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About This Manual 
 
The information in this manual is organized in three parts that again is organized in ten 
chapters, and on the entry page of each part and chapter, a general description is provided 
for quickly catch on the contents. 
 
Part 1 -- WAC Server –  contains five chapters providing description to WAC Server and 
describing how to install, get started, work with and configure WAC Server.  
 
If you want to get started without having to read everything, 
 
¶ Skip directly to the introduction in Chapter One and read the section “ WAC 

Session Agent” , “ WAC Server Service”  and “ How WAC Sever Works” . 
¶ Then Skip to Chapter Three for tips on getting started. You can choose the section 

to read based on the client you are using. If you are using WAC Native Client, 
read the section “ Connecting Using WAC Native Clients”  or “ Chapter Seven”  in 
Part Two. 

 
If you want to quickly familiarize yourself with the WAC Configurations without having 
to read everything, 
 
¶ Skip directly to the Chapter Five for overview of the Configuration Tools and 

“ Advanced Configuration Features –  An Overview” . 
 

If you want to quickly know what you can do after logging to WAC Server without 
having to read everything, 
 
¶ Skip directly to the “ Chapter Seven”  in Part Two and read the session “ After 

Logging In” . 
¶ Alternatively, you can also scan through the “ Chapter Four –  Working with WAC 

Server” . 
   
Part 2 -- WAC Native Clients –  contains three chapters providing introduction to the 
native clients and its installation, describing how to use the native client to access server 
and use its command options 
 
Part 3 –  WAC Toolkit –  contains two chapters providing introduction to WAC text-
based applications and providing step-by-step information for using the Toolkit. 
 
If you want to know what is WAC Toolkit and how to install it without having to read 
everything, 
 
¶ Skip directly to Chapter Nine and read the section “ WAC Toolkit Lists” , and then 

the “ Installation” . 
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Use the Index and Table of Contents for help on specific topics when you don’ t have time 
to read through the chapters. 
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Part One --- WAC Server 
 
WAC Server, a Windows Access Server, can put you at the host 
computer through three access methods, and enable you to do 
remote administration with its great toolkit and build-in command 
line utilities. 
 
This part covers: 
 
¶ Chapter One, “ Introduction to WAC Server”  provides the 

general description about WAC Server, introduces its 
interactive session agent, its service, and how it works.   

 
¶ Chapter Two, “ Installation”  provides information about 

step-by step setup procedures including the software’ s 
upgrade and re-setup, and the system changes.   

 
¶ Chapter Three, “ Getting Started”  provides information 

about getting connected by using the WAC native clients 
and the third party clients, and the user public key 
authentication method. 

 
¶ Chapter Four, “ Working with WAC Server”  provides 

information about all kinds of utilities that you can use to 
work during an interactive WAC Session.   

 
¶ Chapter Five, “ Configuring WAC Server”  provides 

information about configuration tools and the advanced 
configuration features including Server Global Settings, 
User Settings, Access Control, SSH Settings, and Serial 
Port Setting. Besides, a “ Reference”  section is also attached 
to this chapter for a supplement to the “ Advanced 
Configuration Features”  section. 
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CHAPTER ONE 

Introduction to WAC Server 
 
This chapter contains the following four sections: 
 
¶ The “ WAC Server Description”  section simply describes WAC Server and 

applications that come with it. 
 
¶ The “ WAC Session Agent”  section introduces the two methods of WAC session 

agent to monitor the session as well as the side effect and advantages.  
 
¶ The “ WAC Server Service”  section introduces the WAC service and provides several 

ways to start or restart WAC service. 
 
¶ The “ How WAC Server Works”  section describes the three steps to make WAC 

server work. 
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WAC Server Description 
 
Congratulations. You choose Windows Access (WAC) Server. It is a brainchild of Foxit 
Software Company.  
 
WAC Server is a combined Windows NT 4.0/2000/XP server, integrating the telnet, ssh 
and terminal server. The WAC Sever allows the client users to remotely access the Server 
machine just as if they were the local users. Using ANY telnet, ssh and terminal client 
program, users can login to the Server Machine. 
 
The Server machine should be the Windows NT 4.0/2000/XP machine on which WAC 
Server has been installed. And it can be anywhere on the Internet or in your local network 
or in the serial cable.  
 
In addition, WAC Server offers a gallery of text-based console applications and 
Command Line Tools that are great helper facilitating you to remotely work on the 
Server machine. And it also ships with two free native client programs that are used to 
access Server machine and thus establish a WAC client-server talk environment.   
 
Often while you are working in WAC talk environment, and do administration under the 
help of WAC console applications, you forgot that you are working on the Server 
Machine. 
 

WAC Session Agent 
 
A WAC session between client and server is created each time a connection is established. 
For each WAC session, WAC Server makes use of a special session agent, 
WACSES.EXE, which monitors the user activities, the keyboard/mouse input, and the 
screen output for each of the user sessions. This session agent uses two types of 
technologies to monitor the application outputs:  

1. The session agent goes directly to the screen buffer of the user session and ready 
content, if it finds anything changed, the change will be packaged according to the 
transportation protocol and terminal type, and sent to the terminal;  

2. The session agent can build a special communication instrument, called "pipe" and 
redirect the application's output to that pipe, so when the application wants to write 
something onto the screen, it actually goes to the pipe. At the other end of the pipe, 
there sits the session agent, which interprets the output and does the actual screen 
modification for the application, and at the same time it also packages and sends the 
change to the terminal.  

The WAC session agent can use those two methods at the same time, but the second 
method has some side effect and some advantage too:  
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1. Some applications don't act the right way when their output got redirected. For 
example, sometimes the output disappears because it's got buffered in the memory, 
also sometimes user input got affected too;  

2. On the other hand, some application relies on redirection to work. Your application 
might send out some special characters to the terminal and want it to perform some 
special action instead of displaying it. In this case we can't detect any modification to 
the screen, so the first change-detection monitoring doesn't work in this case. A very 
common example is the BEL character, which is never been displayed but causes the 
terminal to beep. If you disable the session agent redirection, you will never hear that 
sound.  

For the side effect and advantage, WAC Server introduces a configurable setting called 
“ AgentRedirect” . The capacity of this configurable setting exists to enable or disable 
WAC session out agent redirection, furthest optimizing you screen. 
 
In addition, the configurable setting “ Session Tick”  exists to help update the terminal, 
and the “ Keep Session”  exists to help specify the period for keeping a broken session so 
that after that period the broken session can be terminated and make available to other 
users. 
  
For more information, please see Chapter Five –  Server Global Settings -  “ Global Agent 
Redirection” , “ Session Tick for Terminal Update”  and User Admin Settings - “ Session 
Broken Keeper” . 
 

WAC Server Service 
 
The WAC Server is built as an NT service, which means it will be running on the 
background, and by default, WAC Server will be automatically started whenever you 
start the machine. 
 
The service name for WAC Server is, quite naturally, "Foxit WAC Server". And since it's 
a service, so like any other Windows NT/2000/XP services, you can use the service 
utility to start and stop WAC Server, changing the startup type (whether to automatically 
start the service when machine startup), etc.  
 
WAC Service can be started and stopped in the following ways: 

1. From the Windows Services  

On your server machine, go to "Start/Control Panel/Administrative Tools/Services", 
scroll down the list or just press "F" letter for several times and you will find "Foxit 
WAC Server". Then click the Start or Stop button to execute the task. Select whether 
WAC Service will start automatically or manually, double click "Foxit WAC Server" 
and select Automatic or Manual from the Start type combo box.  

2. From the Command Line  
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¶ To stop the WAC service, at the command line, type "WAC STOP"  
¶ To start the WAC Service, at the command line type "WAC START"  
¶ To restart the WAC Service, at the command line type "WAC RESTART"  

3. From the WAC Service Manager (svcma.exe)  

WAC Service Manager, it performs the same functionalities as the Windows Services, 
except it's a text-based application, so when you logon remotely using a terminal, you 
should use the WAC Service Manager. To run it, at the command line, type 
"SVCMAN.EXE" and press ENTER. 

4. From the GUI CONFIG Program --- WAC Manager (wacma.exe)  

Run WAC Manager, on the WAC Server Status page, click on the WAC Server Stop, 
WAC Server Restart, or WA Server Start.  

 
NOTE: Stopping and restarting WAC service will disconnect all users from the server. 
 

How WAC Server works 
 
Use WAC Server is as easy as 1-2-3.  
 
Installation Set up WAC Server on your host computer of Widows systems. The setup is 
easy and fast, and an extra client and tool program will be installed into your computer at 
the same time. For more, see Chapter Two Installation. 
 
Access   Remotely access your host computer with a client from any workstation and PC 
with network connection, or terminal with serial communication cable. For more, see 
Chapter Three Getting Started 
 
Working Begin working on your host machine as if you were sitting in front of it by 
using WAC tools. You can instantly access to all its data and resources such as email, 
applications, documents and even network resources. For more, see Chapter Four 
Working with WAC Server. 
 
 
 
 
 
 
 
 
 
 
 



                                                                                                                                                                                 

Page 15 of 231 

 
 
 
 
 
 
 
 
 

 CHAPTER TWO 

Installation 
 
This chapter contains the following five sections: 
 
¶ The “ Procedure One”  section introduces the preparative work before setting up WAC 

Server, -- that is how to load CD to your CD ROM or download WAC software from 
the website and crate the temporary directory for it. 

 
¶ The “ Procedure Two”  section introduces the step-by-step process of setting up WAC 

Server installation. 
 
¶ The “ Express Upgrade, Update or Re-setup”  introduces ways to update the WAC 

Server. 
 
¶ The “ Setup Affection”  section introduces the system change on your host machine 

after installing WAC Server. 
 
¶ The “ Uninstall”  section introduces the WAC Server un-installation. 
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Procedure One -- Load CD or download the software  

WAC Sever package is distributed through both CD pack and Web Sever.  
If you have WAC Server CD pack available, following the three steps below then skip to 
Procedure Two: 
 
1. Load WAC Server CD into your computer's CD - ROM drive.  
2. If the WAC Server installation program doesn't start automatically, choose Start > 

Run. Click “ Browse”  and choose the “ Setup.exe”  file on the WAC Server CD.  
3. Click OK in the Run dialog box.  

 
The software can be downloaded from Web Server, and stored into a temporary directory 
on your hard disc. The file you downloaded is zip package (WAC.ZIP), you need to 
unzip the package in the temporary directory. Follow these steps: 
 
1. Create a temporary directory on your hard disk drive. Name it anything, such as 

C:\WACSETUP.  
2. Download the file from the Web into C:\WACSETUP.  
3. Unzip into C:\WACSETUP the package (WAC.ZIP) that gets you all the files you 

need to install WAC Server.  
4. Run one of the unzipped files SETUP.EXE, and follow the steps of the onscreen 

instructions that will be introduced in the Procedure Two.  

NOTES: 

¶ You can remove the unzipped files from the temporary directory after successfully 
installed the WAC Server.  

¶ Before proceed the setup program, all windows running programs should be closed to 
avoid conflict or errors.  

¶ To be sure the computer you are installing is the one you want to remotely control.  

Procedure Two -- Setup the Software 

To complete WAC Server setup, you will be going on the following excursions: 
 
1. Welcome Screen -- After run the SETUP.EXE program, you should be greeted with a 

welcome screen, click "Next" to continue. If you want to read the Readme.txt, click 
"About"  

2. License Agreement -- What you are seeing is WAC Server License Agreement. This 
is common for nearly all software. Only after you click "I agree" button to grant your 
acceptance can you continue to install.  

3. Microsoft Telnet Service Stop -- No matter you choose "Yes" or "No" the Setup 
program will continue its way. Whereas you are recommended to choose “ Yes” , for 
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the running MS Telnet service may collide with WAC Server telnet service. If choose 
“ No” , you will get an alert message, just click “ OK”  to proceed.  
 

NOTES: 

 
¶ You don’ t experience this step if the Microsoft Telnet service was disabled ahead 

of time on your computer.  
¶ If you hope to remain both Telnet service and WAC Server Telnet service running 

at the same time, you need to change WAC Server telnet port at the later process.  
¶ Click here for instructions of MS Telnet service and WAC Server Telnet service  

 
4. Destination Folder Select -- Before copying files into your computer, the Setup 

program will provide a chance for you to select the location. The default folder is "C:\ 
Program Files\ WAC".  

 
Grant the default location, click "Next" to continue. If not previously specify a WAC 
folder in your computer, you will get a waning message, just click "Yes" to 
automatically create the folder in your computer and proceed installing. Click "No" 
to go back and change the destination folder.  
 
To change the default location, click "Browse" button to bring about "Browse for 
Folder" box. In the box, select the folder you want and click "OK", then click "Next" 
to continue the setup in the selected folder.  

 
5. LPT Port CONFIG -- This step is serving for you to configure the LPT port for client 

side printing. 
  

6. Telnet/ SSH / COM Port CONFIG -- This step is provided for you to configure the 
Telnet and SSH port number as well as Serial ports. The default port number for 
telnet is "23" and for SSH is "22". Click "Next" after specify the ports.  

 
In this step, if WAC Setup program detects the Telnet port or SSH port you 
specified was already occupied by other services, then when you click "Next" you 
will be prompted to change the port number with a pop-up message. If you just like 
to use the present port anyway, click "Yes" on the message, if you like to specify 
another port, click No", then you have to try other port number like "24, 40, 80...".  
 
NOTE: At a later day, if you want to change these port numbers, you can use 
WAC CONFIG tools -- WACMAN.EXE and WAC CONFIG.EXE to do the 
changing.  
 

7. Succeeded Screen -- Up to now, all the required information for WAC Server Setup 
has been collected and installed. Just click the "Finish" button to complete the 
installation when you see the Setup successful notification screen.  
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8. WAC Manager -- Congratulations, you have now accomplished your WAC Server 
setup excursions and are ready to start using it.  
 
Now you should see a pop-up GUI window, this is one of WAC CONFIG tools -- 
WAC Manager, almost WAC Server settings are completed here. Before start a 
connection with WAC Server, just use this program to configure WAC server by 
clicking the setting category index on the left side pane.  

Express Upgrade, Update or Re-setup  

In case you want to update the installation or resume from a cancelled or failed 
installation, you can run the SETUP.EXE program and go on the setup procedure again, 
and again if needed. 
 
¶ If you just want to expressly upgrade WAC Server using existing settings, run 

SETUP.EXE, and press "Express Update" button update WAC Server.  
 
¶ If you just want to update WAC Server with some port numbers changing, run 

SETUP.EXE, and click "Next" button to go to the page that contains "Update" button, 
press that button to continue your update process.  

 
¶ If you just want to install WAC Server into a new place, run SETUP.EXE, and click 

"Next" to go to the page that contains "Re-setup button", press that button to continue 
your re-setup process. And after successfully reinstalled, you can remove those 
installed files in previous installation directory.  

Setup Affection  

The following is a list of what the WAC Server setup will affect your system: 
 

1. A installation directory will be created for you if not previous existing, this directory 
is specified by user during installation;  

2. WAC Server executable and WAC applications are copied to this installation 
directory;  

3. A "Program Group" called "Foxit WAC Server" is created, it includes two shortcuts, 
the first is Uninstall, and the second is WAC Server Manager. And the WAC Server 
Manager was automatically created at desktop as a shortcut;  

4. A special print port called "WAC:" (Fig.1) appears in your available printer ports. And 
a special printer "WAC_PRINTER" (Fig.2) appears in your available printer lists if you 
have installed "Generic / Text Only" driver on your computer;  
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Fig.1 

 
Fig.2  

5. A registry key is created as" HKEY_LOCAL_MACHINE\Software\ Foxit 
Software\WAC Server"(Fig.3), all WAC Server configurations are kept under this key. 
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Fig.3 

 
6. A file named "pubkey.txt" is generated in the installation directory, it contains the 

SSH server public key, you should export this file to your SSH clients if you want 
them to verify the server;  

7. A service named "Foxit WAC Server" will be created if not previously existing. This 
service will be set to "Auto" start which means the WAC Server will be started 
automatically when system restart;  

8. The "Telnet" service (Microsoft's telnet server) will be stopped, and disabled so it 
won't get started when system restart (if you still want to keep Microsoft telnet server, 
you should change the WAC Server's telnet port, and manually re-enable the 
Microsoft telnet service);  

9. The WAC installation directory is added to the system path.  

Uninstall  

To remove WAC Server from your system, simply click Start, and go to Programs, find 
the Foxit WAC Server line, and run the UNINSTALL.EXE file. It will undo all the 
changes made by the installation process, except the Microsoft Telnet Server will stay 
disabled, if you want to enable it, go ahead and use the Windows Service Manager.  
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CHAPTER THREE 
 

Getting Started 
 

To access WAC Server, you can use WAC Native Clients, or Other 3rd party clients. And 
even you can authenticate yourself by using user public key over other compliant SSH 
clients. 
 
This chapter contains the following three sections: 
 
¶ The “ Connecting Using WAC Native Clients”  section briefly introduces ways to open 

WAC Native Clients to connect with WAC Server. Details of this section are 
provided in Chapter Seven of Part Two –  WAC Native Clients. 

 
¶ The “ Connecting Using Other 3rd party Client”  section introduces some notices when 

using 3rd party clients like terminal settings, screen size adjustment.  
 
¶ The “ Authenticating Using User Public Key”  section briefly introduces how to 

authenticate to WAC Server using the compliant SSH client. Details of this section 
are provides in Chapter Five –  User Public Key Authentication.  
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Connecting Using WAC Native Clients  
 
Follow the following instructions to open WAC Native Client Window. 
 
¶ On the local server machine, you can open the client window from the Run line, the 

command prompt or the icon in the WAC Server installation directory.  
 

For example, from the Run line, click Start, click Run, in the Open line, input 
"wacterm <IP Add or Host Name> or wacssh <IP Add or Host Name>", and click Ok. 
If you are connecting to the local host, on the Run line, simply type "wacterm 
localhost or wacssh localhost ". 
 
At this point, WAC Client window is open with being connected, and you get WAC 
Server logon banner such as welcome text, evaluation number and host information, 
and the prompt for username and password to login. 
 
¶ On the remote client machine, you can open the client window by directly clicking 

the WAC Client desktop shortcut icon.  
 
At this point, WAC Client Windows is open with prompt for the IP address or host name 
of the machine you are connecting to.  
 
For further information about connecting using WAC Native Client, see “ WAC Native 
Clients -- Getting Started” . 

Connecting Using Other 3rd Party Client  
 
To connect to WAC Sever using 3rd party client, you might need to make adjustments to 
some of the settings (like "terminal settings or size") of your client programs to get the 
best result.   

Adjust Terminal Settings   

In this section we will be discussing some settings on “ VTNT” , “ Other terminals” , and 
“ Keyboard mapping. 

VTNT  

An alternative client is Microsoft's telnet client for Windows 2000 and later. If you are 
not running Windows 2000/XP on your client machine, you can actually copy the 
TELNET.EXE file from a Windows 2000 machine and try to run it on your other 
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Windows platform. This telnet client supports a special terminal type called VTNT, 
which is defined by Microsoft and supported by WAC Server. 
 
VTNT takes full advantages of PC keyboard and output attributes, but it doesn't support 
mouse operations, is not quite convenient for all those WAC applications. 
 
There are some other terminal products on the market that support VTNT terminal too. 

Other Terminals 

If you use clients other than WAC Native Clients or VTNT, make sure your terminal is 
set to DEC-VT compatible mode, or ANSI compatible mode. Please note: some terminals 
claim to be DEC-VT compatible or ANSI compatible, they are actually not. So if you 
experience some problems like messy screen or input inconsistency, you should take a 
look at the settings of those terminals, or use another better terminal program, like 
KoalaTerm from Foxit. (http://www.Foxitsoftware.com/download.htm) 
 
The character set of the terminal, if possible, should be set to "MS-DOS" or "IBM-PC" 
character set, which will allow you to display most of the special characters in the 
Windows console screen. 
 
If your terminal support mouse, please set it to DEC compatible mode so the mouse 
movement and click events can be correctly sent to the server applications. 
 

The recommended minimum terminal screen size is 80x25, which will allow you to run 
most of the console applications without program. WAC applications support larger 
terminal size too.  

Keyboard Mapping  

If your terminals other than WAC Native Clients or VTNT, you need to carefully set your 
keyboard mapping if you want to make use of special function keys and key 
combinations like ALT-keys. 
 
Keyboard mapping means you can change the settings in your terminal program so when 
you press certain key or key combination at the terminal, some code sequence will be 
sent to the server. 
 
You have to set the keyboard mapping of your terminal in such a way that the code 
sequences can be recognized by WAC Server so your server application gets the correct 
keyboard code information. 
 
For a list of code sequences recognized by WAC Server (equivalents of VT terminal keys 
are also listed), see Appendix B.  
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Resize terminal screen 

While standard size for DOS command prompt is 25 lines and 80 characters per line, and 
that's suitable for most of the case, you might found this standard size needs to be 
changed sometimes. 
 
You might think your screen should display more contents and of course, your monitor is 
large enough to hold a large window, then you can increase the terminal size of your 
WAC session. 
 
WAC Server detects the terminal size when the session is connected, therefore, you need 
to re-logon if you want to use another terminal size. 
 
If you use a serial terminal to connect with WAC Server, there is no way for WAC Server 
to automatically detect the terminal screen size, so WAC Server assume all terminals 
connected through serial ports have the size of 80x24 which is the default size of VT 
serial terminals. If your terminal actually has a different screen size, you have to tell the 
server about it, using the following command: 
 
WAC term [<port name>] [Width=<Mw>] [Height=<ah>]  
 
For example: 
 
WAC term COM1 width=80 height=25  
 
NOTE: You have to log out from the port and re-logon again to make the new size 
effective. 

Authenticating Using User Public Key  
 
Except the username/password authorization, WAC Server also supports public key 
authentication for SSH2. If you want to use public key to logon, you need to do the 
followings: 
 
¶ Generate a public/private key pair using the generation utility of your SSH client 

program (WACSSH client doesn't support user public key authentication, so you have 
to use other SSH 3rd client to do this.);  

 
¶ Copy the public key file to server, and on the server machine, execute "wac userkey 

add <filename> <username>" command to add the key file to server accepted public 
key list;  

 
When logon, choose the private key in the client program.  
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The first time logon using public key will always be rejected, unless you the user doesn't 
have a password. You need to input the server's password for the user. Once the password 
accepted, you won't need to input password again.  
 
NOTES: 
 
¶ Please note some clients might have bugs with the standards, if you experience 

problem with third party clients, please change the SSH version or cipher algorithm 
settings and try again.  

 
¶ For more detailed information, see “ User Public Key Authentication” .   
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CHAPTER FOUR 

Working with WAC Server 
 
This chapter contains the following nine sections: 
 
The “ Managing Sessions”  section introduces the command line utilities and console tool 
that can be used to manage the session, and described what operations you do in an 
interactive session with those utilities.  
 
¶ The “ Managing Services”  section introduces the command line utilities and console 

tool that can be used to manage the session and briefly described what you can do 
with those service utilities. 

 
¶ The “ Managing User and Group”  section introduces the console application that can 

be used to manage the user and group on the remote host machine, and provides some 
tips on for the XP system users. 

 
¶ The “ Managing System Tools”  section introduces some tools that facilitate your 

remotely managing the host system, like “ Event Viewer” , “ System Information” , 
“ Process Viewer”  and “ Registry Editor” . 

 
¶ The “ Managing Files”  section introduces some tools that facilitate your remotely 

managing files and resources on the host machine, like “ Text Editor” , “ Binary Editor”  
and “ WAC Explorer” . 

 
¶ The “ Checking Mails”  section introduces a tool that facilitates your remotely 

checking and composing outlook inbox mails on the host machine, like “ WAC 
Inbox” . 

 
¶ The “ Chatting”  section introduces a tool that facilitates your starting an instant chat 

dialog with the online current users during a session. 
 
¶ The “ File Transfer”  section introduces on “ file transfer server side configuration” , 

“ file directories”  and “ sending files with three WAC tools” . 
 
¶ The “ WAC Command Line Utilities”  section provides detailed introductions to all 

WAC command line utilities and their usage. 
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Managing Sessions  
 
Each log-on connection is called a "session" in WAC Server. The maximum number of 
concurrent session allowed in a WAC Server is determined by the license number you 
purchased. For evaluation users, maximum 2 sessions can be logged onto the server at the 
same time. 
 
You can view and change the other session information using the WAC session 
management utilities. To manage the sessions, you must be a member of the server's 
administrator’ s group. Otherwise you can only do something on your own session(s). 

Session Managing Utilities 

In a WAC Server session, users in the administrator’ s group can perform many useful 
tasks with session managing utilities, including a full-screen console application "Session 
Manager" and a handful of command line Utilities 
 
¶ The "Session Manager", a text-based application, displays the current users and 

provides methods to watch, control, take over, reconnect to and abort a session, to 
send messages or broadcast system messages to users. To run it from the command 
line, type SesMan and press Enter. See WAC Toolkit –  “ Session Manager”  in Part 
Three. 

 
¶ The command line utilities including "wac who", "wac whoami ", " wac send", " wac 

watch” , “ wac control” , “ wac takeover” , and "wac abort". These command tools serve 
for you to manage the sessions from the command prompt.  See Chapter Six - 
Command Line Utilities in Part Two. 

 
For what you can do with these session utilities, See “ Session Inter-operations”  section 
below. 

Session Inter-Operations  

There are a lot of things can be done between WAC Server user sessions. In this section, 
we just succinctly guide you through the session inter-operation. If you want the detailed 
how-to instructions, you need to refer to their respective help documents.  
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Session Info View  

WAC Server provides a mechanism for users to view and observe all current active user 
sessions. The session Info contains the “ Session ID” , the “ Username” , the “ Port Type” , 
the “ IP Address” , the “ Term”  (client name), and the “ Connection Start Time” . 

View All Current Active Sessions Info 

¶ When you start “ Session Manager” , you will see a list of all current sessions, when 
there are new sessions and session terminated late, the list will automatically updated 
with highlighting flicker.   

 
¶ At the command line, you can use "wac who" to get a list of all current sessions.  

View Your Current Active Session Info 

¶ At command line, you can use "wac whoami" to get information about the session 
you are currently working in. 

Alert messages  

WAC Server provides a mechanism for users to post short messages to other session(s). 
The message will pop up on the other session's screen, and the screen will be frozen until 
the user press any key to dismiss the message and return to normal screen.  
 
You can post the message to a particular session or all sessions under a particular user, or 
broadcast messages to all active sessions (yourself will get that message too!).  
 

Post Message to Particular Session 

 
¶ In "Session Manager", select the session you want to post message to, and select 

Message button.   
 
¶ At the command line, you can use "wac send <session id> <message>” command to 

send message to the session under this session ID. Or use “ wac send <username> 
<message>”  to send message to the session(s) under this username. 
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Broadcast Message to All Sessions 

 
¶ In "Session Manager", select the session you want to post message to, and select 

Broadcast to send message to everyone.  
 
¶ At the command line, you can use "wac send all" command to send messages to 

everyone.  

Session Watch 

WAC Server provides a mechanism for authorized users to watch, control, take over, and 
reconnect to other session's screen. You have to be a member in the administrator’ s group 
to do this. Also you can always watch the session under the same user name as yours.  
 
Session watch features are very helpful if you want to monitor remote sessions, or do 
remote demonstration. They also are great powerful training/ QA tool 

Monitor Other Session 

When the screen of another session is monitored, the output of the watched session will 
appear on both watched session and watcher session. More than one watcher can watch 
the session at the same time 
 
¶ In “ Session Manager ” , select the session you want to watch, and select Watch 

button, to end the watch state, press Enter key.  
 
¶ At the command line, you can use “ wac watch <session id> |<username>”  command 

to watch, press Enter key to end watch. 
 
NOTES: 
 
¶ In WAC Server, you can use “ User Admin Settings”  in WAC configuration tools to 

configure a particular user or user group to monitor your session (See Chapter Five - 
“ Specify the Watching Users” ).   

 
¶ You can't monitor the session you are currently working on, because that doesn't 

make sense. 

Control Other Session 

When the session is controlled, the session is under interactive input. Both you and the 
other side user can enter data into the session. To end the session control, press <ctrl -d> 
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¶ In "Session Manager", select the session you want to watch, and select Control 

button, to end the control, press <ctrl-d> key.  
 
¶ At the command line, you can use "wac control <session id> |<username>" 

command to control, press <ctrl-d> key to end control. 
 
NOTES: 
 
¶ In WAC Server, you can use “ User Admin Settings”  in WAC configuration tools to 

configure users or user groups to control your session (See Chapter Five - Specify the 
Controlling or Takeover Users).   

 
¶ You can't control the session you are currently working on, because that doesn't make 

sense. 

Take Over Other Session 

When the session is taken over, only you can do the operations on the session, while the 
other side session is disabled and not able to enter any data except watching the session.  
 
¶ In "Session Manager", select the session you want to watch, and select Takeover 

button, to end the takeover, press <ctrl-d> key.  
 
¶ At the command line, you can use "wac takeover <session id> |<username>" 

command to take over, press <ctrl-d> key to end takeover 
 
NOTES: 
 
¶ In WAC Server, you can use “ User Admin Settings”  in WAC configuration tools to 

configure users or user groups to take over your session (See Chapter Five - Specify 
the Controlling or Takeover Users).   

 
¶ You can't take over the session you are currently working on, because that doesn't 

make sense. 

Reconnect to Session  

During watching the session, if needed, you can reconnect to a broken or active session, 
and continue work on that session.  
 
When you perform the Reconnect task, your current session is actually terminated, and at 
once got reconnect to the session you selected. If it is a broken session you reconnect to, 
the broken session will be recovered and appears in your current session. If it is an active 
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session you reconnect to, the original active session will be aborted and at once becomes 
into your current session. 
 
¶ In "Session Manager", select he session you want to reconnect to, and select 

Reconnect button, your current session will be terminated and at once switched to the 
selected session.  

 
¶ At the command line, you can use "wac reconnect <session id> |<username>" 

command to reconnect, your current session will be terminated and at once switched 
to o the selected session 

 
NOTES:  
 
¶ Besides this watching Reconnect feature, WAC Server also provides another  

Reconnect feature that allows you to automatically reconnect to a broken or an active 
session the next time when re-log in. And this can be accomplished by setting up Auto 
Reconnect in “ User Admin Settings”  within WAC configuration tools (See Chapter 5). 

 
¶ Broken sessions are created when the Keep Session value in “ User Admin Settings”  

page is set and a connection has got broken illegally, and the user has not yet 
reconnected to their broken session. (See Chapter Five - Broken Session Keeper ) 

 
¶ You can't monitor, control, take over and reconnect to the session you are currently 

working on, because that doesn't make sense. 

Abort Session 

You can abort a particular active session or a broken session (this will abort all running 
applications of that session and disconnect it), if you are authorized: you have to be the 
same user, or a user in the Administrator’ s group.  
 
¶ In "Session Manager", select the session you want to abort, and select Abort button.  
 
¶ At command line, use the "wac abort <session id> |<username>" command.  

 

Managing Services 
 
On your server system, there might be running a lot of services. Often you need a service 
management program to look after them. 
  
On your host system, you can use the Windows “ Services" to perform the tasks. This tool 
can be found inside the "Administrative Tools" group. 
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You can also use the WAC service management utilities to perform the tasks, locally and 
remotely. See WAC Service Managing Utilities. 
 
NOTE: You might need to be logged on as an administrator or a member of the 
administrator’ s group. Otherwise some features of service management utilities are 
unavailable. 

WAC Service Managing Utilities 

After logon to the remote host machine via WAC Server, you might want to disable or 
enable some services that are on the background, or to view and change some service 
properties. To do all the changing to services, you can use the WAC “ Service Manager” . 
And many times, you might need to manage service system such as shutdown or reboot a 
remote host machine, and change the system logon password, all this can be 
accomplished by the WAC command line service utilities inside WAC Server. 
 
¶ The "Service Manager", a text based application, displays all services running on 

your host machine and provides methods to start/stop/restart the services, to modify 
the service properties and even connect to another computer and do operations. This 
program functions like Windows ‘ Services”  yet with some better features. To run it 
from the command line, type svcman and press Enter. See WAC Toolkit –  “ Service 
Manager”  in Part Three. 

 
¶ The command line service utilities including "wac shutdown | reboot", "wac 

password" and “ wac disable | enable telnet | ssh | serial” . These command utilities 
serve for you to manage the remote service system from the command prompt. If you 
want to manage Foxit WAC Server from the command line, you can use “ WAC start | 
stop | restart”  command to do. 

 
NOTE: 
 
¶ For the how-to instructions with the WAC service managing utilities, please refer to 

their respective help documents. Here is the brief list of what you can do with these 
utilities: 

 
× Shutdown a computer from the command line; 
× Reboot a computer from the command line; 
× Change login password from the command line; 
× Start, stop and restart WAC Server from either the command line or SvcMan; 
× Disable or enable the telnet, ssh or serial port service from either the command 

line or SvcMan; 
× View and manage all remote services from the SvcMan; 
× Connect to another computer from the SvcMan; 
× View and change the services’  properties from the SvcMan; 
× More…  
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Managing User and User Group  
 
WAC Server acts like a gateway between the host (Windows) machine and the client 
machine, so to log onto WAC Server is actually to log onto the host machine. You should 
use your Windows user account (including username and password ) to try to logon, as if 
you are sitting in front of the machine and trying to logon. 
 
Thus if you want to create a new user account, or change some settings of the exiting 
accounts, you should need at least a user management utility. 
 
On your local host machine, you can use the Windows "Local Users and Groups" to 
perform the tasks. This application can be found in "Administrative Tools > Computer 
Management > Local Users and Groups". 
 
You can also use WAC user management utility to achieve the tasks, locally and 
remotely. See User Managing Utility. 

User and Group Managing Tool 

Often in a WAC session, you might need to manage the user account on the host machine 
and / or create new account for the user. WAC Server provides you a full-screen 
application --"User Manager" to help you achieve this task. 
 
¶ The WAC "User Manager" was designed to view and manage the host users and 

groups in a session environment. You can use this program to view, add or delete 
users and user groups, and even more. It functions just like Windows "Local Users 
and Groups" except it is a text-based application. To run it from the command line, 
type UserMan and press Enter. See Chapter Ten –  “ User Manger”  in Part Three. 

Tips for Windows XP Users 

Windows XP allows you to create user accounts without password required, and you 
might think it's very convenient to logon without a password. Yet this will cause logon 
failure when you log on to WAC Server. Windows XP has a setting called "Limit local 
account use of blank passwords to console logon only", and by default, this setting is 
enabled, that means you can't logon to Windows system through other means without 
passwords except sitting at the machine and click on the user icon.  

If you want to logon XP through WAC Server, you either need to assign a password to 
your user, or disable this setting using "Security Options" in "Local Security Policies". 
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We strongly recommend you to add a password to your user, because it's very dangerous 
to allow user to logon from remote machine, without a password.  

NOTE: "Security Options" locates at "Administrative Tools > Local Security 
Policies>Local Policies". 

Managing System Tools 
 
WAC Server provides ways for you to monitor the recorded system events, such as 
“ Event Viewer” ; to view the device information, such as “ System Information” ; to 
monitor the running processes, such as “ Process Viewer” , and to modify your system 
registry, such as “ Registry Editor” . 
 
¶ To run “ Event Viewer”  from the command line, type eventview and press Enter. For 

more information about it, see WAC Toolkit - Event Viewer in Part Three. 
  
¶ To run “ System Information”  from the command line, type sysinfo and press Enter. 

For more information about it, see WAC Toolkit - System Information in Part Three. 
  
¶ To run “ Process Viewer”  from the command line, type procview and press Enter. 

For more information about it, see WAC Toolkit –  Process Viewer in Part Three. 
 
¶ To run “ Registry Editor”  from the command line, type regedit and press Enter. For 

more information about it, see WAC Toolkit - Registry Editor in Part Three. 
 

Managing Files  
 
Often in a session, you need to edit and manage files on your server machine. In a WAC 
session, there are three tools can be used to achieve the task: 
 
¶ The "Text Editor", a powerful and efficient Windows text editor, much better than the 

old DOS editor. To run it from the command line, type “ edit”  and press “ Enter” .  
 
¶ The "Binary Editor", a binary file viewer and editor. In this program, the file can be 

opened at both text and binary format in one screen, and you can modify the text file 
by changing the binary file. To run it from the command line, type “ binedit”  and 
press “ Enter” . 

 
¶ The "WAC Explorer", a great text-only alternative to Windows Explorer. You can 

use this program to manage your local and remote files simply by drag and drop 
actions, and even explore to your network neighborhood. To run it from the command 
line, type “ wacexplorer”  and press “ Enter” . 
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NOTE: For further information and how-to instructions, please refer to their respective 
help documents on the WAC Toolkit of Part three. 

Checking Mails 
 
If you have an Outlook mail account on your server machine, you have to often go there 
to take care of your mails if you not always be there physically. Now in a WAC session, 
you don't need to do that. WAC "Email Inbox" helps you to do this task. 
 
¶ The "Email Inbox", is a text-based program that can access to your Outlook Inbox 

and display all messages in front of you. In this program, you can view, compose and 
reply emails, and even store your mail address. To run it from the command line, type 
inbox and press Enter. 

 

Chatting 
 
WAC Sever provides a chat utility -- "Phone" for you to start a chart dialog with someone 
who locates on your host machine. A message will pop up in the called user's screen, 
prompt the called user to use chat utility to answer. If there is no response in 20 seconds, 
WAC Server will drop back you a "call canceled" message. 
 
WAC "Phone" (phone.exe) is a full-screen console chat application. To chat at Phone, 
you need to call the user first, when the other user accepts your calling request, you can 
only begin the chat. It is easy to do, simply enter your text into the typing screen, and the 
responses will be got display in the displaying screen. 
 
To run "Phone" from the command line, type "phone" and press "Enter". For detailed 
information, please see WAC Toolkit –  Chat Tool in Part Three. 
 

File Transfer  
 
WAC Server provides a very convenient way for you to remotely access your server from 
your desktop PC, you can do a lot on the remote server with WAC applications as well as 
command line utilities, but sometimes you may want to exchange some data, i.e.; doing 
file transferring between your desktop PC and the server.  
 
Although there are a lot of ways to do the file transfer, in the WAC environment, the best 
way is through file transfer facilities that built-in with WAC native clients or WAC 
Server. 
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Configuring File Transfer on Server Side 

File transfer is one of WAC Server build-in utilities, so you can use one of WAC 
configuration tools to control the file transfer on the server side, like disabling or 
enabling the file transfer service, or conditionally enabling the file transferring service:  
server to terminal only, terminal to server only, or both ways interactively. Here are the 
instructions: 
 
¶ If you use WAC Manager (wacman.exe), you need to go to the “ Server Global 

Settings”  page, and then modify the “ File Transfer for WAC Native Clients” . 
 
¶ If you use CONFIG.EXE, you need to go to the “ Server Settings”  page, and then 

modify the “ FileTransfer”  value. 
 
For detailed instructions, see Server Global Settings –  “ File Transfer” . 

File Directories  

Before you do the transferring, you might want to change the directory of the file. It 
involves two directories: the local directory on the machine running WAC Native Clients 
(WACTERM or WACSSH), and the remote directory on the server. 
 
When you do file transferring, the file is looked up in the sending machine's current 
directory and will be placed in the receiving machine's current directory.  
 
To change the directory of the file, you need to press Ctrl+} to temporarily leave the 
WAC talking session and shift to the command screen of WAC Native Clients. 
 
 
¶ To change the local directory, use "LCD" command, for example:  
 

WACSSH> lcd mydir 
 

If you want to see the current local directory, just type "LCD": 
 

WACSSH> lcd 
 
¶ To change the remote directory, use "CD" command, for example:  
 

WACSSH> cd mydir 
 

If you want to see the current remote directory, just type "CD" 
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WACSSH> cd 
 
NOTE: For further information about the commands, see "WAC Client Command line 
Utilities" in Chapter Eight of Part Two. 
 
If you don't specify the file directories, WAC Clients will set the local current directory 
as the current directory when you run the WAC Clients, and WAC Server will set the 
remote current directory as the user's initial directory (see User Admin Settings - "Logon 

Initial Directory"), or set the installation directory of WAC Server in case of no user initial 
directory available. 
 
When you run "WAC Explorer" (wacexplorer.exe), it automatically set the remote 
current directory to the directory currently listed in "WAC Explorer", this will give you 
much convenience to send files to server when you run "WAC Explorer" on the server, 
just explore to the directory you want to place the received file, and issue "SEND" in the 
command screen. 
 
However, if you don't want the file to be placed in WAC Explorer's current directory, you 
can always use "CD" command to override the remote current directory before you send.  

Sending Files to Server with WAC Client Command 

Utility 

When you want to send files on your local machine (where WAC Clients are running on) 
to the machine on which the WAC Server is running, you should press CTRL-] to switch 
to the command screen of WAC Clients, and use "SEND" command, for example:  
 

WACSSH> send myfile.txt 
 
If you want to send more than one files, you can use wildcard characters (*) in the 
command, like: 
 

WACTERM> send *.txt  
 
Right now, directory structures can't be transferred over the WAC Clients commands, 
you may use WAC Explorer to create the directory structure on server first then do the 
transfer for each of the directories. 
 
In case you want to send some file that's not in the local current directory, you can either 
use "LCD" command to change the local current directory, or directory type relative or 
absolute path of the file in "SEND" command, like:  
 

WACTERM> send...\mydir\myfile.txt 
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Or  
WACTERM> send c:\mydir\myfile.txt 

 
NOTES:  
 
¶ This kind of command won't change the local current directory.  
 
¶ To quit the WAC Clients command screen and return to terminal session, press 

"Enter" or "Ctrl -]" again. 
 
¶ For more information about WAC Clients commands, see "WAC Client Command 

Line Utilities" in Chapter Eight of Part Two. 

Sending Files to Terminal with WAC Explorer  

To send files from the server machine to your desktop machine on which WACTERM or 
WACSSH is running, you can use the "WAC Explorer" (WACEXPLORE.EXE). 
You can start the File "WAC Explorer" from the user menu when you log on to WAC 
Server, or type "WACEXPLOER" at the command prompt. 
 
In the "WAC Explorer", there is a menu item "Send" under the "File" menu, when you 
selected a text file in the file list, you can select this menu item to send to file. The figure 
below is the example. 
 

 
 
Right now you can only send one file at a time, and the sending will be done at 
background so when it's sending, you should be able to continue with your "WAC 
Explorer" session (of course, due to the communication usage, you'll experience some 
slow down). 
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During the file transferring, you can't start the sending for another file. You have to wait 
for the current file to be finished. In future version of WAC Server, a queue will be 
implemented allowing a bunch of files to be started at the same time. 
 
In case the file is rejected by the receiving machine (due to access denied, or out of disk, 
etc.), you will see an alert message popping up on the terminal screen, you'll have to 
resend that file again after the problem got fixed. The figure below is the example. 
 

 
 
NOTE: For more information about "WAC Explorer", please see "WAC Explorer" in 
Part Three. 

Sending Files to Terminal with WAC Command Line 

Utility  

When you logged onto WAC Server, at command prompt, you can directly use WAC 
Command Line tool (WAC.EXE) to send files to your client machine. 
 
The command syntax is: 
 

WAC SendFile <filename> 
like:  
WAC SendFile myfile.txt 
WAC SendFile ...\mydir\myfile.txt 
WAC SendFile c:\mydir\myfile.txt  

 
NOTE: For more information about the "send" command, please see "WAC SendFile" in 
the "WAC Command Line Utilities" section. 
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Right now you can only send one file at a time, and the sending will be done at 
background so when it's sending, you should be able to continue with your session (of 
course, due to the communication usage, you'll experience some slow down). 
 
During the file transferring, you can't start the sending for another file. You have to wait 
for the current file to be finished. In future version of WAC Server, a queue will be 
implemented allowing a bunch of files to be started at the same time.  
 

WAC Command Line Utilities 
 
Within a WAC session, including the great WAC Toolkit applications, you can also use 
the command line utilities to do the remote administration. 
 
WAC command utilities are command line executive programs. Most of them are 
embraced in an executive program called "wac.exe", which resides in WAC Server 
installation directory. Thusly, if you want to get all the command line help files, just issue 
"wac" at the command line, and you should get a list of help information shown as the 
following figure. 
  

 
WAC Command Line Help Files 
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WAC Info 

Display your remote operating system information, such as "host name, version#, service 
state, etc".  
 
Example: 
 
To display your host machine operating system during a WAC session, at the command 
prompt, type "wac info", then type "Enter". 

WAC Who 

Display a list of information of all concurrent users on the host machine such as "Session 
ID, User Name, Client Type, IP Address and Port, Protocol, Start Time etc". 
 
Example: 
 
To find who are currently working on your host machine, at the command prompt, type 
"wac who", then type "Enter". You should get a list of elements that something like the 
following figure: 
 

 
WAC WHO INFOMATION 

NOTES: 
 
¶ You can also use "Session Manager" to perform this task.  
 
¶ The above figure, except telling you the basic user information, it also speaks: there 

are five sessions that have been created on you host machine, only two (#3 and #5) 
are currently active. Then where are the other sessions? Why they aren’ t shown? The 
reason is:  

 
¶ During a WAC connection, unless WAC Server service is restarted, WAC Server 

holds records of every logon session no matter this session is currently active or 
already disconnected. On the other hand, however, WAC Server display only the 
currently existing sessions when you use the "wac who" or "Session Manager" to 
view the session information. Thus naturally, when there are logon and logoff users 
in a WAC connection, there would always be absent sessions. 
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¶ If you want to track information of those absent sessions, you can go to WAC 
Server installation directory, find the folder named "Logfiles" inside which all the 
daily basic logon information is recorded there.  

WAC Whoami 

Display the information of the current active session that you are working with, such as 
"Session ID, User Name, Client Type, IP Address and Port, Protocol, Start Time etc". 
  
Example: 
 
To view your own information, at the command prompt, type "wac whoami", then type 
"Enter". You should get a list of elements that something like the following figure: 
 

 
WAC WHOAMI INFORMATION 

WAC Send 

Post short messages to the particular session or all sessions under the same user name, 
and broadcast messages to all active sessions as well. 
 
Examples:  
 
¶ To post message(s) to the particular session, using this command:  
 

WAC send [<session ID>] [<"message">] 
i.e.; wac send 5 "hello John" 

 
¶ To send message(s) to all sessions under the same user name, using this command:  
 

WAC send [<user name>] [<"message">] 
i.e.; wac send Administrator “ hello John "  

 
¶ To broadcast message(s) to all active sessions, using this command:  
 

WAC send [<all]> [<"message">] 
i.e.; wac send all "how are you" 

 
NOTES: 
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¶ The quotation marks ("") for messages are mandatory when your message is more 
than one word.  

 
¶ You can also use "Session Manager" to perform this task.  

WAC Watch 

Monitor other user's active session screen. 
  
Examples: 
 
¶ To watch other screen by user's session ID, using this command: 
 

WAC watch [<session ID>]  
i.e.; wac watch 5 

 
¶ To watch other screen by name, using this command:  

 
WAC watch [<user name>] 
i.e.; wac watch John 

 
If there are several active sessions under the name as John, WAC Server will list all 
these active session IDs for you to select. In this case, you should choose a session 
ID from the list, and then you are possible to watch other screen. If you want to exit 
this watch action, type <ctrl – d>.  

 
NOTES: 
 
¶ You have to be a member in the administrator's group to do this.  
 
¶ You can't watch the session you are currently working on, because that doesn't make 

sense. But you can watch the session under the same name as yours. 
 
¶ You can also use "Session Manager" to perform this task.  
 
¶ You can also use “ WatchUsers”  in “ User Admin Settings”  within WAC configuration 

tools to configure a list of users to watch your session. See Chapter Five - User 
Admin Settings - “ Specifying the Watching Users” .  

WAC Control 

Monitor other user's active session screen with interactive input.  
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Examples: 
 
¶ To control other screen by user's session ID, using this command: 
 

WAC control [<session ID>]  
i.e.; wac control 5 

 
¶ To control other screen by name, using this command:  
 

WAC control [<user name>] 
i.e.; wac control John 
 
If there are several active sessions under the name John, WAC Server will list all 
these active session IDs for you to select. In this case, you should choose a session 
ID from the list, and then you are possible to control other screen. If you want to exit 
this control action, type Ctrl -D.  

 
NOTES: 
 
¶ You have to be a member in the administrator's group to do this.  
 
¶ You can't control the session you are currently working on, because that doesn't make 

sense. But you can control the session under the same name as yours. 
 
¶ You can also use "Session Manager" to perform this task.  
 
¶ You can also use “ ControlUsers”  in “ User Admin Settings”  within WAC 

configuration tools to configure a list of users to watch your session. See Chapter 
Five - User Admin Settings - “ Specifying the Controlling and Takeover Users” . 

WAC Takeover 

Monitor other user's active session screen with disabling input of the original side. Once a 
session is taken over by you, only you can do operations on the session, while the other 
side can do nothing except watching. 
 
Examples: 
 
¶ To take over other screen by user's session ID, using this command: 
 

WAC control [<session ID>]  
i.e.; wac control 5 

 
¶ To take over other screen by name, using this command:  
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WAC control [<user name>] 
i.e.; wac control John 
 
If there are several active sessions under the name John, WAC Server will list all 
these active session IDs for you to select. In this case, you should choose a session 
ID from the list, and then you are possible to take over other screen. If you want to 
exit this takeover action, type Ctrl -D.  

 
NOTES: 
 
¶ You have to be a member in the administrator's group to do this.  
 
¶ You can't take over the session you are currently working on, because that doesn't 

make sense. But you can take over the session under the same name as yours. 
 
¶ You can also use "Session Manager" to perform this task.  
 
¶ You can also use “ ControlUsers”  in “ User Admin Settings”  within WAC 

configuration tools to configure a list of users to watch your session. See Chapter 
Five –  User Admin Settings - “ Specifying the Controlling and Takeover Users” .  

WAC Reconnected 

Reconnect to an existing (broken or active) session while watching the session.  
 
When you select a session and reconnect to it, on your side, your current session is 
terminated and at once got reconnected to the selected session; on the selected side, 
his/her session is automatically aborted, and then becomes into your current session. 
 
Examples: 
 
¶ To reconnect to an existing session by user's session ID, using this command: 
 

WAC reconnect [<session ID>]  
i.e.; wac reconnect 5 

 
¶ To reconnect to an existing session by username, using this command:  
 

WAC reconnect [<user name>] 
i.e.; wac reconnect John 
 
If there are several existing (broken or active) sessions under the name John, WAC 
Server will list all these active session IDs for you to select. In this case, you should 
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choose a session ID from the list, and then you are possible to reconnect to other 
session.   

 
NOTES: 
 
¶ You have to be a member in the administrator's group to do this.  
 
¶ You can't reconnect to the session you are currently working on, because that doesn't 

make sense. But you can reconnect to the session under the same name as yours. 
 
¶ You can also use "Session Manager" to perform this task.  
 
¶ Besides this watching Reconnect feature, WAC Server also provides another  

Reconnect feature that allows you to automatically reconnect to a broken or an active 
session the next time when re-log in. And this can be accomplished by setting up Auto 
Reconnect in “ User Admin Settings”  within WAC configuration tools 

WAC Abort 

Kick off a session including all running applications under this session. 
  
Examples: 
 
¶ To abort and disconnect a session by session ID, using this command:  
 

WAC abort [<session ID>] 
i.e.; wac abort 5  

 
¶ To abort and disconnect a session by a user name, using this command:  
 

WAC abort [<user name>]  
i.e.; wac abort John 

 
If there are several active sessions created by the user John, WAC Server will list all 
the active session IDs for you to select. In this case, you should choose a session ID 
from the list, and then you are possible to abort the user's session. If you want to 
cancel this action, just type "0" (zero). 

 
NOTES: 
 
¶ You have to be the same authorized user, or a user in the "Administrators" group. 
 
¶ You can also use "Session Manager" to perform this task. 
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WAC Port 

View and change WAC communication port settings. WAC port includes such 
parameters: “ Baud rate” , “ Data length” , “ Parity check” , and “ Stop bits” .  
  
Examples:  
 
¶ To view the current port parameters, using this command:  
 

WAC port [<port name>] 
i.e.; wac port com1  

 
¶ To change WAC port parameters, using this command:  
 

WAC port [<port name>] [Baud=<b>] [Parity=n|e|o] [Data=<d>] [Stop=<s>] 
i.e.; wac port com1 baud=9600 parity=n data=8 stop=1 

 
NOTES: 
 
¶ Where <port name> is the name of the port you want to use, like "COM1".   
 
¶ You can also use “ Communication Settings”  within WAC configuration tools to this 

port setting. For further information, see Chapter Five –  Serial Port Settings - “ Set the 
Communication Parameters” .  

 
¶ Please note the changed terminal port only takes effective after you re-logon on WAC 

Server.  

WAC Term 

Set a different serial terminal screen size. The default serial terminal size is 80x24.  
  
Examples:  
 
¶ To view current terminal information, using this command:  
 

WAC term [<port name>] 
i.e.; wac term com1 

 
¶ To reset the display size of your screen buffer, using this command: 
 

WAC term [<port name>] [Width=<w>] [Height=<h>] 
i.e.; wac term com1 width=80 height=25 
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NOTES:  
 
¶ The changed terminal size only takes effective after you re-logon to WAC Server 

using the port, because WAC Server detects the terminal size only when session got 
started.  

 
¶ You can also use “ Communication Settings”  within WAC configuration tools to this 

port setting. For further information, see Chapter Five –  Serial Port Settings - “ Set the 
Communication Parameters” . 

WAC Start | Stop | Restart  

Disable or enable Foxit WAC Server service by executing start, stop or restart task.  
 
Examples: 
 
¶ To start WAC Service, do like this:  
 

At the command line, type wac start, and then type Enter. You should see an 
"Operation success" message if WAC Server service has been started. 
  
If the WAC Service has been stopped on your host machine, you can't create any 
connection from your client machine before it is started, you have to go to the host 
machine to start it by the command prompt, Windows "Services", WAC "Service 
Manager" or WAC Manager. 
 
If you have copied WAC "Service Manager" into your client machine, you can use it 
to remotely start WAC Service. For instructions, please see "Connect to Another 
Computer" in the "Service Manager" section of Part Two. 

 
¶ To stop WAC Service, do like this:  
 

Within a WAC session, at the command line, type wac stop, and then type Enter. 
Your current session connection will be closed. 
 
Use this command, WAC Server will close and disconnect all your current terminal 
sessions before it is stopped and you can't get connected again until the WAC Server is 
restarted. So if you want to reconnect shortly after stop the service, it is better to use 
wac restart.  

 
¶ To restart WAC Service, do like this: 
 

At the command line, type wac restart, and then type Enter. Your current session 
connection will be closed. 
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This command will also close and disconnect all your current terminal sessions, but 
you can reconnect after a short period of time.  

WAC disable | enable Telnet | SSH | Serial  

Turn on or off WAC Telnet, SSH, and Serial Port Service. After disabling any of the 
service, you are not able to connect with WAC Server over this service any longer until 
enabling it again. 
 
Examples: 
 
¶ To disable or enable Telnet service, do like this: 
 

At the command line, type wac disable telnet or wac enable telnet, and then press 
Enter. You will be prompt to confirm your action, conform it, press Y, otherwise press 
N. 

 
¶ To disable or enable SSH service, do like this: 
 

At the command line, type wac disable ssh or wac enable ssh, and then press “ Enter” . 
You will be prompt to confirm your action, conform it, press Y, otherwise press N. 

 
¶ To disable or enable Serial Port service, do like this: 

 
At the command line, type wac disable serial or wac enable serial, and then press 
Enter. You will be prompt to confirm your action, conform it, press Y, otherwise press  
N . 

 
NOTE: 
 
¶ You can also use “ Server Global Settings”  within WAC configuration tools to disable 

or enable the Telnet, SSH, Serial Port service.  See Chapter Five - “ Server Global 
Settings” .  

WAC SendFile 

Transfer files from WAC Server to your local client machine. 
 
Example: 
 
¶ To send file, using this command:  
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WAC sendfile [filename] 
i.e.; 
wac sendfile myfile.txt 
wac sendfile ..\mydir\myfile.txt 
wac sendfile c:\mydir\myfile.txt 

 
NOTES:  
 
¶ Right now you can only send one file at a time, and the sending will be done at 

background so when it's sending, you should be able to proceed with your session  
 
¶ During the file transferring, you can't start the sending for another file. You have to 

wait for the current file to be finished. In future version of WAC Server, a queue will 
be implemented allowing a bunch of files to be started at the same time.  

 
¶ In WAC session, you can use more than one way to transfer files between you server 

machine and client machine. For details, please see the "File Transfer" section in 
Chapter Four. 

WAC Shutdown | Reboot  

 Shutdown or reboot a local or remote machine. 
 
Examples: 
 
¶ To shutdown a computer, do like this: 
 

Within a WAC session, at the command line, type wac shutdown <plus the remote 
machine name>, and then type Enter, press Y when prompted to confirm. 
 
If typing wac shutdown and pressing Enter will close down the local computer.  

 
¶ To reboot a remote machine, do like this: 
 
Within a WAC session, at the command line, type wac reboot <plus the remote 
machine name>, and then type Enter, press Y when prompted to confirm. 
 
If typing wac reboot and pressing Enter will restart the local computer.  
 
Using this command option, the computer will be automatically started after a period of 
short time. 
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WAC Password 

Allow users to change the login password on your host machine. The user will be 
prompted for old password, new password and new password confirmation. 
  
Example: 
 
¶ To change the login password on your host machine, at the command line, type: 
 

"wac password <plus login username>" 
"i.e.; wac password John" 

 
And then type the old password, new password, and finally confirm it. Users will 
see a "Password has been changed" message if the password was changed 
successfully. 

 
NOTES: 
 
¶ Every Windows user possesses a password and username. If you are an Administrator 

and know this user's name and password, you can change it.  
 
¶ You can also use “ User Manager”  to change the login password for users or for 

yourself. For more information, see Chapter One –  “ User Manager”  in Part Three. 

WAC SSHKey 

Allow you to regenerate the SSH server (host) key (see SSH Server Key Regeneration in 
Chapter Six). 
 
Example: 
 
¶ To regenerate the SSH server key, at the command line, type wac sshkey and press 

Enter. You will be prompted to wait a moment while regenerating the key. And if 
succeed, you will see an “ Operation Success”  message. 

 
NOTES: 
 
¶ During installation, WAC Server automatically generates SSH server key for you and 

stores the public key as “ pubkey.txt”  into WAC Server installation directory. 
 
¶ You can also use WAC Configuration tools to regenerate the SSH key. For more 

information see Chapter 5 –  “ Regenerate SSH Server Key” . 
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WAC Userkey  

Allow you to add a generated user public key to WAC Server, or remove a previously 
imported public key from WAC Server. You can also use WAC Manager to import the 
public key.  See Chapter Five -  “ User Public Key Authentication” . 
 
Examples: 
 
¶ To import the generated public key to the WAC Server, using this command: 
 

WAC UserKey Add <Public Key File> <User Name> <password> 
i.e.; wac userkey add c:\file path\pubkey filename John welcome 

 
You will see an "Operation success" message if the public key has been imported to 
WAC Server. 

 
Where: 
 
¶ The <Public Key File> is the file name for the transferred public key. You should 

tell the full path where public key file locates at.  
 
¶ The <Username> is the name of Windows user who will use the public key to 

authenticate later. Sometimes the public key file includes information about the 
user, in this case you don't need to supply the user name.  

 
¶ The <Password> is the password of Windows user. If you provide password here, 

you will be not asked for to provide password when login even though you are the 
first logon using the public key However if you don't provide the password here, 
you can just press Enter to ignore it if there requires password. See the “ User 
Public Key Authentication”  section for more information. 

 
The above command will register the public key into WAC Server registry and it will 
be got back to compare with the submitted public key later when the user tries to 
authenticate using public key method. 

 
¶ To remove a previously imported public key from WAC Server, using this command: 
 

WAC UserKey Del <User Name> 
i.e.; wac userkey del John 

 
You will see an "Operation success" message if the public key has been removed from 
WAC Server. 
 
NOTE: You can also use WAC Manager to import or delete the user public key. For 
more information see Chapter five –  User Public Key Authentication. 



                                                                                                                                                                                 

Page 53 of 231 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



                                                                                                                                                                                 

Page 54 of 231 

 
 
 
 
 
 
 
 
 
 

CHAPTER FIVE 

Configuring WAC Server 
 
This chapter includes the following three sections: 
 
¶ The “ Configuration Tools”  section briefly describes the tools that can be used to 

configure WAC Server, and the details are provided in the “ References”  section. 
 
¶ The “ Advanced Configuration Features”  section gives an overview on the five parts 

of WAC Server configuration settings and detailed introductions to the configuration 
meanings and how-to methods. 

 
¶ The “ References”  section exists to complement the above two sections. 
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Configuration Tools 
 
During the installation of WAC Server, you will be asked for some configurations like 
the port number of telnet or SSH service, the list of serial communication ports, local 
print port number etc., all these configurations are saved into server registry and are taken 
by the server when it starts. These configurations, along with some other settings, can be 
also modified after the installation using the following two WAC configuration tools:  
 
¶ Local GUI-based configuration program "WAC Manager (wacman.exe)" 
¶ Remote text-based configuration program "CONFIG.EXE"  
 
WAC Manager and CONFIG.EXE actually functions alike in the server configuration 
except that WAC Manager is a GUI program that is desirable for local operation, and 
CONFIG.EXE is a console program that is desirable for remote operation. Most of 
configuration settings WAC Server provides that are set up in CONFIG.EXE can also be 
achieved in WAC Manager. 
 
 For setting instructions, please refer to “ Advanced Configuration Features”  in the next 
session, for the tools, refer to the “ Reference”  section. 
 

Advanced Configuration Features –  An 
Overview 
 
In WAC Server, five head parts of settings constitute the advanced configuration features. 
They includes Server Global Settings, User Settings, Access Control, Serial Port Settings 
and SSH Settings.  
 
¶ “ Server Global Settings”  is the configuration for whole server. This head part can be 

configured either by “ Sever Settings”  in CONFIG.EXE, or by its appropriate settings 
page in WacMan.exe 

 
¶ “ User Settings” , including “ User Preference”  and “ User Admin Settings” . This part 

can be configured either by “ User Preference”  and “ Admin Settings”  in 
CONFIG.EXE, or by “ User Preference for Current User”  and “ User Admin Settings”  
in WacMan.exe. 

 
¶ “ Access Control” , including “ User Access Control”  and “ Host Access Control” . This 

head part can be configured either by “ Admin Settings”  in CONFI.EXE, or by “ User 
Access Control”  and “ Host Access Control”  in WacMan.exe. 

 
¶ “ SSH Settings”  is for all supported SSH services and SSH key settings. This head 

part can be configured either by its appropriate settings page in CONFIG.EXE, or by 
“ SSH Settings”  in WacMan.exe.  
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¶ “ Serial Port Settings”  is for serial port communication settings. This head part can be 

configured either by “ Communication Settings”  in CONFIG.EXE, or by “ Serial Port 
Settings”  in WacMan.exe. 

Server Global Settings 

When working with WAC Server, you may want to disable or enable some configuration 
settings for whole server. WAC Server provides lots of global configurable settings for 
you to do. These settings include: 
 
¶ User logon settings like “ domain settings” , “ max retry” , “ timeout”  and “ logon 

banner” ;  
¶ Session settings like “ output redirection”  and “ terminal update rate” ;  
¶ “ Telnet” , “ SSH” , and “ serial port”  communication settings;  
¶ “ File transfer” , “ SFTP” , and “ anonymous account”  settings;  
¶ “ LPT port”  for client side print settings 
¶ “ Log Mask”  and “ Log Path”  for event logging file settings. 
  
NOTES: 
 
Á After you have modified the settings, you must RESTART WAC Server to take 

your changed configuration settings effective. 
 
Á All the above settings can be accomplished by either WacMan.exe or CONFIG.EXE. 

User Logon Domain Name (UseDomain) 

This configuration feature disables or enables the domain option when user logs on. If its 
value is enabled, when user connects to WAC Server, the server will ask the user for the 
domain name after the user name and password were asked for. This domain name will 
then to be used to verify the logon information.  
 
If you disable this configuration, WAC Server won't ask the user for the domain name, 
then WAC Server will always use the local domain which means the user name and 
password are only checked locally.  
 
Even if domain selecting is enabled, the user can also ignore the domain name by just 
press Enter when asked for the domain name. In this case the local domain is used. If 
you feel that all your users log onto the local domain only, disabling this configuration   
will be definitely more convenient for them because no need to press an extra Enter . 
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The default value for this configuration is enabled, which means the user will be asked 
for the domain name he/she wants to log onto. 
 
Here are instructions for domain configurations in either WacMan.exe or CONFIG.EXE: 
 
¶ If you use WacMan.exe, you need to go to “ Server Global Settings”  page, and there is 

a setting called “ ask for domain name when user logs on” . Check it to enable, de-
check it to disable. By default, it is checked. 

 
¶ If you use CONFIG.EXE, you need to go to “ Sever Settings”  page, and from the left 

side box, choose a setting called “ UseDomain” , and then set “ 1”  to enable, "0" (zero) 
to disable. 

 
NOTE: You have to restart WAC Server service to take your changing effective. 

User Logon Max Retry (MaxLogRetry) 

The maximum number of retries will be allowed for each user logon. If the user still can't 
provide the correct user name and password information after this number of retries, 
WAC Server will disconnect the user connection. 
 
Sometimes you might want to increase this number if somehow your users often can't get 
logged on within this particular number of retries, or, if serial port connection is used, 
since the serial port communication is not reliable, the logon might often fail due to the 
data loss or false data caused by the poor quality of the link. 
 
But you should beware of large retries number being used, because this will provide 
convenience to those intruders who try to figure out the password by trying to logon 
again and again. 
 
The default value for this configuration is 3, which means the server will disconnect if the 
user fails 3 times logging on. 
 
Here are instructions for logon retry configurations in either WacMan.exe or 
CONFIG.EXE: 
 
¶ If you use WAC Manager, you need to go to “ Server Global Settings”  page, and there 

is a setting called “ Max Logon Retry” , you can just enter the retry numbers in the 
adjacent edit box for it.  

 
¶ If you use CONFIG.EXE, you need to go to “ Sever Settings”  page, and from the left 

side box, choose a setting called “ MaxLogonRetry” , and then set the retry numbers 
for it. 

 
NOTE: You have to restart WAC Server service to take your changing effective. 
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User Logon Timeout (LogonTimeOut) 

The maximum number of seconds for a period that the server waits for user input before 
it disconnect during the logon process. The user has to keep typing during the logon, if 
he/she keeps inactive for a period of time, the server will think that this guy don't want to 
logon anymore, or the link between terminal and server is actually broken, then the server 
will disconnect. 
 
The default value for this configuration is 300, which means if you keep inactive for 5 
minutes during the logon, you'll be disconnected. This is a quite long period actually. 
You might want to decrease it if you want to kick out those inactive or broken links as 
soon as possible. 
 
Here are instructions for logon timeout configurations in either WacMan.exe or 
CONFIG.EXE: 
 
¶ If you use WacMan.exe, you need to go to “ Server Global Settings”  page, and there is 

a setting called “ Logon Time Out” , you can just enter the timeout value for it in the 
adjacent edit box.  

 
¶ If you use CONFIG.EXE, you need to go to “ Sever Settings”  page, and from the left 

side box, choose a setting called “ LogonTimeout” , and then set the timeout value for 
it. 

 
NOTE: You have to restart WAC Server service to take your changing effective. 

User Logon Banner (LogonBanner) 

The welcome text that got displayed on the top area in a client window upon connection 
before logging in, is called logon banner. See the figure below: 
 

Logon Banner 
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This feature is for licensed copy only. If you are a licensed user, you can change the 
logon banner as you want. Your banner will be viewed by all client users in the 
connecting period. 
 
Here are instructions for logon banner configurations in either WacMan.exe or 
CONFIG.EXE: 
 
¶ If you use WacMan.exe, you need to go to “ More Server Settings”  page, and there is 

a setting called “ Logon Banner” , you can just enter the banner contents for it in its 
adjacent edit box.  

 
¶ If you use CONFIG.EXE, you need to go to “ Sever Settings”  page, and from the left 

side box, choose a setting called “ LogonBanner” , and then in the edit line enter the 
banner contents for it. 

 
NOTE: You have to restart WAC Server service to take your changing effective. 

Global Agent Redirection (AgentRedirection) 

This configure feature is used to control the way WAC session agent monitors the session 
output. WAC session agent has some effect on the output of some command line 
applications. For more information, please refer to Chapter One - “ WAC Session Agent” . 
 
You can enable and disable the redirection, or conditionally enable and disable the 
redirection. 
 
The default value is conditionally enabled, which means the server conditionally enable 
the redirection when using VT compatible terminal of such a kind, and disable the 
direction when using WAC Native Clients, VTNT of such a type of terminals 
 
Here are instructions for redirection configurations in either WacMan.exe or 
CONFIG.EXE: 
 
¶ If you use WacMan.exe, you need to go to “ Server Global Settings”  page, and there is 

a setting called “ Redirect Program Output” , you can just check the relevant box to 
‘ not redirected’ , ‘ always redirected’ , or ‘ conditionally not redirected and redirected’  
which is the default value. 

 
¶ If you use CONFIG.EXE, you need to go to “ Sever Settings”  page, and from the left 

side box, choose a setting called “ AgentRedirect” , then in the edit line set the value 
for it. “ 0”  to disable, “ 1”  to enable, “ 2”  to conditionally enable and disable. The 
default value is “ 2” . 

 
NOTES:  
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¶ You have to restart WAC Server service to take your changing effective. 
 

¶ This “ Agent Redirection”  is configured for the global server, yet, the system 
administrator can also configure this setting for a certain user or user group. For 
details, see User Admin Settings - “ User Agent Redirection”  in this chapter. 

Session Tick for Terminal Update (SessionTick) 

As described in the "WAC Session Agent”  section (see chapter one), the WAC session 
agent keeps monitoring the screen output by applications in the session, and if any 
changes found, the changes will be sent to the terminal. The session agent checks the 
output periodically and the period between two checks is controlled by this "Session 
Tick" configuration. The value for this configuration represents the number of 
milliseconds. 
 
The default value for this configuration feature is -1, which means "ASAP", the session 
agent will pick an appropriate time interval for monitoring the session output. 
 
Set a large interval for session agent will decrease the CPU usage of the session agents, 
but it will also increase the response time of sessions. 
 
Here are instructions for session tick configurations in either WacMan.exe or 
CONFIG.EXE: 
 
¶ If you use WacMan.exe, you need to go to “ Server Global Settings”  page, and there is 

a setting called “ Session Tick” , you can just enter the tick value in its adjacent edit 
box. 

 
¶ If you use CONFIG.EXE, you need to go to “ Sever Settings”  page, and from the left 

side box, choose a setting called “ SessionTick” , and then in the edit line set the value 
for it.   

 
NOTE: You have to restart WAC Server service to take your changing effective. 

Telnet Service (EnableTelnet) 

The telnet service can be turned on or off by this configuration feature.   
 
Telnet service allows telnet clients to connect to the server and create user sessions. If 
disabled, when a telnet client tries to connect to WAC Server, it will get a "connection 
refused" or "can't connect" error. 
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By default the telnet service is enabled. Sometimes you might need to disable the telnet 
service when you don't want to use it because: 
 
¶ You are using another telnet server, and it will conflict with WAC Server's telnet 

service (unless different port number is used, refer to the “ Telnet Port”  configuration);  
 
¶ You don't want the users to use the insecure telnet service, and you have SSH service 

available to them; 
 
¶ You experienced some problem with the WAC Server's telnet service and you want to 

shut it down temporarily.  
 
Here are instructions for telnet service configurations in either WacMan.exe or 
CONFIG.EXE: 
 
¶ If you use WacMan.exe, you need to go to “ Server Global Settings”  page, and there is 

a setting called “ Enable Telnet” . Check it to enable, and de-check it to disable. By 
default the box is checked. 

 
¶ If you use CONFIG.EXE, you need to go to “ Sever Settings”  page, and from the left 

side box, choose a setting called “ EnableTelnet” , and then in the edit line set the 
value for it: “ 1”  to enable, “ 0”  to disable. 

 
NOTE: You have to restart WAC Server service to take your changing effective. 

Telnet Port (TelnetPort) 

The TCP port which the WAC Server's telnet service listens on. 
 
By default, telnet service listens on port number 23, this is defined by the Internet 
standard, most likely you should use this port so all telnet clients can get connected with 
your server easily. But sometimes you might need to change the default port to another 
port due to: 
 
¶ You have another telnet server running and you don't want to conflict with it. On the 

same host, there can't be two applications listening on the same port, so if you don't 
want to change the port settings of another telnet server, you have to change the WAC 
Server. 

 
¶ Somehow the firewall settings of your network requires you to use another port 

number because the default port number is disabled or something;  
 
¶ You just want to use another port so that no outsider can easily find the port number 

and get connected with your server.  
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Here are instructions for telnet port configurations in either WacMan.exe or 
CONFIG.EXE: 
 
¶ If you use WacMan.exe, you need to go to “ Server Global Settings”  page, and there is 

a setting called “ Telnet Port” , you can just enter the port number in its adjacent edit 
box. 

 
¶ If you use CONFIG.EXE, you need to go to “ Sever Settings”  page, and from the left 

side box, choose a setting called “ TelnetPort” , and then in the edit line set the port 
value for it. 

 
NOTE: You have to restart WAC Server service to take your changing effective. 

SSH Service (EnableSSH) 

This configuration feature is set to turn on or off the SSH service. 
 
SSH service allows SSH clients to connect to the server and create user sessions. If 
disabled, when an SSH client tries to connect to WAC Server, it will get a "connection 
refused" or "can't connect" error. 
 
By default the SSH service is enabled. Sometimes you might need to disable the SSH 
service when you don’ t want to use it because: 
 
¶ You are using another SSH server, and it will conflict with WAC Server's SSH 

service (unless different port number is used, refer to the " SSH Port”  configuration);  
 
¶ You don't want to set up the SSH keys and/or publish them to your users;  
 
¶ You experienced some problem with the WAC Server's SSH service and you want to 

shut it down temporarily.  
 
Here are instructions for SSH Service configurations in either WacMan.exe or 
CONFIG.EXE: 
 
¶ If you use WacMan.exe, you need to go to “ SSH Settings”  page, and there is a setting 

called “ Enable SSH Service” . Just check it to enable, or de-check it to disable. By 
default, this setting is enabled.  

 
¶ If you use CONFIG.EXE, you need to go to “ Sever Settings”  page, and from the left 

side box, choose a setting called “ EnableSSH” , and then in the edit line set the value 
for it: “ 1”  to enable, “ 0”  to disable. 

 
NOTE: You have to restart WAC Server service to take your changing effective. 
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SSH Port (SSHPort) 

The TCP port which the WAC Server's SSH service listens on. 
 
By default, SSH service listens on port number 22. This is defined by the Internet 
standard. Most likely you should use this port so all SSH clients can get connected with 
your server easily. But sometimes you might need to change the default port to another 
port due to: 
 
¶ You have another SSH server running and you don't want to conflict with it. On the 

same host, there can't be two applications listening on the same port, so if you don't 
want to change the port settings of the another SSH server, you have to change the 
WAC Server;  

 
¶ Somehow the firewall settings of your network requires you to use another port 

number because the default port number is disabled or something;  
 
¶ You just want to use another port so that no outsider can easily find the port number 

and get connected with your server.  
 
Here are instructions for SSH port configurations in either WacMan.exe or 
CONFIG.EXE: 
 
¶ If you use WAC Manager, you need to go to “ Server Global Settings”  page, and there 

is a setting called “ SSH Port” , you can just enter the port number in its adjacent edit 
box. 

 
¶ If you use CONFIG.EXE, you need to go to “ Sever Settings”  page, and from the left 

side box, choose a setting called “ SSHPort” , then in the edit line set the port value for 
it. 

 
NOTE: You have to restart WAC Server service to take your changing effective. 

Serial Port Service (EnableComm) 

This configuration feature is set to turn on or off serial port service.   
 
Serial port service allows serial port terminals to connect to the server and create user 
sessions. If disabled, when a terminal tries to connect to WAC Server, it will get nothing. 
 
By default the serial port service is enabled. But you can’ t use port service unless you 
declare serial ports in the “ Serial Port List” . 
 



                                                                                                                                                                                 

Page 64 of 231 

Sometimes you might need to disable the serial port service temporarily due to some 
problem with it. 
 
Here are instructions for serial service configurations in either WacMan.exe or 
CONFIG.EXE: 
 
¶ If you use WacMan.exe, you need to go to “ Serial Port Settings”  page, and there is a 

setting called “ Enable Serial Port Access” . Just check it to enable, or de-check it to 
disable. By default the box is checked. 

 
¶ If you use CONFIG.EXE, you need to go to “ Sever Settings”  page, and from the left 

side box, choose a setting called “ EnableComm” , and then in the edit line set the 
value for it. “ 1”  to enable which is the default value, “ 0”  to disable. 

 
NOTES:  
 
¶ You have to restart WAC Server service to take your changing effective. 
 
¶ For general information about serial port and its settings, you can refer to the “ Serial 

Port Settings”  section in this chapter. 

Serial Port List (CommPortList) 

This is the list of serial ports that users can use to connect their serial port terminal to the 
WAC Server. 
 
This configuration feature is only useful when serial port service is enabled. When you 
specify port list, you should use their port names, and separate them with comma, for 
example, "COM1"or "COM1, COM2". Please don't input any extra characters. 
 
The default value for this configuration is empty means no serial port can be used to 
connect. 
 
Here are instructions for serial port configurations in either WacMan.exe or 
CONFIG.EXE: 
 
¶ If you use WacMan.exe, you need to go to “ Serial Port Settings”  page, and there is a 

setting called “ Serial Port List” . To declare the port, in the edit box above the “ Add 
Port”  button, enter the serial port, and click on “ Add Port”  button. To remove the 
declared port, highlight the port in the “ Serial Port List”  box, and then click on 
“ Remove”  button. 

 
¶ If you use CONFIG.EXE, you need to go to “ Sever Settings”  page, and from the left 

side box, choose a setting called “ CommPortList” , and then in the edit line set the 
value for it.    
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NOTES:  
 
¶ You have to restart WAC Server service to take your changing effective. 
 
¶ For general information about serial port and its settings, you can refer to the “ Serial 

Port Settings”  section in this chapter. 

File Transfer (FileTransfer) 

This configuration feature is used to set up file transfer service for WAC Native Clients. 
You can disable the file transfer service, and can also conditionally enable it to send files: 
“ server to terminal only” , “ terminal to server only” , or “ both ways interactively” . 
 
If you enable the file transfer type as "server to terminal only", your files can never be 
able to send to server from the client machine. And alike, if you enable the transfer type 
as “ terminal to server only” , your files can never be able to send to client from the server. 
While if you enable “ Both ways transfer” , you can be able to send files interactively.  
 
The default value for this configuration is both ways transfer. 
 
Here are instructions for file transfer configurations in either WacMan.exe or 
CONFIG.EXE: 
 
¶ If you use WacMan.exe, you need to go to “ Server Global Settings”  page, and there is 

a setting called “ File Transfer for WAC Native Clients” . Just check the relevant check 
box to specify the transfer type you want. 

 
¶ If you use CONFIG.EXE, you need to go to “ Sever Settings”  page, and from the left 

side box, choose a setting called “ FileTransfer” , and then in the edit line set the value 
for it. 

 
NOTES:  
 
¶ You have to restart WAC Server service to take your changing effective. 
 
¶ For general information and instruction for file transfer in WAC session, please refer 

to Chapter Four –  “ File Transfer” . 

Global SFTP Service (EnableSFTP) 

This configuration feature is used to turn on or off the build-in SFTP service for the 
whole server.  
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By default the SFTP service is enabled for the whole server, and normally all users who 
can access you server can sftp your sources on the server machine. While system 
administrator can change this access condition, he/she can use the “ Admin Settings”  to 
disable or enable the SFTP service for a certain user or group, and even create the access 
root directory to restrict the users’  sftp activities. 
 
Here are instructions for SFTP global configurations in either WacMan.exe or 
CONFIG.EXE: 
 
¶ If you use WacMan.exe, you need to go to “ SSH Settings”  page, and there is a setting 

called “ Enable the build-in SFTP service for secure file transfer” .  Just check the 
adjacent box to disable and enable SFTP service. By default, the box is checked.. 

 
¶ If you use CONFIG.EXE, you need to go to “ Sever Settings”  page, and from the left 

side box, choose a setting called “ SFTP” , and then in the edit line set the value for it. 
“ 0”  is to disable, “ 1”  is to enable and is the default value 

 
NOTES:  
 
¶ You have to restart WAC Server service to take your changing effective. 
 
¶ This SFTP service configuration is for the whole server, yet, the system administrator 

can also configure the SFTP service for a certain user or user group. See User Access 
Control - Restrict Users to Use SFTP Service in this chapter. 

 
¶ For generation information and instructions about SFTP service, please refer to SSH 

Settings - SFTP Service in this chapter. 

Anonymous Access to SFTP Service 

This configuration feature is used to configure anonymous access for SFTP access. 
 
Anonymous access means any user can logon to SFTP service with "Anonymous" as user 
name, and anything as password. Since this no user authentication, anonymous access to 
SFTP Service should be strictly limited.  
 
The configuration of anonymous access requires specifying a root directory and selecting 
an anonymous access type: “ No access” , “ Reading server only” , “ Writing server only” , 
“ Both Reading and Writing” . 
 
Here are instructions for anonymous access configurations in either WacMan.exe or 
CONFIG.EXE: 
 
¶ If you use WacMan.exe, you need to go to “ SSH Settings”  page. In this page, you 

should set the following parameters:  
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Á Root Directory: Click on 'Browse" to select folder for anonymous user access. 

 
Á Anony Access: This parameter specifies the access types allowed for anonymous 

access. The default option is "Reading server only". If you select "No access", 
anonymous account will be disabled.  

 
¶ If you use CONFIG.EXE, you need to go to “ Sever Settings”  page. In this page, you 

should set up the following three configuration variables: 
 
Á AnonyAccount: This parameter should be set to 1 to enable anonymous account; if 

this account is disabled, you are not able to use anonymous access. 
 
Á AnonyDir: This parameter should be set to the root directory allowed for 

anonymous access; It should be strictly limited for you security. 
 
Á AnonyAccess: This parameter specifies the access types allowed for anonymous 

access. 0 for no access, 1 for reading only, 2 for writing only, 3 for both reading 
and writing. The default is “ 1” . If you set the value to “ 0” , that is equal to disabling 
the anonymous account. 

 
NOTES:  
 
¶ You have to restart WAC Server service to take your changing effective. 
 
¶ For generation information and instructions about SFTP service, please refer to SSH 

Settings –  SFTP Service in this chapter. 

LPT Port for Client Side Printing (LTPPort) 

This configuration is used to specify LPT port number which will be mapped to WAC 
printing redirector, so that your DOS application can print server information at client 
side.  
 
Most DOS-based programs print to the LPT1 or LPT2 ports by default. So to allow DOS 
application to use Client Side Printing, at least one LPT port has to be mapped to WAC 
Printing Redirector. 
 
If you have installed WAC Server, you already know you can set the LPT port in 
progress of WAC Server Installation. And LPT port can be reset using one of WAC 
configuration tools. 
 
Here are instructions for LPT Port configurations in either WacMan.exe or 
CONFIG.EXE: 
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¶ If you use WacMan.exe, you need to go to “ More Server Settings”  page, and there is 
a setting called “ LPT Port” . Just check the relevant check box to specify the LPT port 
number you want. If you set “ No use LPT” , no LPT port will be mapped. 

 
¶ If you use CONFIG.EXE, you need to go to “ Sever Settings”  page. And from the left 

side box, choose a setting called “ LPTPort” . Then in the edit line, enter the port 
number for it like “ LPT1, LPT2,”  which are the most common used. If you don't need 
LPT port, just leave it empty. 

 
NOTES:  
 
¶ You have to restart WAC Server service to take your changing effective. 
 

¶ For general information and instructions for WAC client side printing, please refer to 
References - Client Side Printing in this chapter. 

Log Mask for WAC Event Logging (LogMask) 

This configuration is used to specify what kind of server information to be recorded into 
log file.  
 
For details, please refer to References - WAC Event Logging –  “ Define Log Mask”  in 
this chapter. 

Log Path for WAC Log File (LogPath)  

This configuration is used to specify the directory where you want to place the log files in. 
 
For details, please refer to References - WAC Event Logging –  “ Change Log Path”  in 
this chapter. 

User Settings  

The “ User Settings”  in WAC Server actually includes “ User Preference” , “ User Admin 
Settings”  and “ User Access Control” . In this section, we will be introducing “ User 
Preference”  and “ User Admin Settings” ; and the “ User Access Control”  will be 
describing within the section “ Access Control” .  
 
In the “ User Settings” , when user logs into WAC Server, by default, the “ User 
Preference”  settings will be used first, then the default settings. While if the administrator 
has enabled “ Supercede User”  for this user or this user group in the “ User Admin 
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Settings”  page, when this user logs in, the admin settings will be used first, and this user 
preferences are ignored. 
 
If you have configured WAC Server, you already know all settings that can be configured 
in “ User Preference”  page can also be achieved in “ User Admin Settings”  page. This is 
easy for the administrator to manage and control users’  preference settings. 
 
The following user settings can be set by either user or administrator: 
 
¶ Initial Directory (InitDir): The initial directory when the user logs on;  
¶ StartScript: the startup command that got automatically executed when the user logs 

on;  
¶ WAC Menu (WacMenu): Whether the WACMENU application will be displayed 

after the user logs on;  
¶ Agent Redirect (AgentRedirect): Whether the shell will be executed in a redirected 

environment. 
¶ Shell: The shell program. By default the Windows command interpreter (cmd.exe) is 

used, but user or administrator can specify alternative shell program, like the WAC 
Protected Shell;  

¶ Watch Users (WatchUsers): Specify a list of users who can watch your session. 
¶ Control User (ControlUsers): Specify a list users who can control or take over your 

session 
¶ Heart Beat: Specify the heart beat period, in seconds. 
¶ Keep Session: Specify the period for WAC Server to keep the broken session, in 

seconds. 
¶ Auto Reconnect: Whether to automatically reconnect to the broken or existing 

session. 
¶ SupercedeUser: Whether the user's settings should be disabled and use 

administrator’ s settings. 

User Preference 

After you get used to WAC Server and its applications, you might want to make yourself 
more comfortable by introducing some settings especially for you and nobody else. All 
these settings are called "User Preference".  
 
Every Windows user can specify their preferences. However, all these user preference 
settings can be set and reset by system administrator using “ User Admin Settings” . In 
other words, all the settings you have done on this page will not take effective once the 
system administrator chooses to reset and supercede your settings.  For more information 
and the parameter references, please refer to the “ User Admin Settings”  section. 
 
Setting up the user preference can be accomplished by either WacMan.exe or 
CONFI.EXE. 
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¶ If you use WacMan.exe, you need to go to “ User Preference for current user”  page, 
and then in the relevant settings line, just click on the "Browse" or "Choose" button, 
or check the "check box" to modify the settings. 

 
¶ If you use CONFIG.EXE, you need to go to “ User Preferences”  page, and then click 

on each of the user preferences on the left side, the corresponding value and remark 
will be shown on the right side. Go ahead and change the value in the edit box, then 
continue on other values by clicking on another user preference, or when you are 
done, click the "OK" button.  

User Admin Settings 

As we introduced in the “ User Preference”  section, in WAC Server, each individual user 
can have some of his/her own preferences on several settings, like the initial directory, 
start script, shell program, etc. But sometimes it might be needed for the system 
administrator to step in and help the user to set up the preferences. This kind of settings 
are called "administrator's settings for users", or in short, "user admin settings".  
 
The system administrator can specify settings for each individual user or user group and 
force them to take his/her settings by enabling “ SupercedeUser” . If he/she doesn’ t specify 
a parameter for a particular user or not enabling “ SupercedeUser” , the user preference or 
the default settings for that parameter will be used instead. 
 
And the administrator can also change the default settings for all users.  
 
The following are the general instructions for Admin Settings: 
 
¶ To specify settings for a particular user or user group, select this user or user group 

from the "Current User/Group Name", and modify the settings for the corresponding 
configuration parameters. And then enable “ Supercede Users” . 

 
¶ To supercede the user or user group preference settings, on the "User Admin 

Settings" page, select this user or user group from the "Current User/Group Name", 
and then enable "Supercede User".  

 
¶ To configure the settings for all users, you can choose "Default User Settings" from 

the "Current User/Group Name", and then set up the parameters. If you want the 
default settings supercede the user preferences, you should enable “ Supercede User” . 

 
¶ To save the modification on this page, just go ahead by clicking other page. Your 

modification will be stored automatically.  
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Logon Initial Directory (InitDir) 

The first working directory when user logs on is called “ Initial Directory” . Users will 
directly land on this directory when log on if the “ Start Script”  is left empty and “ WAC 
Menu”  is disabled. 
 
By default, WAC Server installation directory is the initial directory. You can use WAC 
configuration tools to change the directory, locally or remotely. 
 
Here are instructions for initial directory configurations in either WacMan.exe or 
CONFI.EXE: 
 
¶ If you use WacMan.exe, you need to go to “ User Admin Settings”  page. From the 

“ Current User/Group Name” , select the user, user group or DefaultUserSettings that 
you want to control, and then in the “ Initial Directory”  edit box, enter the full path of 
the directory or click on “ Browse… ”  button to select the directory. 

 
¶ If you use CONFIG.EXE, you need to go to “ Admin Settings”  page. From the 

Current User/Group Name, select the user, user group or DefaultUserSettings that 
you want to control, and then from the left side box, choose “ InitDir” , and in the edit 
line, input the full path for the directory. 

 

Logon Start Script (StartScript) 

The executable program file that got executed immediately when user logs on is called 
Start Script. If no value specified for this configuration feature, by default, WAC Server 
will run WAC Menu instead. 
 
This file can be any executable file, like a standard .EXE file, or a batch command file 
with .BAT extension. Make sure you have access right to this file otherwise it won't be 
executed. 
 
To modify this configuration, you should use the full path (starting with the driver name), 
WAC Server will start searching this file in your home directory and then the system path. 
 
The default value for this preference is empty, which means no script or executable file 
will be executed. 
 
Here are instructions for start script configurations in either WacMan.exe or CONFI.EXE: 
 
¶ If you use WacMan.exe, you need to go to “ User Admin Settings”  page. From the 

“ Current User/Group Name” , select the user, user group or DefaultUserSettings that 
you want to control, and then in the “ Start Script”  edit box, enter the full path of the 
directory or click on “ Browse… ”  button to select the directory. 
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¶ If you use CONFIG.EXE, you need to go to “ Admin Settings”  page. From the 
Current User/Group Name, select the user, user group or DefaultUserSettings that 
you want to control, and then from the left side box, choose “ StartScript” , and in the 
edit line, input the full path for the directory. 

 

Launch WAC Menu (WacMenu) 

This configuration feature allows you to disable or enable the automatic launching of 
WacMenu application. 
 
By default, when you log onto WAC Server, and you haven't specified any auto-run file 
using "StartScript" configuration feature, the server will automatically start WACMENU 
application for you, giving you easy access to most of the WAC applications. 
 
If you don't need the menu to be automatically displayed, just disable "WacMenu". And 
if you want later to turn it back on again, enable it again. 
 
If you specify any file in "StartScript" preference, WAC Server will NOT start 
WACMENU application automatically anymore, no matter how you set the WACMENU 
value. If you still want to see the menu, you should add the WACMENU.EXE command 
in your start script. 
 
By default, WACMENU is enabled, which means if "StartScript" preference is empty, 
WAC Server will always launch the WACMENU automatically. 
 
Here are instructions for WAC Menu configurations in either WacMan.exe or 
CONFI.EXE: 
 
¶ If you use WacMan.exe, you need to go to “ User Admin Settings”  page. From the 

“ Current User/Group Name” , select the user, user group or DefaultUserSettings that 
you want to control, and then in the “ Display WAC Menu”  line, check the relevant 
check box perform the task. 

 
¶ If you use CONFIG.EXE, you need to go to “ Admin Settings”  page. From the 

Current User/Group Name, select the user, user group or DefaultUserSettings that 
you want to control, and then from the left side box, choose “ WacMenu” , and in the 
edit line, input the value for it. “ 0”  is to disable, “ 1”  is to enable. 

 

User Agent Redirection (AgentRedirection) 

This configure feature is used to control the way WAC session agent monitors the session 
output. WAC session agent has some effect on the output of some command line 
applications. For more information, please refer to the “ WAC Session Agent”  section. 
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The system administrator can disable or enable “ Agent Redirection”  for a certain user or 
user group or all users based on your terminal conditions so that your terminal is able to 
receive some special characters like the bell signal. 
 
There are three types of ways for you to control the redirection: 
 
¶ Not Redirected: Disable WAC agent redirection.  
 
¶ Redirected: Enable WAC agent redirection. 
 
¶ Taking the Server Settings: Whether to redirect is up to the server global agent 

redirection settings. See "Global Agent Redirection" in "Server Global Settings". 
 
The default value for this configuration is “ Taking the Server Settings”  which means the 
server uses the global “ Agent Redirect”  configuration setting for the server.  
 
Here are instructions for agent redirection configurations for user or user group in either 
WacMan.exe or CONFIG.EXE: 
 
¶ If you use WacMan.exe, you need to go to “ User Admin Settings”  page. From the 

“ Current User/Group Name” , select the user, user group or DefaultUserSettings that 
you want to control, and then under the “ Agent Redirection” , check the relevant 
check box perform the task. 

 
¶ If you use CONFIG.EXE, you need to go to “ Admin Settings”  page. From the 

Current User/Group Name, select the user, user group or DefaultUserSettings that 
you want to control, and then from the left side box, choose “ AgentRedirection” , and 
in the edit line, input the value for it.  

 

Specify User Shell (Shell) 

This is a secure configuration feature that is used to specify the command line shell that 
got executed when a user logs in. By default, cmd.exe is executed, but you can change it 
to any other applications such as “ WAC Protected Shell” . See Chapter Five –  References 
–  “ WAC Protected Shell” . 
 
Upon setting up the shell for a certain user or group, this user or users in this group will 
directly land on this shell when they log in. In this shell, they can only execute some 
commands or programs that the shell allowed. If they do the ultra vires execution, their 
sessions will be immediately closed. This is very useful in restricting user’ s access and 
activities in your server. 
 
Setting up this figuration should use the full path, like "c:\program files\wac\pshell.exe". 
And you can also attach the command parameter to it, like "c:\program 
files\wac\pshell.exe wac.psh".  
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All the above settings can be accomplished by one of WAC configuration tools. Here are 
instructions for shell configurations for user or user group in either WacMan.exe or 
CONFIG.EXE: 
 
¶ If you use WacMan.exe, you need to go to “ User Admin Settings”  page. From the 

“ Current User/Group Name” , select the user, user group or DefaultUserSettings that 
you want to control, and then in the “ Shell”  edit box, enter the full path of the shell or 
click on “ Browser”  to select the shell. 

 
¶ If you use CONFIG.EXE, you need to go to “ Admin Settings”  page. From the 

Current User/Group Name, select the user, user group or DefaultUserSettings that 
you want to control, and then from the left side box, choose “ Shell” , and in the edit 
line, input the full path for the shell. 

Specify the Watching Users (WatchUsers) 

This configuration feature is used to specify a list of users to watch your session. Use 
comma to separate users. And the specified users, even they are but normal Windows 
users, can watch your screen despite your Admin identity. 
 
The specified users can use command tool "wac watch" or “ Session Manager”  to monitor 
your screen. 
 
This configuration can be accomplished by using one of WAC configuration tools. Here 
are instructions for watching user configurations for user or user group in either WAC 
Manager or CONFIG.EXE: 
 
¶ If you use WAC Manager, you need to go to “ User Admin Settings”  page. From the 

“ Current User/Group Name” , select the user, user group or DefaultUserSettings that 
you want to control, and then in the “ Watch Users”  edit box, enter the users or click 
on “ Browse… ”  button to select the users who you allow to monitor your session, 

 
¶ If you use CONFIG.EXE, you need to go to “ Admin Settings”  page. From the 

Current User/Group Name, select the user, user group or DefaultUserSettings that 
you want to control, and then from the left side box, choose “ WatchUser” , and in the 
edit line, input the users separated by comma. 

 

Specify the Controlling and Takeover Users (ControlUsers) 

This configuration feature is used to specify users to control or takeover your session 
screen.  Use comma to separate users. The specified users, even they are but normal 
Windows users, can control and takeover your screen despite your Admin identity. 
 
And the specified users can use command tools "wac control" and "wac takeover", or 
“ Session Manager”  to watch and operate on your screen.   
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This configuration can be accomplished by using one of WAC configuration tools. Here 
are instructions for controlling user configurations for user or user group in either 
WacMan.exe or CONFIG.EXE: 
 
¶ If you use WacMan.exe, you need to go to “ User Admin Settings”  page. From the 

“ Current User/Group Name” , select the user, user group or DefaultUserSettings that 
you want to control, and then in the “ Control Users”  edit box, enter the users or click 
on “ Browse… ”  button to select the users who you allow to control your session, 

 
¶ If you use CONFIG.EXE, you need to go to “ Admin Settings”  page. From the 

Current User/Group Name, select the user, user group or DefaultUserSettings that 
you want to control, and then from the left side box, choose “ ControlUsers” , and in 
the edit line, input the users separated by comma. 

 

Session Heartbeat (HeartBeat) 

This configuration is used to heart beat periods to help identify link or remote computer 
failures. 
 
This configuration can be accomplished by using one of WAC configuration tools. Here 
are instructions for heart beat configurations for user or user group in either WacMan.exe 
or CONFIG.EXE: 
 
¶ If you use WacMan.exe, you need to go to “ User Admin Settings”  page. From the 

“ Current User/Group Name” , select the user, user group or DefaultUserSettings that 
you want to control, and then in the “ Heart Beat”  edit box, enter the time in seconds. 

 
¶ If you use CONFIG.EXE, you need to go to “ Admin Settings”  page. From the 

Current User/Group Name, select the user, user group or DefaultUserSettings that 
you want to control, and then from the left side box, choose “ HeartBeat” , and in the 
edit line, input time in seconds. 

 

Broken Session Keeper (KeepSession) 

This configuration feature is used to specify the period for WAC Server to keep the 
broken session. When a reconnection is not performed within the specified period, the 
broken session will be gracefully terminated.  
 
In the default behavior, upon a client or link failure, or exit illegally, a session will be 
normally terminated deleting all running data. This kind of session is termed to be broken. 
However after setting the “ keep session” , the users are given the opportunities to 
reconnect to the broken session to resume their work.   
 
This configuration can be accomplished by using WAC CONFIG tools. 
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Here are instructions for Keep Session configurations for user or user group in either 
WacMan.exe or CONFIG.EXE: 
 
¶ If you use WacMan.exe, you need to go to “ User Admin Settings”  page. From the 

“ Current User/Group Name” , select the user, user group or DefaultUserSettings that 
you want to control, and then in the “ Keep Session”  edit box, enter the time in 
seconds. 

 
¶ If you use CONFIG.EXE, you need to go to “ Admin Settings”  page. From the 

Current User/Group Name, select the user, user group or DefaultUserSettings that 
you want to control, and then from the left side box, choose “ KeepSession” , and in 
the edit line, input time in seconds. 

 

Session Logon Auto Reconnect (AutoReconnect) 

This auto reconnect method is defined to automatically detect if there is an existing 
session (a broken or active session) for a user when he/she is logging in, if so, WAC 
Sever will automatically reconnect this user to his/her existing broken session or active 
session. 
 
Broken sessions are only saved when you have set the period for the “ Keep Session”  (See 

Chapter Five- Server Global Settings - “ Broken Session Keeper” ). And reconnections must be 
performed within this specified period, or the broken session will be automatically 
terminated by WAC Server. 
 
To reconnect to a broken session or active session, a user must use the same login name 
and password. 
 
There are three types of auto reconnect methods: 
 
¶ Disable: Disallow auto reconnecting. In this case, you will always create a new 

session whenever you log in.   
 
¶ Reconnect to broken session: After enabling this type, when you are logging in, you 

will be always reconnected to your broken session last time you left off. 
 
¶ Always reconnecting: When enable this type, you can create only one session with 

server no matter how many times you log in. That is because always reconnecting can 
automatically detect when you are logging in, and determine if there are any existing 
sessions (broken or active session) for you, if so WAC server will automatically 
reconnect you to the existing session. Thus you have not any chances to create a new 
session. This is useful if there is session limit or you need to log onto the same 
session from different PC.  

 
By default, the auto reconnect is disabled, which means you can create as many sessions 
as your system allowed. 
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Here are instructions for Auto Reconnect configurations for user or user group in either 
WacMan.exe or CONFIG.EXE: 
 
¶ If you use WacMan.exe, you need to go to “ User Admin Settings”  page. From the 

“ Current User/Group Name” , select the user, user group or DefaultUserSettings that 
you want to control, and then in the “ Auto Reconnect”  filed, check the relevant check 
box. 

 
¶ If you use CONFIG.EXE, you need to go to “ Admin Settings”  page. From the 

Current User/Group Name, select the user, user group or DefaultUserSettings that 
you want to control, and then from the left side box, choose “ AutoReconnect” , and in 
the edit line, input value for it: “ 0”  for disable, “ 1”  for reconnecting to the broken 
session, “ 2”  for always reconnecting.  

 
NOTE: 
 
¶ Besides this “ Logon Auto Reconnect” , WAC Server also introduces another watching 

“ Reconnect”  feature that allows you to reconnect your session to an existing session 
when you are watching the sessions. See Chapter Four –  Managing Session -
“ Reconnect to Session” .  

 

Supercede User Settings (SupercedeUser) 

This is Admin only configuration parameter that allows Admin settings to supercede the 
user preferences. 
 
If the system administrator doesn't enable Supercede User for a particular user or group, 
this user or group’ s preference settings will be used first when they log in. Yet, if the 
other way round, the Admin settings will be used first when they log in, and the user 
preferences settings will be ignored. 
 
Here are instructions for Supercede User configurations for user or user group in either 
WacMan.exe or CONFIG.EXE: 
 
¶ If you use WacMan.exe, you need to go to “ User Admin Settings”  page. From the 

“ Current User/Group Name” , select the user, user group or DefaultUserSettings that 
you want to control, and then in the “ Supercede User”  line, check the relevant box. 

 
¶ If you use CONFIG.EXE, you need to go to “ Admin Settings”  page. From the 

Current User/Group Name, select the user, user group or DefaultUserSettings that 
you want to control, and then from the left side box, choose “ SupercedeUser” , and in 
the edit line, input value for it: “ 0”  for not supercede which is the default value, “ 1”  
for supercede..   
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Access Control  

The most important part of the five head parts in the WAC advanced configuration 
settings is “ Access Control” . WAC Server supports a very flexible access control plan. 
Access can be granted or revoked to any particular user, user group, or host address.  
 
For your convenience, WAC Server also allows you to alter default access for all users 
and hosts. 

User Access Control  

For user or user group access control, system administrator can assign access to different 
types of service: SFTP service, port forwarding service, or remote execution service, 
interactive session. Besides, Administrator can also limit the session numbers, confine the 
user connections to some defined hosts and create root directory for SFFP file access. 
 
In addition, the system administrator can also change the default settings for all Users. 
 
The following are the general instructions for Access Control: 
 
¶ To deploy the access control for a particular user or user group, select this user or 

user group from the "Current User/Group Name", and then modify the relevant 
configuration parameters. 

 
¶ To configure the settings for all users, you can choose "Default User Settings" from 

the "Current User/Group Name", and then set up the parameters.  
 
¶ To save the modification on this page, just go ahead by clicking other page. Your 

modification will be stored automatically.  
 

Restrict Users to Use SFTP Service (SFTP) 

 This configuration feature allows system administrator to restrict a certain user and user 
group to use SFTP file access by disabling or enabling SFTP Service. 
 
Here are instructions for User SFTP Service configurations in either WacMan.exe or 
CONFIG.EXE. 
 
¶ If you use WacMan.exe, you need to go to “ User Access Control”  page, and from the 

Current User/Group Name, select the user or group you want to control, or the 
DefaultUserSettings,, and then in the SFTP line, modify the check box. 
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¶ If you use CONFIG.EXE, you need to go to “ Admin Settings”  page, and from the 
Current User/Group Name, select the user or group you want to control, or the 
DefaultUserSettings,, and then modify SFTP value: “ 0”  for disallow, “ 1”  for allow, 
“ leave it empty”  for using default settings. 

 
NOTES:  
 
¶ This SFTP feature is configured for a certain user or group, yet, the system 

administrator can also configure it for the whole server. See Global Server Settings –  
“ Global SFTP Service”  in this chapter. 

 
¶ For general information and instructions on SFTP service, please see SSH Settings –  

“ SFTP Service”  in this chapter.  
 

Limit SFTP File Access (FileRoot) 

This configuration feature is used to set a root directory to limit the file access of a 
certain user or user group’ s SFTP activities. After set the "Root Directory" or "FileRoot", 
all files and directories outside this specified directory won't be accessible to the user's 
SFTP session. 
 
Here are instructions for SFTP File Access configurations in either WacMan.exe or 
CONFIG.EXE. 
 
¶ If you use WacMan.exe, you need to go to "User Access Control" page, and from the 

"Current User/Group Name", select the user or group you want to control, or the 
DefaultUserSettings, and then in the box under the "Root Directory for SFTP 
Service" enter the full directory path or click on "Browse" button to select the folder. 

 
¶ If you use CONFIG.EXE, you need to go to "User Admin Settings" page, and from 

the "Select User/Group" button, select the user or group you want to control, or the 
DefaultUserSettings, and then on the left box, choose "FileRoot" and enter the full 
directory path for it. 

 
NOTE: 
 
¶ For general information and instructions on SFTP service, please see SSH Settings –  

“ SFTP Service”  in this chapter. 
 

Restrict Users to Use Port Forwarding Service (PortFwd) 

This configuration feature allows system administrator to restrict a certain user and user 
group to do port forwarding over a SSH channel. 
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Here are instructions for Port Forwarding configurations in either WacMan.exe or 
CONFIG.EXE. 
 
¶ If you use WacMan.exe, you need to go to “ User Access Control”  page, and from the 

Current User/Group Name, select the user or group you want to control, or the 
DefaultUserSettings, and then in the “ Port Forwarding”  line, modify the check box. 

 
¶ If you use CONFIG.EXE, you need to go to “ Admin Settings”  page, and from the 

Current User/Group Name, select the user or group you want to control, or the 
DefaultUserSettings, and then modify “ PorFwd”  value: “ 0”  for disallow, “ 1”  for 
allow, “ leave it empty”  for using default settings. 

 
NOTE:  
 
¶ For general information and instructions on Port Forwarding, please see SSH Settings 

–  “ Port Forwarding”  in this chapter. 
 

Restrict Users to Use Remote Execution (Exec)    

This configuration feature allows the system administrator to restrict a certain user and 
user group to run remote command execution service through a SSH channel. 
 
Remote Command Execution allows remote users to execute a single command on a 
remote server machine, using any remote execution client that follows the Remote 
Execute UNIX standard, including clients from UNIX, Linux, NT etc. 
 
The Remote Execution is designed for executing a single command, such as a batch file, 
without having to start a interactive session.  
 
In WAC Server, you can submit any Windows command or program (with parameters) to 
the server and get it executed. The output of the command or program will be sent back 
to client for display.  
 
The Configuration of remote command execution can be set using one of the WAC 
configuration tools. As an administrator, you can configure which user or group can use 
this remote execution service, which are not. By default, the remote execution is enabled. 
 
Here are instructions for Remote Execution configurations in either WacMan.exe or 
CONFIG.EXE. 
 
¶ If you use WacMan.exe, you need to go to “ User Access Control”  page, and from the 

Current User/Group Name, select the user or group you want to control, or the 
DefaultUserSettings, and then in the “ Remote Execution”  line, modify the check box. 

 
¶ If you use CONFIG.EXE, you need to go to “ Admin Settings”  page, and from the 

Current User/Group Name, select the user or group you want to control, or the 
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DefaultUserSettings, and then modify “ Exec”  value: “ 0”  for disallow, “ 1”  for allow, 
“ leave it empty”  for using default settings. 

 

Restrict Users to Use Interactive Session (Interactive) 

This configuration feature is used to specify whether to grant a particular user or user 
group to logon interactively.  
 
When the interactive session was disabled for a certain user or user group, this user or 
user group will be never able to access WAC Server except some special service like 
remote execution service. If she or he attempts to connect to WAC Server, her or his 
connection will be at once disconnected upon got connected. 
 
Here are instructions for Interactive configurations in either WacMan.exe or 
CONFIG.EXE. 
 
¶  If you use WAC Manager, you need to go to “ User Access Control”  page, and from 

the Current User/Group Name, select the user or group you want to control, or the 
DefaultUserSettings, and then in the “ Interactive Session”  line, modify the check box. 

 
¶ If you use CONFIG.EXE, you need to go to “ Admin Settings”  page, and from the 

Current User/Group Name, select the user or group you want to control, or the 
DefaultUserSettings, and then modify “ Interactive”  value: “ 0”  for disallow, “ 1”  for 
allow, “ leave it empty”  for using default settings. 

 

Limit the Session Number (SessionLimit) 

Many times, as a system administrator, you may want to limit the maximum number of 
sessions that a user can connect to. You can define the session number for a certain user 
or user group. By default, the session number is not limited, that means the users can 
connect as many sessions as the system permit. 
 
Here are instructions for Session Limit configurations in either WacMan.exe or 
CONFIG.EXE. 
 
¶ If you use WAC Manager, you need to go to “ User Access Control”  page, and from 

the Current User/Group Name, select the user or group you want to control, and in the 
Session Limit line, input the session number you. allow for the selected user or user 
group 

 
¶ If you use CONFIG.EXE, you need to go to “ Admin Settings”  page, and from the 

Current User/Group Name, select the user or group you want to control, or the 
DefaultUserSettings, and then choose “ SessionLimit”  and input the session number 
that you allow for the selected user or user group 
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Restrict Host IP Connections of User (HostList) 

The system administrator may want to confine the connections of certain user or user 
group only to certain particular host IP addresses or a company network. This feature is 
great useful when you want your user to connect to WAC Server only from the company 
network not any other place. 
 
Once the host IP addresses are assigned to the selected user or user group, this user or 
user group will never be able to connect to WAC Server outside the listed IP address. In a 
short, theses users’  connections only from the IP Addresses listed in Host List are 
allowed.  
 
Here are instructions for Host List configurations in either WacMan.exe or 
CONFIG.EXE. 
 
¶ If you use WAC Manager, you need to go to “ User Access Control”  page, and from 

the Current User/Group Name, select the user or group you want to control, or the 
DefaultUserSettings, and in the “ Host List”  line, input the host IP address that you 
allow for the selected user or user group to connect only from. 

 
¶ If you use CONFIG.EXE, you need to go to “ Admin Settings”  page, and from the 

Current User/Group Name, select the user or group you want to control, or the 
DefaultUserSettings, and then choose “ HostList”  and input the host IP address that 
you allow for the selected user or user group to connect only from. 

 
NOTE:  
 
¶ The host addresses must be IP addresses separated by comma. You can use " * ", like 

"192.168.2.* " to specify a network segment.  

Host Access Control 

For particular host address control, you can allow and disallow connections to WAC 
Server. You can also assign stored user/password to any particular address so the client 
can logon without typing anything. This configuration feature is very useful when using 
RF devices to connect. And also it is great helpful when there are computers in a defined 
set of company network that you would not allow to connection to WAC Server. 
 

Allow and Disallow Host IP Connections 

This feature is used to specify whether or not to allow a particular host IP address to 
connect to the server machine.  
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To allow or disallow a host connection, you need to first add this host IP to the 
“ Configured Hosts”  box, then assign allow or disallow value to it. Or if there are existing 
host that you want to control on the “ Configured Hosts”  box, just highlight that host and 
then assign allow or disallow value to it. These can be accomplished by either 
WacMan.exe or CONFIG.EXE. 
  
¶ If you use WacMan.exe, you need to go to “ Host Access Control”  page. Then you can 

do like this: 
 
¶ To Add a Host: On the “ IP Address”  line, input the valid IP address, or just select 

from the “ Configured Hosts”  box, and click on “ Add”  button. The added the IP 
address should be displayed in the “ Configured Hosts”  box.  Then on the “ Allow 
Connect”  check Enable, Disable or Default. 

 
¶ To Remove a Host: On the “ Configured Hosts”  list, highlight the host you want to 

delete, and then click on the “ Remove”  button. 
 
¶ If you use WAC CONFIG.EXE, you need to go to “ Host Settings”  page. Then you 

can do like this: 
 
¶ To Add a Host: On the “ Host”  line, input the valid IP address, or just select from 

the “ Configured Hosts”  box, and click on “ Ok”  button. The added IP address 
should be displayed in the “ Configured Hosts”  box.  Then on the “ Allow Connect”  
page, input the value as the remark prompt to enable or disable the added host. 

 
¶ To Remove a Host: On the “ Configured Hosts”  list, highlight the host you want to 

delete, and then click on the “ Remove Host”  button. 
 
NOTE: You can’ t remove a “ DefaultUserSettings” , but you can enable and disable it for 
all uses. To do so, just select it from the “ Configured Lists”  and assign value to it. 
 

Store Username and Password for Certain IP Address 

This configuration feature is used to store the windows system username and password 
on the server for the configured host so that host users can log onto server from this 
configured host without providing anything at client side. 
 
To store the username and password for the configured host, you need fist select a 
configured host, and then save the username and password for it. These can be 
accomplished by either WacMan.exe or CONFIG.EXE. 
 
¶ If you use WacMan.exe, you need to go to “ Host Access Control”  page. And then 

from the “ Configured Hosts”  box, select the intended host, or just add the intended 
host to the “ Configured Host”  box. Then on the “ Stored Username”  and “ Stored 
Password”  line, enter the valid name and password for this host. 
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¶ If you use CONFIG.EXE, you need to go to “ Host Settings”  page. And then from the 

“ Configured Hosts”  box, select the intended host, or just add the intended host to the 
“ Configured Host”  box, and click “ Ok” . Then on the “ Stored Username”  and “ Stored 
Password”  page, enter the valid name and password for this host. 

 

SSH Settings 

WAC Server offers several different levels of SSH setting to meet the security needs of a 
wide variety of computing environments. The different SSH security features are listed 
below: 
 
¶ SSH Server Key Regeneration: SSH server key regeneration is one of WAC Server 

security feature. In WAC Server you can regenerate the SSH server key if you 
suspect the old server key was compromised or corrupted somehow. For further 
information, see “ SSH Server Key Generation”  in the following section.  

 
¶ User Public Key Authentication: Besides username / password authentication, 

WAC Server also supports user public key authentication for SSH2, and use the DSA 
algorithm, the USA's federal Digital Signature Standard. For further information, see   
“ User Public Key Authentication”  in the following section. 

 
Besides, WAC Server also provides the following services based on the secured channel 
established between SSH client and the server:  
 
¶ SFTP Service: You can use SFTP client to connect to WAC Server and transfer files 

between client and server machines securely. Anonymous account is also supported 
by WAC SFTP server (can be disabled and enabled). For details, please see “ SFTP 
Service”  in the following section. 

 
¶ SCP Service: SCP program is a simple command line program for copying files 

between machines securely. WAC Server supports SCP service through its SFTP 
server. So you can use SFTP client to connect to WAC Server and perform the copy 
task. 

 
¶ Port Forwarding: You can use your SSH client (like WACSSH or FSLink) and 

WAC Server to form a secured firewall to protect your existing applications when 
communicating over untrusted network (like Internet). For details, please see “ Port 
Forwarding”  in the following section. 

 
¶ Remote Command Execution: You can submit any Windows command or program 

(with parameters) to WAC Server and get it executed. The output of the command or 
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program will be sent back to client for display. For further information, see User 
Access Control - “ Restrict Users to Use Remote Command Execution”    

SSH Server Key Regeneration  

SSH server key regeneration is one of WAC Server security feature. You can regenerate 
the SSH server key if you suspect the old server key was compromised or corrupted 
somehow. SSH server key contains a pair of keys: server public key and private key, the 
public key is open and can be viewed.  
 

SSH Server Key  

To prevent the network spoofing attack, each server has a unique identity. This identity 
here is called server key (or host key). The server key includes a pair of carefully selected 
large primary numbers (1024 bits). One number is exposed as public key (called server 
public key), and the other is kept for private key.  
 
When WAC Server installed, the server public key is recorded in a file named 
"pubkey.txt" under the WAC installation directory, and the private key is saved into the 
server registry list. 
 
If you want you SSH clients to verify the server, you should export the "pubkey.txt" file 
to your SSH clients. You can manually copy the "pubkey.txt" into all your clients and 
they should be able to import that file into their "authenticated server list". 
 
Or more conveniently, you don't have to do the transfer and import, just go ahead and 
connect with your SSH client, it will inform you a new server public key is received, and 
ask you whether you want to accept it or not. If you are concerned about the security, you 
can view the content of the received key and compare it with the content in the 
"pubkey.txt" file generated by WAC Server installation, if the keys look exactly the same, 
then you can accept the key and next time the verification is automatically done. Of 
course if you feel like confident, you can just accept the key, no need to deal with the 
"pubkey.txt" file at all. 
 

Regenerate SSH Server Key 

In some cases you might want to regenerate your server key pairs, like when you suspect 
the old key was compromised or corrupted somehow. You can use "Regenerate Server 
Key" in WAC CONFIG Tools or use the command line utility "wac sshkey" to perform 
the task. Here are the instructions: 
 
Regenerate Server Key from the WAC Manager (wacman.exe) 
 

1. Run WAC Manager (wacman.exe);  
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2. Click 'SSH Settings" on the left index panel;  
3. On the "SSH Settings" page, click on the button "Regenerate Server Key...".  

 
Regenerate Server Key from the CONFIG.EXE 
 

1. Run WAC CONFIG.EXE.  
2. On the CONFIG panel, click the button that is labeled as "Regenerate Server 

Key", or just press the "R" key.  
 
Regenerate Server Key from the Command Line 
 
¶ At the command line, type "wac sshkey" and press "Enter". You will be prompted to 

wait for while during reproducing the SSH server key.  
 
NOTE:  
 
¶ The generated keys are stored as "pubkey.txt" into the WAC Server installation 

directory. 
 

View Server Public Key 

After generate or regenerate SSH server key, for some cases, you might want to view the 
sever public key. Then there are four ways for you to view its contents: 
 
From the Pubkey File 
 
¶ Go to WAC Server installation directory, open the file "pubkey.txt" that contains the 

public key contents of the host. 
 
From the WAC Manager (wacman.exe) 
 

1. Run WAC Manager (wacman.exe);  
2. Click 'SSH Settings" on the left index panel;  
3. On the "SSH Settings" page, click on the button "View Server Public Key...".  

User Public Key Authentication  

WAC Server also supports public key authentication method for SSH2. With this method, 
you don't need to input a password when get connected to WAC Server.  
 
“ Public key authentication”  is one of the most secure methods of identifying yourself to a 
login server. Before using the public key authentication, you need to generate a pair of 
keys -- one public and one private on your SSH client machine, and copy or import the 
public key to the WAC Server machine. Then, when you connect to WAC Server by 
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telling it that you want to use public key authentication to log on, WAC Server will 
happily authenticate you against your private key. 
 

Generate User Public Keys  

Before you can setup public key authentication with WAC Server, you need to create a 
pair of public/private keys on your client machine. This can be done by the key 
generation utility of your SSH client. The key generation process will typically generate 
two files: one for private key and another for public key. 
 
After finishing the key generation, you need to import the public key to WAC Server (see 

“ Import Public Keys to WAC Server”  in the next section), and store the private key into the disc 
of your client machine. 
 
NOTES: 
 
¶ WAC Server's native SSH client, WACSSH, doesn't support public key 

authentication, so it can't create key pairs either.  
 
¶ Currently WAC Server only supports DSA keys. So when you generate the SSH keys, 

you should choose DSA key type. 
 

Import Public Key to WAC Server  

Once you created the key pair for the server to verify the public key later, you need to 
transfer the generated public key to WAC Server. You can use one of the following ways 
to add the public key to the list of recognized keys: 
 
Import Public Key from WAC Manager (wacman.exe) 
 

1. Run WAC Manager (wacma.exe); 
2. Click "SSH Settings" on the left index panel;  
3. On the "SSH Settings" page, in the "Allowed User Public Keys" pane, click on 

the button "Import";  
4. On the pop-up "Enter File Name" box, input the key file name or click "Browse" 

to bring up the "Open" box, and select the file;  
5. Click "Ok" after finish the file name;  
6. On the pop-up "User Name" box, input a user name or use the existing username 

for the key file and click "Ok". If you click "No", the import process will be 
ceased. 
NOTE: For the "username", see the “ Where”  note in the “ Import Public Key from 
the Command Line”  section.  

7. After successfully accomplish the above steps, the imported public key is listed 
by the username in the left box.  
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NOTES: 
 
¶ After import the “ public key” , you can save your login password for this key so that 

even thought you are the first logon using user public key, you are not asked for the 
password. See “ The First Logon Using User Public Key” . To store the login password 
for the public key, select one public key from key list in the left box, and then click 
on "User Password"; and then n the pop-up "User Password" box, enter the password 
and confirm it, then click "Ok" to finish.  

 
¶ If your Public Key Authentication fails to connect with WAC Server, you can try 

saving the password first, and then test again.   
 
Import Public Key from the Command Line 
 
At the command line, type: 
 

WAC UserKey Add <Public Key File> <User Name> <Password> 
 
For example:  wac userkey add filename John welcome 

 
You will see an "Operation success" message if the public key has been successfully 
imported to WAC Server. 
 
Where: 
 
¶ The <Public Key File> is the file name for the transferred public key. You should 

tell the full path where public key file locates at.  
 
¶ The <UserName> is the name of Windows user who will use the public key to 

authenticate later. Sometimes the public key file includes information about the 
user, in this case you don't need to supply the user name. If you use the same 
username for the imported file, always the previously imported public key file 
will be overwritten. 

 
¶ The <Password> is the login password that associates with the Windows login 

username and it's an optional parameter. You do not have to provide it. If you 
provide password here, you will be not asked for to provide password when login 
even though you are the first logon using the public key. However if you don't 
provide the password here, you can just press “ Enter”  to ignore it if there requires 
password.  

 

View the Imported Public Key  

 
After import the user public key, you can view its contents, here are the instructions: 
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View from the WACMAN.EXE 
 
1. Run WAC Manager (WACMAN.EXE);  
2. Click "SSH Settings" on the left index panel;  
3. On the "SSH Settings" page, in the "Allowed User Public Keys" pane, click on the 

button "Details";  
4. You should see a pop-up box that contains the public key contents. Click "Ok" to 

close the box.  
 
View from the Registry 
 
1. Run Windows Registry Editor or WAC Registry Editor (regedit.exe);  
2. Go to "HKEY_LOCAL_MACHINE\Software\ Foxit Software\WAC 

Server\SSH2\UserKeys".  
3. On the UserKeys pane, you should see the imported public key was listed by the 

username that you provided when you imported the key. Just double click the 
username, and you can view key contents.  

Remove the imported Public Key  

 
After imported the user public key, if for some cases, you want to delete it from the 
recognized list, you can using the following ways to execute the task: 
 
Remove the Public Key from the WACMAN.EXE 
 

1. Run WAC Manager (WACMAN.EXE);  
2. Click "SSH Settings" on the left index panel;  
3. On the "SSH Settings" page, in the "Allowed User Public Keys" pane, select one 

public key from key list in the left box, and then click on "Remove";  
 
Remove the Public Key from the Command Line 
 
¶ At the command line, type WAC Userkey Del <UserName> and press Enter.  

 
Where: <UserName> is the windows username that you provided when imported the 
public key to server. 
 

Store Password for the Imported Public Key  

 
After you import the user public key to WAC Server, you can store the corresponding 
Windows password for this public key, so that even when first logging in server using 
User Public Key, you don't need to submit it again.  
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NOTE: The corresponding password means this password must associate with the 
username that you provide when you import the public key. 
 
If your Public Key Authentication fails to connect with WAC Server, you can try saving 
the password first, and then test again.  
 
Here are the how-to steps: 
 
Store Password from the WACMAN.EXE 
 
1. Run WAC Manager (WACMAN.EXE);  
2. Click "SSH Settings" on the left index panel;  
3. On the "SSH Settings" page, in the "Allowed User Public Keys" pane, select one 

public key from key list in the left box, and then click on "User Password";  
4. On the pop-up "User Password" box, enter the password and confirm it, then click 

"Ok" to finish.  
 
Store Password from the Command Line 
 
1. At the command line, when you use "WAC UserKey Add" to import a public key, 

attach the <password> to this command option, then you will store the password.  
 

NOTE: Normally, the <password> in the "WAC UserKey Add <Public Key File> 
<User Name> <Password>" is a an optional parameter, you don't have to provide it, 
you can just press Enter to ignore it. 

 
 

The First Logon Using Public Key  

After generate the key pair, and import the key to WAC Server, now you are ready to use 
public key method to logon to WAC Server. You should configure your client program to 
use public key authentication method. For some client programs, you need to specify a 
private key file, and the private key must match the public key registered in WAC Server. 
Note the client program might store the private key encrypted by another passphrase, in 
order to access that private key, you have to supply the passphrase for verification. 
 
WAC Server will first verify the public key and digital signature supplied by your client 
program, if verified successfully, for the first logon, WAC Server will require you to 
input a password. This password is required by Windows system to grant system access 
to you. While, if you set the password for the public key ahead, you will not be asked for 
the password. For details, see "Store Password for the Imported Public Key". 
 
After the password got verified by Windows system, WAC Server will store the 
password securely in its registry, so you don't need to provide the password any more. 
 



                                                                                                                                                                                 

Page 91 of 231 

Logon Using Public Key  

After the first logon, you can use public key authentication method without Windows 
password. (But the private key passphrase, if required, can't be omitted.) 
If somehow the Windows password got changed later, when you use public key to logon, 
WAC Server will again ask you to provide the correct password. You have to input the 
new password and it will again be securely stored for later use. 

SFTP Service 

SFTP stands for Secure File Transfer Protocol, it serves the need to transfer files between 
server and client using an SSH session. 
 
WAC Server has a build-in SFTP service, which is automatically activated on your server 
machine when you installed WAC Server. So if you have the compliant SFTP client you 
can use them to do file transferring securely over a WAC session. 
 
This SFTP service supports both version 3 and version 4 of SFTP protocol. Make sure 
your SFTP client supports those protocol versions in order to connect with WAC Server's 
SFTP service. 
 

SFTP Configurations  

SFTP is automatically installed and enabled when you installed WAC Server. However, 
you can later manually disable or enable SFTP service for the whole server, or for the 
certain user or group.  
 
¶ To disable or enable SFTP for the whole server, you should use either WacMan.exe 

or CONFIG.EXE to modify the “ SFTP Service” . For detailed instructions, see Server 
Global Settings - “ SFTP Service”  in this chapter. 

 
¶ To disable or enable a particular user or group to access SFTP service, you should use 

either WACMAN.EXE (wacman.exe) or CONFIG.EXE to modify the “ SFTP”  for 
this user or group. For detailed instructions, see User Access Control - “ Restrict Users 
to Use SFTP Service”  in this chapter. 

 
Sometimes it might be needed to limit the file access of a certain user or group’ s SFTP 
activities within a certain directory, in this case administrator can set the root directory 
for the user or group. After this root directory set, all files and directories outside the 
specified root directory won’ t be accessible to the user’ s SFTP session. For detailed 
instructions, see “ Limit SFTP File Access”  in the “ User Access Control”  section. 
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Anonymous SFTP Configurations 

Like anonymous FTP access, WAC Server also supports anonymous access to SFTP 
service. That means any user can logon to SFTP service with "Anonymous" as user name, 
and anything as password. 
 
Since no user authentication is done, anonymous access to SFTP service should be 
strictly limited. WAC Server requires a root directory to be specified for anonymous 
access. Anything outside the root directory won't be able to be accessed anonymously. 
 
To configure anonymous SFTP access, you need to use one of the WAC Configuration 
tools to set their parameters.  
 
¶ If you use WAC Manager (wacman.exe), you need to go to “ SSH Settings”  page, and 

modify the root directory and anonymous access type. 
 
¶ If you use CONFIG.EXE, you need to go to “ Server Settings”  page, and modify the 

“ AnonyAccount” , “ AnonyAccess”  and “ AnonyDir” . 
 
For detailed instructions, see Server Global Settings - “ Anonymous Access to SFTP 
Service”  in this chapter. 
 

Connecting to SFTP Service  

You can use any standard compliant SFTP client to connect with WAC Server's SFTP 
service. 
 
Like other SSH connection, you need to pass the user authentication before an SFTP 
session can be established. You can use password or public key to authenticate yourself. 
After authenticated, if SFTP is not disabled for the whole server or the particular user, 
you can start to issue SFTP commands to WAC Server. 
 
WAC Server supports all available SFTP commands defined in protocol version 3 and 
version 4. 
 
The file path in SFTP commands can be either in Unix format (using "/" as separator) or 
Windows format (using "\" as separator). 

Port Forwarding 

Port Forwarding, or SSH tunneling, is used to route data over the secure SSH connection. 
There are two types of port forwarding that SSH offers: local and remote forwarding. 
They are also called outgoing and incoming tunnels. Local forwarding forwards traffic 
coming to a local port, and then from there onto a specified remote host port. Remote 
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forwarding is similar to local forwarding but in the other direction. It forwards traffic 
coming to a remote port, and then onto a specified local port. 
 
To use the port forwarding, you need to do some settings on both server side and client 
side. 
 

Configure Port Forwarding on WAC Server 

WAC Server has a build-in port forwarding service, and by default, it is enabled when 
WAC Server is started. So you don't need to do any configurations in server for port 
forwarding, just use your SSH clients that support port forwarding to tunnel to the remote 
machine via WAC Server.  
 
However, as a system administrator, you might for some reasons need to ban the 
forwarding service or decline a certain user or user group to tunnel to your server, in this 
case, you can use one of WAC configuration tools to modify the "Port Forwarding". Here 
are the instructions:  
 
¶ If you use WAC Manager (wacman.exe), you need to go to “ User Access Control" 

page, and modify the “ Port Forwarding”  
 
¶ If you use CONFIG.EXE, you need to go to "User Admin Settings" page, and modify 

the “ PorFwd”  value. 
 
For detailed instructions, see “ Restrict Uses to use Port Forwarding Service”  in the “ User 
Access Control”  section. 
 

Configure Port Forwarding on WACSSH  

Before do forwarding with SSH client, you should configure your SSH client. In our case, 
we will be configuring our client -- WACSSH to accept the connections. 
 
During a WAC session, press "Ctrl+}" to temporarily leave your virtual server screen and 
switch to the WACSSH command screen. Then on this command screen, you can set up 
the settings for local and remote forwarding. Here are the instructions: 

Local Port Forwarding  

 
At the WACSSH command screen, type "help fwdlocal". You should get help 
information about local forwarding. Then issue the following command to forward local 
connections to server: 
 

"fwdlocal <local port> <remotehost>:<remote port>"  
i.e.; fwdlocal 3001 server1.remote.com:22 
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WACSSH will be listening on port 3001, any connections coming to this port will be 
forwarded to the server, where the connection will be further forwarded to the host 
server1.remote.com:22. (The server and this host can be the same machine.)  
 
If you want to view all the previous local configurations, type "fwdlocal".  This command 
will list all the schemed local port forwarding for you. 
 
If you want to remove the previously configured local port forwarding, type "fwdlocal 
<local port>". This command will drop this port from the schemed local port forwarding 
list. 

Remote Port Forwarding  

 
At the WACSSH command screen, type "help fwdremote". You should get help 
information about remote forwarding. Then issue the following command to ask server to 
forward connection to us: 
 

"fwdremote <remote port> <local host>:<local port> "  
i.e.; fwdremote 3002 server1.local.com:22  

 
WACSSH will send a request to the server, if approved, the server will be listening on the 
port 3002, any connection that coming to this port will be forwarded to WACSSH, where 
the connection is further forwarded to the host server1.local.com:22. (WACSSH client 
and this local host can be the same machine.)  
 
If you want to view all the previous remote configurations, type "fwdremote". This 
command will list all the schemed remote port forwarding table for you. 
 
If you want to remove the previously configured remote port forwarding, type 
"fwdremote <local port>". This command will drop this port from the schemed port 
forwarding list. 

Serial Port Settings 

WAC Server supports serial port communications, which means you can use a plain-old 
terminal (or a terminal emulator) and connect it to your NT/2000/XP server through a 
serial cable. Right now WAC Server only support terminals that are compatible with 
DEC VT series terminals.  
 
Before you can get connected over a serial cable, both the serial port on the client and 
server machine must have identical communication settings. Configuring serial port 
communications in WAC Server involves enabling the "serial port" and specifying the 
"serial ports", setting the communication parameters that control the baud rate and the 
serial data. 
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Enable the Serial Port Service (EnableComm) 

Before you can access the server using a serial port, you need to declare it to WAC 
Server so the server can listen on that port. What you need to declare is enable the “ serial 
port”  using one of the WAC configuration tools. 
 
If you use WacMan.exe, you need to go to the “ Serial Port Settings”  page and then 
modify the setting. If you use CONFIG.EXE, you need to go to the “ Server Settings”  
page, and then modify the “ EnableComm”  value. For detail instructions, please see 
Server Global Settings –  “ Serial Port Service”  in this chapter. 
 
NOTE:  
 
¶ Enabling the serial port is not enough, you also need to specify the serial port list to 

WAC Server, so the server can know which serial port it should be listening.  
 
¶ You have to restart the WAC Service to take your settings effective. 

Specify the Serial Port List (CommPortList)  

If you have installed WAC Server, you already know you can specify the serial port list 
during installing WAC Server. If you didn't specify the port list during the installation, 
then when you user CONFIG.EXE and try to open the “ Communication Settings” , you 
will see a pop-up message as below: 
 

 
 
In this case, you need to go to the "Server Settings" panel to configure the 
“ CommPortList”  value. Or you can't set the communication settings nor use the serial 
port access. You can specify more than one port in this list.  
 
If you use WacMan.exe to specify the serial port list, you will not fall across the above 
condition. For detailed instructions please refer to Server Global Settings - “ Serial Port 
Service”  and “ Serial Port List”  in this chapter. 
 
When you have specified or installed more serial ports, you might have COM5 - 
COM12. If you have installed an additional serial communication adapter with 8 ports, 
you can go ahead and include them into your WAC Server port list, like "COM1, COM5, 
COM6, COM7, COM8, COM9, COM10, COM11, COM12". All these ports will be 
accessible using serial terminals. 
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Set the Communication Parameters 

Before you can communicate, communication parameters need to be figured out and 
properly set. These parameters include the "Baud rate, Data length, Parity check, and 
Stop bits". Communication parameters have to be exactly the same for both terminal and 
the corresponding port on WAC Server, otherwise the communication is impossible.  
 
To change the parameters for your terminal (or emulator), consult the user manual of the 
terminal (or emulator), to change the parameters for WAC port, you can use one of the 
WAC configuration tools to perform the task. 
 
¶ If you use WacMan.exe, you need to go to “ Serial Port Settings”  page, and in the 

“ Communication Settings”  area, select the port from the “ Port”  combo box, and then 
set the relevant parameters for this port.. 

 
¶ If you use CONFIG.EXE, you need to go “ Communication Settings”  page. In this 

page, from the left side “ Port”  list box, select the port you want to set, and then at the 
right side, set the relevant parameters.  

 
NOTE: 
 
¶ You can also use WAC Command Line tool “ wac port”  to perform this task.  

Notes and Tips 

Serial cables are considered connected all the time, so when you want to end the session, 
be sure to log out, otherwise, even if you turned off the terminal (or closed the terminal 
emulator), WAC Server will still think you are connected, then next time when you back 
online, you'll automatically get connected without logon, because you never logged off. 
And anybody else can get into the system too, so be sure to log off.  
 
Serial communications are not reliable, that means sometimes data might get lost 
between the server and the terminal. In this case, the screen might be corrupted and look 
messy, don't be panic, you can press CTRL-R to refresh the screen (WAC Server will 
send the screen data one more time), and most likely you will see everything OK now. Of 
course the final resort is restarting the terminal and/or restarting the session.  
 
One thing you need to note, the default terminal size for DEC VT terminal is 24 lines, 
which is different from the default size of DOS command prompt (25 lines), you might 
lose the last line of the display of some applications. If your terminal supports more lines, 
you should notify the server about it. For more information about the terminal size 
change, please refer to "Resize Terminal Size”  or WAC command line tool “ wac term”  
section. 
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References 
 
This section exists to complement the “ Advanced Configuration Features”  section. 

WAC Event Logging 

WAC Server provides detailed event logging information for user activities. And the 
system administrator can selectively enable or disable the information to be recorded by 
setting “ Log Mask” .  
 
Logging information is written into “ Logfiles”  which resides in WAC Server installation 
directory, and the system administrator can change the directory by setting “ Log Path”  
and to view those logging information real time using “ View Log File”  in WAC Manager 
 
If the user uses WAC Protected Shell, administrator can choose to log all user activities 
like executed commands and programs. See References –  WAC Protected Shell –  
“ Define Pshell File”  in this chapter. 
 
NOTE:  
 

¶ WAC Server also provides a console tool –  “ Event Viewer”  to log important events in 
your host Windows system. Use this tool, you can remotely view and manage your 
system events. See Chapter One - “ Event Viewer”  in Part Three. 

Define Log Mask (LogMask) 

The configuration “ Log Mask”  is used to specify what kind of server information to be 
recorded into log file.  
 
WAC Server provides five types of event information for system administrator to choose 
to log.  The system administrator can use WAC configuration tools to accomplish the 
task. Here is the information type and their descriptions: 
 
¶ Server Info:  This information is logging events such as " the WAC Server running 

status,  the various services state and their corresponding ports, and the basic server 
information like 'Licensee, SN: , Maximum Sessions, system name, OS’  etc” . 

 
¶ Basic Session Info: This information is logging events such as "connection type, 

source IP, terminal info, and session ID etc ". 
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¶ Detailed Session Info: This information is logging events of session inter-
operation such as "session watch, session control, session takeover, session abort 
etc". 

 
¶ Authorization Related Info: This information is logging events such as " the 

domain name, the logon user name, the authorization state, and the authorization 
methods like ‘ the stored password auth, public key auth, SSH signature auth’  etc ". 

 
¶ File Transfer Info: This information is logging transferring activities between 

server and terminal. All trails including your deleting file, creating/deleting 
directory, renaming file, anonymous reading or writing during transferring file will 
be recorded. 

 
By default, all the five types of logging information are enabled.  
 
Here are instructions for logging information configurations in either WacMan.exe or 
CONFIG.EXE: 
 
¶ If you use WacMan.exe, you need to go to “ More Server Settings”  page, and there is 

a setting called “ Log Mask” . Just check the relevant check box to enable or disable 
the logging information you want.   

 
¶ If you use CONFIG.EXE, you need to go to “ Sever Settings”  page. And from the left 

side box, choose a setting called “ LogMask” . And then in the edit line, input the value 
for it.  “ -1”  is the default value that means all logging information is enabled. 
 
The "LogMask" value is using the position of bit mask in a bit-wise field to set and 
reset the state of individual bits, thus to specify the information. Here is the value 
syntax and using examples”  

 
¶ “ 1" for Server Info; 
¶ "2" for Basic Session Info;  
¶ "4" for Detailed Session Info; 
¶ "8" for Authorization Related Info; 
¶ "16" for File Transfer Info.  

 
Examples  
 
1. If you want to log "server info" and "authorization related info" into “ Logfiles” , 

you should use the plus outcome of their values “ 5”  to specify the log mask. In a 
word, in the edit line, you should set the value to “ 5”  to log the two types of 
information.   

 
2. If you want to log “ server info” , "detailed session info" and "file transfer info", in 

the text edit box, you should set the value to "21" which is the plus outcome of the 
three values (1 +4+16). 
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NOTE: You have to restart WAC Server service to take your changing effective. 

View Log File  

A “ log file”  is a daily-delimited text file, which actually records all logging information 
in one day and is stored with the date stamp into the “ Logfiles” . For example, on the day   
2003-7-16, you and other users log into WAC Sever, and do many operations and then 
log off. All you activities on this day then will be stored into “ Logfiles”  with the name 
“ WAC030716.TXT” .  
 
In the “ Logfiles”  directory, there contains many a daily “ log file” , and you can easily 
view some day log file by recognizing the saving name   
 
There are two ways for you to view the log files: 
 
¶ In WAC Manager, in the WAC Server Status page, select the date from the calendar, 

and click on the "View Log File" button to bring up a text file that contains all the 
logging information in this date. 

 
¶ Go to WAC Server installation directory, open the directory “ Logfiles” , you can see a 

list of daily “ log file” , just double click the log file you want to view. 
 
NOTE: For your conveniences, can create shortcut for “ Logfiles”  by copying or dragging 
it to somewhere that you feel convenient to view afterwards. 

Change Log File Path (LogPath) 

The configuration “ Log Path”  is used to change the directory which contains all the 
logging information.  
 
By default, the logging information is written into “ Logfiles”  which a folder locates in 
the WAC Server installation directory. You can create shortcut for “ Logfiles”  by copying 
or dragging it to somewhere that you feel convenient to view afterwards. You can also 
change its path using WAC configuration  tools. 
 
Here are instructions for log path configurations in WAC Manager and CONFIG.EXE: 
 
¶ If you use WAC Manager, you need to go to “ More Server Settings”  page, and there 

is a setting called “ log path” .  Just enter the path in the adjacent edit box, or click 
“ Browse… ”  button to select the path.  
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¶ If you use CONFIG.EXE, you need to go to “ Sever Settings”  page. And from the left 
side box, choose a setting called “ LogPath” . Then in the edit line, enter the path for it.  

 
NOTE: You have to restart WAC Server service to take your changing effective. 

Client Side Printing  

While you remotely run applications on server machine, you can print locally on the most 
convenient printer. WAC Server can redirect server printing to client program for each 
user.  
 
To use Client Side Printing, you need to do some settings on both server and client side. 

Server Side Setup 

1. Install WAC Printing Redirector  

This step was completed during you installed WAC Server.  
 
After you installed WAC Server, a special print port called WAC_PRINTER will appear 
in the available printer ports in your server machine. It has two features: 
 
¶ This WAC_PRINTER essentially is WAC Printing Redirector (or called Virtual 

Printer Port), it can redirect server side printing to client side when there are any print 
job demands.  

 
¶ This WAC_PRINTER is shared after installation.  
 
After creating WAC_PRINTER, you might need to map a DOS print port like LPT1 or 
LPT2 to WAC_PRINTER, because most DOS-based programs print to the LPT1 or 
LPT2 ports by default.  See the step two below. 
 
After producing this mapping, when you require print job from a DOS-based program, 
the printer output seems to be printed to LPT port, however, actually printed onto 
WAC_PRINTER, thus WAC_PRINTER is able to redirect the printing to client side. 
 
NOTE: If you found no WAC_PRINTER was installed after installing WAC Server,  
please see Troubleshooting. 
 

2. Map LPT port to WAC Printing Redirector 

You can use the following methods to accomplish this task: 
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¶ During installing WAC Server, check one LPT port in the check-box when you are 

prompted to select the port number.  
 
¶ Run WACMAN.EXE, and on the More Server Settings page, check one LPT port 

in the check-box. Or run WAC CONFIG.EXE, and go to the Server Settings page, 
then on the LPTport panel, specify the value for it.  

 
¶ Use NET USE command. For example:  
 
net use lptx: \\printserver\wac_printer where lptx is the LPT port that you are using 
(usually lpt1 or lpt2), printserver is the server name that WAC_PRINTER locates in. 
 

Client Side Setup 

Here we will take our WAC Native Client as a case. 
 
To succeed at the Client Side Printing, you also need to choose an actual and available 
printer for WAC Client Printing port.  
 
During the WAC Server - client session, press Ctrl+] to switch your virtual screen to the 
WAC Client command screen. In the command screen, use the following commands: 
 
Print  
Print <printer number> 
 
For more information, please refer to WAC Client Command line Utilities –  “ Print”  in 
Chapter Eight. 

Troubleshooting 

While installing WAC Server on your host machine, if WAC Installshield Wizard detects 
there is no "Generic / Text Only printer driver" available on this machine, WAC 
Installshield will automatically skip installing WAC_PRINTER, and then you have to 
manually add it later by Windows printer manager. Here are the step-by-step instructions: 
 

1. Add Generic / Text Only Printer Driver 

1. Run Control Panel.  
2. Select Printers or Printers and Faxes. 
3. Right-click mouse and select Server Properties. 
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4. On the pop-up Print Server Properties dialog box, click Drivers and then select 
Add button on bottom of this page. 

5. On the pop-up Add Printer Driver Wizard, follow the step-by-step instructions 
to add Generic / Text Only Printer Driver.  

 

2. Add WAC_Printer  

1. Run Control Panel. 
2. Select Printers or Printers and Faxes. 
3. Double click Add Printer. 
4. On the pop-up Add Printer Wizard. Click on Next. 
5. Check Local Printer. Click on Next. 
6. Select one of unused LPT ports. Click on Next.  
7. Select Generic from Manufacturers list and Generic / Text Only from Printer 

list. Click on Next. 
8. Check Keep Existing Driver. Click on Next. 
9. Name your Printer Name as WAC_PRINTER. Click on Next. 
10. Select Shared and name the printer WAC_PRINTER. Click on Next.  
11. After the above steps are finished, a printer name WAC_PRINTER should appear 

in the Printers window. This printer cannot be used by any other service except 
WAC Server.  

 

WAC Protected Shell 

Introduction 

WAC Protected shell (pshell.exe) is a small program that system administrator can 
choose as designated shell program for some of all users 
 
Sometimes you might not want your users to connect to WAC Server and have total 
access to all programs and resources on the server machine. You can use access control 
provided by Windows system to do that but it's very difficult to setup correct access for 
thousands of files on the server. 
 
As a much more convenient and efficient alternative, WAC Server provides a "Protected 
Shell" program. System administrator can force all or some users to use this program 
instead of the standard command shell program provided by Windows system. 
The protected shell program takes a definition file as input. The protected shell will reject 
the user to access any commands or programs not defined in this file. For different users, 
administrator can assign different definition files.  
 



                                                                                                                                                                                 

Page 103 of 231 

Administrator can also choose to log everything the user has done within the protected 
shell, including the commands and programs executed, as well as detailed input/output 
data. 
 
By forcing users to use protected shell, you can be sure that everything is under your 
control. 

Define Pshell Files  

As we introduce in the Introduction section, Pshell.exe takes a definition file as input and 
provide only defined commands or programs to the user. In this section we will tell how 
to construct the definition file and you will learn:  
 
¶ What types of line contained in the definition file;  
¶ What tools you can use to define the file;  

 
The definition file can contains the following types of line: 
 

1. Welcome text: "welcome <welcome text>".  
2. Version text: "version X"  
3. Prompt text: "prompt <prompt text>" 
4. Log text: "Log command or execute "  
5. NT shell command: "command <your command name> <NT command line>"  
6. Program execution: "execute <your command name> <file path and parameters>"  
7. Exit command: "exit <your exit command>"  

 
The tools that you can use to define the Pshell files: 
 

1. You can use the Windows NotePad or WordPad to edit the files and save it into 
WAC Sever installation directory.  

2. You can also use WAC Edit.exe to define the files, especially when you need to 
define the file remotely.  

 
Here is the example that uses WAC Edit.exe to define the Pshell files: 
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Where: 
 
¶ "Log command" will log everything that user has done within the Pshell, and the 

logged files are stored as "ps_<username>.txt" into WAC Server installation directory.  
 
¶ Commands in violet are 'your command name', you can randomly assign any valid 

name to them.  
 
¶ "%THE_HELP_FILE%" is the internal command of Pshell.exe, it can tell your user 

what commands or programs that you allowed them to run when they type "psh_help". 
It should be capitalized.  

 
NOTE: 
 
¶ After accomplish editing the file, it is best that you save it into the directory where 

Pshell.exe locates in. And you can assign it any extension, but "*.psh" are 
recommended for easily recognized later.  

Use Pshell 

To force your users to use Pshell, you should use WAC configuration tools to configure 
"Shell" in "User Admin Settings" page (see Chapter Five –  User Admin Settings - “ Specify User 

Shell” ).  
 
After you configure the user or users group to use Pshell.exe, when they log onto WAC 
Server, they will be asked to input protected file as the following figure: 
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This "Protected File" is the file you defined ahead for this user or user group, only when 
users input the correct protected file name that they can really step in and work there, 
otherwise they will be disconnect from server. 
 
While users want to enter the correct Pshell file name, they must be got informed in 
advance. As administrator, there are two ways for you to notice them: 
 
¶ Directly tell them your defined Pshell file name including file path like "d:\program 

files\wac <file name>".  
 
¶ Not tell them. Just use WacMan.exe or CONFIG.EXE to configure "Shell" 

(Recommended). For example: You save your defined Pshell file as "wac.psh" and 
you put it into "d:\program files\wac", thus you can configure the Shell value as 
"d:\program files\wac wac.psh". In this way, when user log onto WAC Server, they 
will be directly located in your designed Pshell files, something look like the 
following shell box:  
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Where: 
 
¶ The "welcome text", "version number”  or "prompt (\>)" is up to how you defined the 

Pshell files.  
 
In the above box, users can work there as long as they know what commands or programs 
that you allowed them to use. 
 

WAC Manager 

WAC Manager is the GUI-based program that is used to configure WAC Server when 
you are physically working on the server. This program can be accessed from your 
desktop shortcut, the Run line or Command Prompt by typing "wacman.exe". 
 

WAC Server Status 

 
WAC Server Status 
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In this page you can visually view your host machine information like "Host Name, OS 
Version" and WAC Server version number as well as WAC Server running status. 
Besides, you can also do the followings: 
 
¶ Start, stop and restart WAC service  
 
To perform the task, simply click on the button that labels “ WAC Server stop” , “ WAC 
Server start”  and “ WAC Server restart” , and you will notice the WAC Server status will 
change accordingly on the top pane. 
 
In WAC Server, there are more than one way to start, stop and restart WAC service, for 
more information, please refer to Chapter One –  “ WAC Server Service” . 
 
¶ View WAC Event Log File  
 
To view the log file, select the date from the calendar, and click the "View Log File" 
button to bring up NotePad that contains all the logged information. 
 
For more information, please refer to “ WAC Event Logging” . 
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Server Global Settings   

 
Server Global Settings 

 
 
To set up the configuration variables, just check or de-check the check box, or enter the 
value in the relevant box. 
 
The detail instructions are described in Chapter Five “ Server Global Settings” , below is a 
quick reference list: 
 
¶ Ask for domain name when user logon: By default, this option is enabled. If 

disabled, user will always log on the local domain. 
¶ Max Logon Retry: The maximum number for user logon retries. If the user can’ t 

successfully log on after this number of retries, WAC Server will disconnect. The 
default is “ 3” . 

¶ Logon Timeout: The timer for user input during the logon process. If the user keeps 
inactivity for this period, WAC Server will disconnect. The default value is “ 300” . 
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¶ Session Tick: The timer for WAC Server to update the terminals. Using a longer time 
will decrease the CPU load, but also increase the response time. “ -1”  is the default 
value that means, WAC Server will update the terminal as soon as possible. 

¶ Enable Telnet: Enable the telnet service for telnet access. By default, this option is 
enabled. 

¶ Telnet Port: The port that telnet service will be listening on. “ 23”  is the default value. 
¶ Redirect Program Output:  Whether and how WAC session agent should redirect the 

program output. 
¶ File Transfer: Disable or conditionally enable file transfer between WAC Server and 

WAC Native Clients. 
 
NOTE: The new configuration settings will only take effective only after WAC Server 
service got restarted.  
 

More Server Settings 

More Server Settings 
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To set up the configuration variables, just check or de-check the check box, or enter the 
value in the relevant box. 
 
The detailed instructions are described in “ Server Global Settings” , below is a quick 
reference list: 
 
¶ Log Mask: Specify what kind of information to be recorded into “ Logfiles” . 
¶ LPT port: Specify which LPT port to be used to DOS application for client side 

printing.  
¶ Log Path: Specify the directory where you want to put the log files in. 
¶ Logon Banner: The custom banner can be displayed on the client session upon 

connection to the server. 
 
NOTE: The new configuration settings will only take effective only after WAC Server 
service got restarted.  
 

SSH Settings 

 
SSH Settings 
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To set up the configuration variables, just check or de-check the check box, or enter the 
value in the relevant box, and or click on the relevant buttons. 
 
The detail instructions are described in the appropriate section, below is a quick reference 
list: 
 
¶ Enable SSH Service: Whether to enable SSH service for SSH client access. By 

default, this option is enabled.  
¶ SSH Port: The port the SSH service will be listening on. The default value is “ 22” . 
¶ Enable the build-in SFTP Service: Whether to enable SFTP service for secure file 

transfer between server and terminals. 
¶ Root Directory: Set the root directory for anonymous access. You must set this 

directory if you want to anonymous access. 
¶ Anonymous Access: Disable or conditionally enable anonymous access for 

anonymous account. The default value is “ Reading Server Only” . 
¶ View Server Public Key: To view the host public key. This public key is generated 

during WAC Server installation. 
¶  Regenerate Server Key: To regenerate the host key. This host key includes a pair of 

public key and private key.  
¶ Details: To view the contents of the imported user public key.  
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¶ User Password: To save the Windows login password for the imported user public 
key, so that you are not asked for the password even when the first logon using user 
public key. 

¶ Remove:  To delete the imported user public key from the recognized list. 
¶ Import: To input the generated user public key to WAC Server. 
 
NOTE: Some of new configuration settings will only take effective only after WAC 
Server service got restarted.  
 

Serial Port Settings 

 
Serial Port Settings 

 
 
To set up the configuration variables, just check or de-check the check box, or enter the 
value in the relevant box, and or click on the relevant buttons. 
 
The detail instructions are described in “ Serial Port Settings”  in Chapter Five, below is a 
quick reference list: 
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¶ Enable Serial Port Access: Whether to enable serial port service for serial port 

terminal access. 
¶ Serial Port List: To add a list of serial ports for serial port terminal access. And the 

added ports can be removed by using the Remove button. 
¶ Communication Settings: For you to change the communication parameters and 

terminal screen size. Here is the list: 
 
¶ PORT: For you to select one communication port from the port list.  
¶ PARITY: For you to select parity check value "Even", "No Parity" or "Odd".  
¶ STOP BITS: For you to select stop bit value "1Bit", "1.5 Bits" or "2 Bits".  
¶ BAUD RATE: For you to specify the transmission rate like "1200, 2400.9600 

etc".  
¶ DATA LENGTH: For you to specify the data bits which can have 2-600 bytes in 

length.  
¶ WIDTH and HEIGHT: For you to set the display size of your screen buffer.  
¶ TERM ID: For you to set the ID number of your terminal.  

 
NOTE: Some of new configuration settings will only take effective only after WAC 
Server service got restarted.  

User Access Control 

User Access Control 
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In this page, system Administrator can enable or disable some service for all users or user 
groups. 
 
General Instructions for Access Control 
 
¶ To configure settings to a particular user or user group, select the user or user group 

from the "Current User / Group Name", and check "Enable" or "Allow" or enter the 
value in the relevant service line.  

 
¶ If you are planning to configure access settings for all users, you can choose "Default 

User Settings" from the "Current User/Group Name", and then set up the parameters.  
 
¶ To save the new configuration settings, just go ahead by clicking other page. 
 
The detailed instructions are described in Chapter Five - “ User Access Control” , below is 
a quick reference list: 
 
¶ Interactive Sessions: Whether to allow this user to log onto server for interactive 

sessions. 
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¶ SFTP: Whether to allow this user to log onto this server for SFTP Service. After you 
enable SFTP service for this user, be sure to set the root director for this user too (see 
Root Directory below), or this user will be able to access all your resources and files 
on your server.  
 

¶ Remote Execution: Whether to allow this user to log onto this server for remote 
execution.  
  

¶ Port Forwarding: Whether to allow this user to log onto this server for port 
forwarding service.  
  

¶ Session Limit: Define the maximum number of sessions that a user can connect. If 
leave it empty or set to zero, the user can connect as many sessions as the system 
permit  

 
¶ Host List: List of host addresses allowed for this user or user group to connect from. 

Must be IP addresses separated by comma. You can use " * ", like "192.168.2.* " to 
specify a network segment. NOTE: All the specified user or users group will not be 
able to connect to server unless they connect out from the specified IP addresses. 

 
¶ Root Directory for SFTP Service: Specify the root folder for SFTP access. Files 

outside of this root directory will not be allowed to access.  
 

User Admin Settings 

User Admin Settings 
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In this page, system Administrator can specify user settings for all users or user groups, 
and alternatively, can supercede user's preference with Admin Settings. 
 
General Instructions for Admin settings  
 
¶ To configure settings for a particular user or user group, select this user or user group 

from the "Current User/Group Name", then modify the settings in the corresponding 
configuration line, or check the relevant option. NOTE: If you don't enable 
“ Supercede User” , WAC Server will use the user preference first when the user logs 
on. 

 
¶ If you want to force user or users group to use your admin settings instead of their 

own user preference, on this page, select this user or user group from the "Current 
User/Group Name", and then enable "Supercede User". NOTE: WAC Server will 
ignore individual user preference and use Admin settings first.  

 
¶ If you are planning to configure the settings for all users, you can choose "Default 

User Settings" from the "Current User/Group Name", and then set up the parameter. 
You can also enable “ Supercede User”  to force users to use your configured default 
settings instead of the user preference. 
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¶ To save new configuration settings, just go ahead by clicking other pate. 
 
The detailed instructions are described in “ User Access Control” , below is a quick 
reference list: 
 
¶ Initialization Dir: The first working directory when user logs on.   
 
¶ Start Script: The running application when user logs on. If no value for this 

parameter, by default, WAC Server will run WAC Menu which if not disabled.   
 
¶ Shell: The shell command line you want to execute when the session is created. By 

default, cmd.exe will be executed, but you can change it to any other application by 
set the "Shell" value here.  NOTE: In WAC Server, the system administrator can use 
the WAC Protected Shell to restrict user’ s activities.  

  
¶ Watch Users: Specify a list of users who can watch your session. Use comma to 

separate users. And the specified users can use command tools ""wac watch" to 
monitor your screen.  NOTE: The specified users, even they are but normal Windows 
users, can watch your screen despite your Admin identity. 

 
¶ Control Users: Specify a list of users who can control (or take over) your session. 

Use comma to separate users. And the specified users can use command tools ""wac 
control" and "wac takeover" to watch and operate on your screen.  NOTE: The 
specified users, even they are but normal windows users, can control your screen 
despite your Admin identity. 

 
¶ Heartbeat Period: Specify the heartbeat period, in seconds.  
 
¶ Keep Session Period: Specify the period for WAC Server to keep broken session, in 

seconds. And all data or running applications in the broken session are remained 
intact. So when you reconnect to this broken session with same username, you are 
able to continue your work just like your session was never broken.  

 
¶ Display WAC Menu: Whether to display the WAC application menu when user logs 

on. This option is only effective when "Start Script" option is not set".  
 
¶ Auto Reconnect: Whether to disable or conditionally enable auto reconnect to 

reconnect to the existing (broken or active) sessions when user logs on.  
 
¶ Disable: Disallow auto reconnecting. If check this option, you will always create 

a new session whenever you connect.  
 
¶ Reconnect to broken session: If this option is checked, then when user logs on, 

WAC Server will detect if there are any broken sessions for this user, if so, this 
user will be reconnected to the broken session.  
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¶ Always reconnecting: If this option is checked, then when user logs on, WAC 

Server will detect if there are any existing session for this user, if so, this user 
will always be reconnected to the existing session. In other words, when user logs 
on under the same username, he/she can only create one session if check this 
option. 

 
¶ Agent Redirect: Whether WAC Server should redirect the console application output 

for processing. Redirection allows terminal to be able to receive some special 
characters like the bell signal.  

 
¶ Not redirect: Disable WAC agent redirection.  
 
¶ Redirected: Enable WAC agent redirection. 
 
¶ Taking the server settings: Whether to redirect is up to Server Global Settings. 

 

User Preference  

User Preference 
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This page is for current user to configure their personal settings. But these settings can be 
superseded by “ User Admin Settings” . That is to say all settings you do on this page 
might be not taken effective if the “ User Admin Settings”  is set to supercede user 
preference. 
 
To modify the settings, in the relevant settings line, just click on the "Browse" or 
"Choose" button, or check the "check box". 
 
For the quick reference to the configuration meanings, please see “ User Admin Settings”  
in the above session. 
 

Host Access Control 

Host Access Control 



                                                                                                                                                                                 

Page 120 of 231 

 
 
In this page, you can allow or disallow of connection to WAC Server. You can also 
assign stored user/password to any particular address so the client can logon without 
typing anything (very useful when using RF devices to connect). 
 
The detailed instructions are described in “ Host Access Control” , below is a quick 
reference list: 
 
¶ Configured Hosts: All the added IP addresses will be listed in this box. If you want 

to delete one of the configured IP addresses, just select one the list, and click on 
“ Remove Host”  button. 

 
¶ IP Address: For you to input the host addresses that you want to add to the 

Configured Hosts. 
 
¶ Allow Connect: Disable or enable the configured host connection.    
 
¶ Stored Username: Store login username for the selected configured host. Along with 

the Stored Password, you can allow the selected host to logon without typing 
username/password. 

 



                                                                                                                                                                                 

Page 121 of 231 

¶ Stored Password: Store login password for the selected configured host. Along with 
the Stored Username you can allow the selected host to logon without typing 
username/password. 

Session Manager 

Session Manager 

 
 
In this page, you can observe all session activities, send messages to a particular session 
or all sessions, and abort a session.  
 
The detailed instructions are described in Chapter One - “ Session Manager”  within Part 
Three. 
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CONFIG.EXE 

The "CONFIG.EXE" is a full-screen text-based application. You'll find it quite easy to 
use with mouse operation support. This application can be run from the Run line, or from 
the Command Prompt by typing “ config.exe” . 
 
When you run the "CONFIG.EXE ”  application, you'll see four buttons available for four 
categories of settings you can view or change. Here is the screen snapshot:  
 

  
 
When you entering each settings page, you will find all the configuration names are listed 
on the left box, and when you click on or choose each of them, you'll see its 
corresponding value and expositive remarks displayed on the right side. You can go 
ahead and change the value in the edit box, then continue on other values by clicking on 
another configuration name, or when you are done, click the "OK" button. 
 
With those expositive remarks, you will feel easy to understand and set up the 
configuration parameters. However, if you need more detail, you can refer to their 
appropriate sections, here is the list: 
 
¶ “ Server Settings”  is for configuration of the global sever, which is described in 

“ Server Global Settings” . 
 
¶ “ Communication Settings”  is for serial port communication settings, which is 

described in “ Serial Port Settings” . 
 
¶ “ Regenerate SSH Keys”  is for regenerating the SSH server key pair, which is 

described in “ SSH Server Key Regeneration” . 
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¶ “ User Preferences”  is for preferences of the current user, which is described in “ User 
Settings –  User Preference”  

 
¶ “ Admin Settings”  is administrator settings for user and user group, which is described 

into “ User Admin Settings”  and “ User Access Control” . 
 
¶ “ Host Settings”  is for administrator settings for host access, which is described in 

“ Host Access Settings” . 
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Part Two –  WAC Native Clients  
 

WAC Client are free programs, they speak native protocols which 
are particularly designed for WAC Server.   

This part covers: 

¶ Chapter Six, “ Introduction and Installation”  Provides 
information about the native client instruction and installation. 

 
¶ Chapter Seven, “ Getting Started”  Provides information about 

the preparatory working before accessing to the remote 
computer and the logging process.   

 
¶ Chapter Eight, “ Command Line Options”  Lists and describes 

all command options supported by WAC Native Clients, such 
as HELP, CD, LCD, SEND FWDLOCAL, FWDREMOTE, 
PRINT and QUIT. 
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CHPATER SIX 
 

WAC Native Clients 
 

This chapter contains the following sections: 

 

¶ The “ Description”  section provides description to the native clients. This includes an 
explanation of the differences between WACTERM and WACSSH.  

¶ The installation section provides information on how to install the native clients. 
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Description 

Thanks for using WAC Native Clients –  WACTERM and WACSSH. WAC Native 
Clients are WAC Server package client part which was particularly designed for 
accessing WAC Server from your workstation(s) or terminal(s). 
 
With WAC Native Clients, WAC users can achieve the best and ideal effect in WAC 
interactive environment. So, using our WAC Clients to access our WAC Server is highly 
recommended, though there are other clients supported by WAC Server too. 
 
WAC Native Clients include two programs: WACTERM and WACSSH 
 
WACTERM is our telnet native protocol client, which is efficient when used over a 
local area network or Internet, but it can leak out you sensitive data like user name and 
password.  
 
WACSSH is our Secure Shell native program, which was designed to meet the needs of 
encrypted terminal connections and secure file transfers. Via this client program, all your 
communication traffic (including passwords) will be effectively encrypted, you are no 
longer to worry about eavesdropping or connection hijacking 

Installation 

WACTERM and WACSSH can be installed on Windows 95/98/Me/NT 4.0/2000/XP.  
As they are free, they don't require any installation except copying the file itself. If you 
want, you can create a shortcut of the file to any of your local computers. 
 
Where to Copy  
 
¶ On your host machine, go to the WAC Server installation directory, find the icons 

that labeled "wacterm.exe" and "wacssh.exe", and perform copy and paste tasks. 
  
If you are replicating to your local machine over your intranet, you can use the Windows 
"Network Neighborhood". 
 
If you are replicating to your local machine over internet, alternatively, you can go to our 
site to download them. Seconds are sufficient. Download link: 
"http://www.foxitsoft.com/wac/client.zip". 
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CHAPTER SEVEN 

Getting Started 
 
 
This chapter contains the following sections: 
 
¶ The “ Preparatory Work”  section introduces how to enable the mouse support and 

change the terminal size before launching WAC Native Clients or logging into WAC 
Server. And there are illustration shows available. 

 
¶ The “ Starting… ”  section introduces the connecting and logging process. In the 

“ ” Logging In”  section you will be introduced to some logon settings that can be later 
configured by one of WAC Configuration tool; and in the “ After logging In”  section, 
you will learn what programs or commands you can run and use when successfully 
land on WAC Server. 
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Preparatory Work 
 
Before log onto WAC Server, you might need to do some preparatory work such as 
“ enabling mouse support and change the screen size” . If you already know how to do 
with, just skip to the other section.  

Enable the Mouse Support  

WAC Native Clients support mouse operations. If this is your first time using WAC 
Clients to access WAC Server, you might find that your mouse is unavailable. To enable 
the mouse support, you need to disable the Quick Edit mode in the Windows console 
Properties tab, because that mode will use the mouse for selecting the console content 
instead of sending the mouse events to WAC Server applications.  
 
Here is step-by-step about how to enable the mouse, and you can also see the illustration 
shows below. (In the following case, we will be using WACSSH as examples.). 
 

1. Run the WACSSH. 
2. Click the console button sitting on the window left-up border, then click 

Properties. 
3. On the Properties -- Options tab, disable Quick Edit Mode under the Edit 

Options, then click Ok to close the Properties box.  
4. On the pop-up prompt box, check the second option, then click Ok to finish.  
5. Now you need to run WACSSH program again, or your changing can't take 

effective. If you are taking this action within a session (after logging in), you have 
to disconnect and re- logon.  

 
Here is the illustration: 
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Step One  

 
 

Step Two 
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Step Three 

 
 

Step Four 
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Step Five 

 
 

Change the Terminal Size  

WAC Clients support different screen sizes and uses the full screen of your console 
window, if you want to use a different screen size for your terminal, you have to resize 
the console window and re-logon.  
 
If you are running WAC Clients from a command prompt window, just resize the 
command prompt window before launching the clients (Keep to the 2-4 steps as follows). 
If you are running WAC Clients from your desktop (shortcuts), just use the default 
console size (80x25). Yet, if you still want to change the size, you need to close the client 
program after change sand run it again, or your changing can't take effective (Keep to the 
1-5 steps as follows). 
 
Here is step-by-step about how to change the terminal size, you can also see the 
illustration shows below. (In the following case, we will be using WACSSH as 
examples.)  
 

1. Run the WACSSH. 
2. Click the console button sitting on the window left-up border, then click 

Properties  
3. On the Properties -- Layout tab, specify the screen buffer and size, and then 

click Ok to close the Properties box. 
4. On the pop-up prompt box, check the second option, then click Ok to finish.  
5. Now you need to run the WACSSH program again, or your changing can't take 

effective.  
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NOTES: 
 
¶ Don't use console button to change the console size within a session (after logging 

in), because that will be rendering inconsistence between the console buffer, the 
WAC server, and the terminal client you are using.  

 
¶ Some applications might force a console size change during initialization, in this 

case, when you quit those applications, you need to use console button to change 
the console size back to what you used when you logged on.  

 
Tips:  
 
¶ If you often use different screen sizes to connect, for conveniences, you can create 

shortcuts for WAC Client and assign different terminal window sizes to each of 
the shortcuts by using the windows console button.  

 
Here is the illustration: 

Step One  
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Step Two 

 
 

Step Three 
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Step Four 

 
 

Step Five 
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Starting…  

Establishing a Connection  

When you run one of the WAC Native Clients, you will see a pop-up console prompt 
(Fig1), requiring the host name and address that you want to visit. Once you have finished 
the "Host Name" and press Enter, WACTERM or WACSSH will begin trying to connect 
you to the server. 
 
NOTE: If you are using an ssh client and want to use the public key to verify yourself to 
WAC Server, please refer to Chapter Three - “ Authenticating Using User Public Key” .  

 
Fig1 

Logging In  

After you have got connected, by default you will be presented with logon banner as well 
as the logon information - username, password and domain if any (Fig.2). 
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Fig2 

Logon Banner: By default, once you got connected, WAC Server will display you logon 
banner before your logon. You can modify this logon banner by using one of WAC 
configuration Tools. See Chapter Five –  Server Global Settings –  “ User Logon Banner” . 
 
Username and Password: You should enter your valid Windows user account, and press 
Enter. 
 
Domain: After you provide username and password, you will be asked for this field. The 
Domain field is optional, if you do not wish to connect to a particular domain, just ignore 
it simply by pressing Enter. Otherwise type the domain name you want to connect. You 
can disable and enable the domain prompt by using one of WAC configuration Tools. 
See Chapter Five –  Server Global Settings –  “ User Logon Domain Name” . 
 
After you have provided the logon information and press Enter, and then by default 
WAC Server will grant your access with WacMenu (fig.3) 
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Fig.3 

WAC Menu: WacMenu serves as a doorway to all WAC Toolkit applications. From here 
you can easily view and launch all WAC Tools to aid your remote administration. You 
can disable and enable WAC Menu by using one of WAC configuration tools. See 
Chapter Five –  Server Global Settings –  “ Launch WAC Menu” . 

NOTES: 

¶ For your security, if you have mistyped your password more than three failed login 
attempts, by default, WAC Server will close your client window. You can change the 
login attempts by using one of WAC configuration tools.  

 
¶ If you are logging onto XP host system through WAC Server without password, you 

will fail to do. Because Windows XP allow you to create user account without 
password, yet by default not allow you to console logon with blank password. For 
details, please see Managing User and Group - "Tips for Widows XP Users".  

After Logging In 

After you log onto WAC Server, what happens next is up to what actions you take. 

1. You can launch full screen text programs. These programs use the whole screen to 
display. They can display colorful text information, graphic special characters, and 
even some of them can accept mouse input. WAC Server includes a collection of full 
screen text programs called "WAC Toolkit" that allows you to do a lot of things on 
your server.  

 
For more information about WAC Toolkit, please refer to Part Three.  
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2. You can run command line programs (some called "TTY programs"). These 
programs take and display simple text information and can be run with any type of 
terminals. WAC Server includes a series of "wac" command tools for you to view and 
manage the status of WAC Server.  

 
For more information about WAC command line tools, please see Chapter Four –
“ WAC Command Line Utilities” .  

 
3. You can execute basic Windows commands like "dir", "cd", "del" to manage your 

Windows files and other resources. To see a list of commands available, type "Help" 
at the console window.  

 
4. You can use WAC Native Clients Command Line Tools. During the WAC client - 

server session, simply press CTRL+}, and your virtual server screen will be 
magically switch to WAC Client screen. Being there, you can browse around the 
local and remote directories, send files to server, perform printing job and even do 
port forwarding (wacssh only).  

 
For more information about WAC Clients commands, please see WAC Client 
Command Line Utilities.  

Logging Out 

When you have finished your session, you should log out by typing the server's own 
logout command "exit". When the server processes your logout command, the WAC 
Client window should close itself automatically. 
 
You can also close a WAC session using the Close button in the window border or using 
the Quit option at the WAC Client command screen, but this might confuse the server 
and render the data lost on those running applications, or suspend the session and make 
the session stay around. 
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CHAPTER EIGHTE 
WAC Client Command Line Utilities 

 
When you use WAC Native Clients to connect to WAC Server, you can press CTRL-] 
keys to temporarily leave the terminal screen and enter the WAC Client "command 
screen" as shown below (in our case, we will be using WACSSH as examples): 
 

 
 
At the command screen, you can type commands followed by "ENTER" to execute 
commands related to the current WAC connection. Commands are case insensitive. 
Type "HELP" then press "ENTER" key will give you a list of all commands supported by 
the WACTERM and WACSSH.  
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“ HELP”  --- Help Information  

Get a list of all supported commands, or detailed information about a particular command. 
 
Syntax: 
 

HELP 
HELP <command name> 

 

“ CD”  --- Change Remote Directory  

Change the current directory of the WAC Server you are connecting to. This directory 
will be used to place any files you send to the server. 
 
Without any parameter, CD command will display the current remote directory. 
 
Syntax: 
 

CD 
CD <directory name> 

 
You can type space within the directory name, like: 
 

CD Application Data 
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“ LCD”  ---- Change Remote Directory  

Change the current directory of the WAC Clients. This directory will be used to place any 
files you received from the server. 
 
Without any parameter, LCD command will display the current local directory. 
 
Syntax: 
 

LCD 
LCD <directory name> 

 
You can type space within the directory name, like: 
 

LCD Application Data 
 
When you change the local directory to somewhere you don't have permission to access, 
this command fails, an error message will be given, and the local current directory stays 
at the previous directory. 
 
When you change the remote directory to somewhere you don't have permission to access, 
this command fails, an error message will be given, and the remote current directory stays 
at the previous directory. 
 

“ SEND”  ---- Send Local Files to Remote Host  

Send local file(s) to the server. Those files will be placed in the current remote directory, 
with the same file name (if the file exists in remote directory with the same name, it will 
be overwritten). 
 
Syntax: 
 

SEND <file name>  
i.e.; send c:/program files/wac/pubkey.txt 

 
You can include wildcard characters (*, ?) in the file name, if more than one files found, 
they will be sent to the server one by one. 
 

i.e.; send c:/program files/wac/*.txt 
 
This command will print out the full path of each sent file, if the file rejected by the 
remote server, an error message will be given but it continues to send the next file if there 
is any. 
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For how to send files to terminal from server, please refer to Chapter Four –  “ File 
Transfer” . 
 

"FWDLOCAL" ----Local Port Forwarding (wacssh only)  

Tunnel local TCP port connections to the server side. At the command screen, type "help 
fwdlocal" you should get help information about local forwarding.  
 
Syntax: 
 

"FWDLOCAL <local port> <remotehost>:<remote port>"  
i.e.; FWDLOCAL 3001 server1.remote.com:22 

 
WACSSH will be listening on port 3001, any connections coming to this port will be 
forwarded to the server, where the connection will be further forwarded to the host 
server1.remote.com:22. (The server and this host can be the same machine.)  
 
If you want to view all the previous local configurations, type "fwdlocal". This command 
will list all the schemed local port forwarding for you. 
 
If you want to remove the previously configured local port forwarding, type "fwdlocal 
<local port>". This command will drop this port from the schemed local port forwarding 
list. 
 

"FWDREMOTE" ---- Remote Port Forwarding (wacssh only)  

Tunnel remote TCP port connections to client side. At the command screen, type "help 
fwdremote", you should get help information about remote forwarding.  
 
Syntax: 
 

"FWDREMOTE <remote port> <local host>:<local port> "  
i.e.; fwdremote 3002 server1.local.com:22  

 
WACSSH will send a request to the server, if approved, the server will be listening on the 
port 3002, any connection that coming to this port will be forwarded to WACSSH, where 
the connection is further forwarded to the host server1.local.com:22. (WACSSH client 
and this local host can be the same machine.)  
 
If you want to view all the previous remote configurations, type "fwdremote". This 
command will list all the schemed remote port forwarding table for you. 
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If you want to remove the previously configured remote port forwarding, type 
"fwdremote <local port>". This command will drop this port from the schemed port 
forwarding list. 

"PRINT" ---- WAC Client Side Printing  

Choose an actual printer for WAC Client Printing. At the command screen, type "Help 
Print" would display you a list of print assistance. 
 
Syntax: 
 

Print 
Print <printer number> 
Print 0 

 
Where: 
 
¶ Print ---- to display available printers and current printer. The printer preceded by 

wild card (*) is the current printer. 
 
¶ Print <printer number> ----- to choose a printer. WAC Client lists your available 

printers by numeric figure, so to choose a printer, you are asked to choose the number 
before the printer. 

 
¶ Print 0 ---- Disable the printing on this client. Here "0" is zero. 

"QUIT" ---- Quit the Client Program  

Simply quit the WACTERM or WACSSH application and disconnect from the server. 
 
Syntax: 
 

QUIT 
 
This QUIT command is same to Close button in the window border, will broke the WAC 
Session and all applications you are current running will be aborted, it's possible that 
some data of those running applications got lost during the quit process, so it's 
recommended that you don't use QUIT command, instead, go into the WAC session, quit 
the running application, and type "EXIT" at the command prompt.  
 
Tip: 
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¶ If you don't want to lose your data by this command, or hope to continue your work 
after your session is broken from server unexpectedly, you can use WAC 
Configuration Tools to set the "KeepSession" for a period of time, thus you can 
recover your data and go on your work when you reconnect again.  
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Part Three –  WAC Toolkit 
 
WAC Toolkit are Windows text-based applications, they provide a cost-
effective way for you when you do remote administration. 
 
This part covers: 
 
¶ Chapter Nine, “ Introduction to WAC Toolkit ”  provides general 

information about WAC tools, lists all the tool applications currently 
available in WAC Server, and gives brief instructions on WAC 
Toolkit installation. 

 
¶ Chapter Ten, “ Using WAC Toolkit ”  provides information about the 

specific how-to topics that explain how to accomplish the specific 
task by using the text-based applications.   
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CHAPTER NINE 

Introduction to WAC Toolkit 
 
 
This chapter contains the following sections: 
 
¶ The “ Description”  provides introduction to WAC Toolkit. 
 
¶ The “ features”  section briefly exhibits a list of features of WAC Toolkit. 
 
¶ The  “ WAC Toolkit List”  list and explain WAC Tools with grouping them in “ user 

tools”  and “ administrator’ s tools”  
 
¶ The “ Ways to Launch WAC Tools”  provides introductin to hwo to run WAC 

programs on session environment or on a local computer. 
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Description 

WAC Toolkit is a collection of text-based applications designed for Windows 
NT/2000/XP systems. These applications are all text-based applications, or console 
applications, they utilize the full console screen and support mouse operations.  
 
Since they are Windows applications, they support advanced features provided by 
Windows, and run efficiently without any additional support from the operating system.  
 
WAC Toolkit is bundled in WAC Server, so if you are WAC Server customers, you 
automatically have WAC Toolkit, for free. But even if you don't use WAC Server, you 
can purchase WAC Toolkit separately, and all WAC Toolkit applications run well 
without WAC Server, except few features requiring WAC Server support, like file 
transferring between WAC Server and WAC Clients. 
    
Among applications in WAC Toolkit, there are basically two categories of tools, some 
are tools for normal users, others are tools for system administrators.  For more 
information, please refer to WAC Toolkit Lists. 

Features 

¶ Graphic-like Interface: WAC applications have the look and feel as graphic 
applications, yet they are text-based applications and can be delivered to remote 
terminals.  
 

¶ Color Support: Support full ANSI colors. WAC applications make use of full screen 
color, it is pleased to eyes and extremely easy to operate. 
 

¶ Mouse and Keypad Support: Both mouse operations and shortcut keys are available 
in WAC Toolkit. Many jobs can be achieved with only a few clicks and presses. 
 

¶ Desktop Shortcuts: Create a shortcut to make even faster and efficient use to your 
local computer. You can also make shortcuts to desktop with different screen size for 
using convenience. 
 

¶ Easy Setup: For WAC Server users, only need to copy and paste the files into your 
intended place. For other server users, four or five steps are enough to set up the 
programs. 
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WAC Toolkit Lists 

As mentioned before inside WAC Toolkit there are many text-based Windows 
applications, they are helpful when you do remote access. WAC applications are useful 
for both normal users and system administrators. For quick snap, here is a list of all WAC 
Toolkit: 
 

Tools for Users 
 
Text Editor:  A basic text editor which is more powerful and efficient than the old MS-
DOS Editor. 
 
Binary Editor: A binary and text editor which is used for viewing and changing binary 
files. 
 
File Manager: A file manager which functions as Windows Explorer and lets you view 
and administer all your files and folders. You can even send files here. 
 
WAC Explorer: Allow you to explore your computer, as well as your network 
neighborhood, much like the graphic Windows Explorer. 
 
Email Inbox: A mail tool allows users to check the emails in the inbox at the remote 
server machine, and even to reply emails or compose new emails too.  
 
 
Phone: A chat tool enables you to start a chat dialog with someone located at your 
remote host computer while you are on your local client computer. And your typing got 
displayed on other user’ s screen instantly. (Please note this tool is only available on 
WAC Server connectivity environment.) 
 

Tools for Administrators 
 
Session Manager: View and manage all authorized logged-on user sessions, you can 
send or broadcast messages, you can even watch what other people is doing by screen 
watching. (Please note this tool is only available on WAC Server connectivity 
environment.) 
 
Process Viewer: A process viewer which lists all current processes on the machine and 
refresh itself periodically, and you can kill a process here. 
 
Service Manager: A service manager which allows you to view and manage all your 
windows services on your server, and can even on another machine by connecting to it. 
Event Viewer: An event viewer which lets you to take a close look at what happened on 
your machine, and even on another machine by connecting to it. 
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Registry Editor: A registry editor which functions as Windows Registry Editor, and so 
you don't need to renewedly learn to how to use it. 
 
User Manager: A user manager which allows advanced users to manage all users on the 
server. 
 
System Information: A computer manager which allows you manage various aspect of 
the server system. 
 
Games: Small game programs including Snake and Mine for amusement. 
 
WAC Toolkit users should find most of WAC tools function exactly like tools under 
Microsoft Windows system, even more powerful and efficient to use. There are more 
upcoming advanced tools. 
 
Reference: For using particular steps, please refer to Chapter Ten –  “ Using WAC 
Toolkit” . 
 

Ways to Launch WAC Tools 

WAC Toolkit contains a host of console programs (or called text-based programs), so 
exactly WAC Toolkit are console Toolkit. Unlike the GUI programs that can be only run 
and used on the local machine, WAC console Toolkit can be run and used locally and 
remotely. 
 
If you are a WAC Server user, you can run WAC tools from the following ways: 

Within a WAC session  

1.  From the WacMenu  
 

When you get connected with WAC Server, you should be granted by "WacMenu" on 
which lists all the WAC tools. Just click the button that labeled the tool name, and you 
will enter into the program window. Press "ESC" can help you exit from the current 
program at any time. 
 
2. From the Command Line  
 
During you are working at the command line in a WAC session, just type their executive 
name to run them like: "EDIT.EXE", "BINEDIT.EXE".  
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NOTE: Each program has its own corresponding executive name. For references, please 
see Appendix C –  “ Program and Executive Name Contrast” . 

On the server machine  

1. From the Run Line  
 
If you are to start the programs on the server machine, you can run them from the Run 
Line. Do like this: Click Start, click Run, in the Open box, type the executive name of 
the tool. 
 
NOTE: Each program has its own corresponding executive name. For references, please 
see Appendix C –  “ Program and Executive Name Contrast” . 
 
2. From the Windows Command Prompt (or called Console Window)  
 
If you are to start the programs on the server machine, you can run them from the 
Windows Command Prompt. On the command line, just type the executive name of the 
tool, and type Enter.  
 
3. From the shortcut  
 
If you are to start the programs on the server machine, you can directly click the program 
icon inside the WAC Server installation directory. Or if you have already created 
shortcuts for them, then just click the shortcuts. 
 
NOTE: All WAC tools can work greatly by themselves, so you can copy them to your 
other computers without WAC Server's environment required.. 
 
 

Installation   

If you are a WAC Server customer, you are not required to install the Toolkit. Because 
during your installing WAC Server, all the tool files have been already copied into your 
computer. You can find these files on the server installation directory.  
 
If you are a sheer WAC Toolkit customer, the installing progress takes you just two 
minutes. Detailed instructions are described as follows: 
 
1. Download the software from the web server into your temporary directory on your 

hard disc. And unzip the package (WACTOOL.ZIP). 
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2. Run one of the extracted files, SETUP.EXE. The install Shield Wizard will begin 
automatically. 

3. Click Next on the Welcome Screen to read the WAC Toolkit License Agreement, and 
click I Agree to indicate your acceptance of these license terms and conditions. 

4. Click Next to accept the default destination for the Toolkit installation. 
5. On the complete notification screen, click Finish.  
6. Congratulations, you have now set up the WAC Toolkit and are ready to start using it.  
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CHAPTER TEN 

Using WAC Toolkit 
 
 
 
 
 
WAC Toolkit was developed to cater to those Windows advanced administrators who 
often need to do some remote administration such as managing remote user or sever 
systems, editing Windows system registry or tracing system events etc. through 
command prompt, and those normal Windows users who just need to do some simple 
operations on the remote machine such as editing texts, handle mails and managing 
routine files etc.  

 
In this chapter, we are discussing step by step about how to use WAC tools. 
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Text Editor  

Text Editor is a basic text editor that you can use to create simple text documents. The 
most common use for Editor is to view or edit text (.txt) files. This WAC Text Editor is 
more powerful and efficient than the old MS-DOS Editor. 
 

Figure 10-1 Screen Snapshot 
 
 

             
 

Using Text Editor 

File Menu  

This menu mainly comprises of creating, opening, saving and existing from a file: 
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New: Creates a new screen to edit files.  
 
¶ If you are switching to another screen from the current active screen without 

saving it, Edit will pop up a box to ask you this file untitled has not been saved yet, 
save it now? Once choose No, you will lose the unsaved data and never recover it, 
choose Yes to bring about a Save box for you to save and entitle the file.  

 

Open: Selects a drive or folder and opens an existing file.  
 
¶ In the Disc or Directories box, select the path name where your file locates in, 

then in the Files box select the file (.txt) you want to open. What you select in the 
boxes will be mapped into the Path field and File Name field.  

 

Save: Saves a new-created file or an existing file without renaming it. In the Save box, 
you can choose one of the following ways to do:  
 
¶ In the File Name field, input the file name, then in the Disc or Directories box 

select a drive or folder where you want to place your file, and then click OK to 
create a new file.  

 
¶ In the Disc, Directories and Existing Files boxes, select a different drive, directory 

or filename, and then click OK to replace the existing file.  
 

Save As: Saves and names the file you are working on.  
 
¶ Use this command to name a new unnamed file, or to rename an existing file. If 

there's an existing file with the same name, then Edit asks you if you're sure you 
want to replace it with this file.  

 

Exit: Quits form the current application.  
 
¶ Click this command, Edit asks “ if you want to exit this program?". If there is an 

unsaved file, Edit pops up a dialog box asking "the file untitled has not been saved 
yet, save it now?" Click Yes to bring about Save box for you to save and entitle 
this file, click No to quit the application completely. 

Edit Menu: 

This menu primarily contains standard window editing commands: 
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Undo <Ctrl+z>: Provides you a chance to undo your last action. 
 
¶ On Edit menu click Undo or press Ctrl+z  

 

Cut <Ctrl+x>: Cuts the current selected text to the clipboard so that you can move it 
to another location. 
 
¶ Select the text, and then on the Edit menu, click Cut or press Ctrl+x.  

 

Copy <Ctrl+c>: Copies the current selected text to clipboard so that you can paste it 
to another location. 
 
¶ Select text, and then on the Edit menu, click Cut or press Ctrl+c.  

 

Paste<Ctrl+v>: Pastes text you have cut or copied into screen. 
 
¶ Place the insertion point where you want to paste the text, and then on the Edit 

menu, click Paste or press Ctrl+v.  
 

Clear<Del>: Deletes the highlighted text on the current active session. 
 
¶ Select text, and then on the Edit menu, click Delete or press Del.  

Search Menu  

 
 

Find: Find text in a file.  
 
¶ To find text that is an entire word and not part of a longer word, click Match 

Whole Word only.  
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¶ To find text with the same combination of uppercase and lowercase letters as the 

find text, click Match Case.  
 
¶ You can press ESC at any time to cancel the search.  

 

Repeat Last Find: Continues searching for additional instances of the same text.  
 

Replace: Finds specified text and replaces with a new text.  
 
¶ To confirm each replacement, click the Replace button. 

 
¶ To replace all occurrences of the text at once, click the Replace All button.  

 
¶ To find text with the same combination of uppercase and lowercase letters as the 

find text, click Match Case.  
 
¶ The first occurrence of the text is selected, and you are prompted to either Replace 

this match, or to Skip this match without replacing it, or to Cancel the search. 
 
¶ You can also press ESC at any time to cancel the search. 

Options Menu  

 
 

Settings: Presets tab stops and print port for Edit. 
 
¶ Use Tab Stops to determine the number of the tab stops on a line.  

 
¶ Use Printer Port to indicate the port your printer is connected to.  

 

Colors: Determines the color of screen elements.  
 
¶ First, from the Item list, click the item you want to change.  

 
¶ Second, from the Foreground list, click the color you want the item to be.  

 
¶ Third, form the Background list, click the color you want the background to be.  
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NOTE:  
 
¶ To go back to the original color scheme, click Default. This undoes all the 

changes you have made.  

Help Menu  

About: Suggests Edit version and copyright. 
 

Commands: Provides Cursor Movement Commands, Editing Commands etc. 
 

Cursor Movement Commands 

Home  Move to the start of the current line  

End Move to the end of the current line  

Ctrl+Up Scroll up one line  

Ctrl+Down  Scroll down one line  

PageUp Scroll up one screen  

PageDown  Scroll down one screen  

Ctrl+PgUp Scroll left one screen 

Ctrl+PgDn Scroll right one screen 

Ctrl+Home Scroll to the start of the document  

Ctrl+End Scroll to the end of the document  

Ctrl+Lef Move left one word  

Ctrl+Righ Move right one word  

Editing Commands 

Enter Start a new line 

Delete Delete the character that the cursor is on 

Backspace Delete the character to the left of the cursor 

Tab Move the cursor to next tab stop 

Insert Switch between insert and overwrite modes 

Ctrl+Y Delete the current line 

Ctrl+V Paste buffer contents into file 

Commands for Working with Selected Regions 

Shift 
Use the shift key in conjunction with the cursor movement 
functions to select regions 

Ctrl+C Copy the current selection to buffer 

Ctrl+X  Delete the current selection and copy it to buffer 
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Delete Delete the current selection 

Backspace Delete the current selection 

Commands Management Commands 

Ctrl+F Find text 

Ctrl+R Find text and replace it 

F3 Repeat the last search 
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Binary Editor  

Binary Editor (BinEdit) is a binary and text editor. With this application you can open 
other special formatting documents in binary format and then edit them. 
 

Figure 10-2 Screen Snapshot 
 
 

 
 

Using Binary Editor 

File Menu 

This menu mainly comprises of creating, opening, saving and existing from a file: 
 

 
 

New: Creates a new screen to edit files.  
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¶ If you are switching to another screen from the current active screen without 
saving it, BinEdit will pop up a box to ask you this file untitled has not been saved 
yet, save it now? Once choose No, you will lose the unsaved data and never 
recover it, choose Yes to bring about a Save box for you to save and entitle the 
file.  

 

Open: Selects a drive or folder and opens an existing file.  
 
¶ In the Disc or Directories box, select the path name where your file locates in, 

then in the Files box select the file you want to open. What you select in the boxes 
will be mapped into the Path field and File Name field.  

Save: Saves a new-created file or an existing file without renaming it. In the Save box, 
you can do: 
 
¶ In the File Name field, input the file name, and then in the Disc or Directories box 

select a drive or folder where you want to place your file, and then click OK to 
create a new file.  

 
¶ In the Disc, Directories and Existing Files boxes, select a different drive, directory 

or filename, and then click OK to replace the existing file.  
 

Save As: Saves and names the file you are working on.  
 
¶ Use this command to name a new unnamed file, or to rename an existing file. If 

there's an existing file with the same name, then Edit asks you if you're sure you 
want to replace it with this file.  

 

Exit: Quits form the current application. 
 
¶ Click this command, BinEdit asks you "do you want to exit this program?". If 

there is an unsaved file, BinEdit pops up a dialog box ask you "the file untitled 
has not been saved yet, save it now?". Click Yes to bring about Save box for you 
to save and entitle this file, click No to quit the application completely.  

Edit Menu  

This menu primarily contains standard window editing commands: 
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Undo: Provides you a chance to undo your last action.  
 
¶ On Edit menu click Undo or press Ctrl+Z 

Cut: Cuts the current selected text to the clipboard so that you can move it to another 
location. 
 
¶ Select the text, and then on the Edit menu, click Cut or press Ctrl+x.  

 

Copy: Copies the current selected text to clipboard so that you can paste it to another 
location. 
 
¶ Select text, and then on the Edit menu, click Cut or press Ctrl+c.  

 

Paste: Pastes text you have cut or copied into screen. 
 
¶ Place the insertion point where you want to paste the text, and then on the Edit 

menu, click Paste or press Ctrl+v.  
 

Delete: Deletes the highlighted text on the current active session. 
 
¶ Select text, and then on the Edit menu, click Delete or press Del.  

 

Select All: Select all text displayed on the current screen including those in the scroll 
buffer history at once. 
 
¶ On the Edit menu, click Select All or press Ctrl+A  

Search Menu  

 
 

Find Binary: Finds data in the binary formatting file.  
 
On the Search menu, click Find Binary. In Find What, type the data you want to find.  
 

Find Next Binary: Continues searching for additional instances of the same data. 
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On the Search menu, click Find Next Binary or press F3.  
 

Replace: Finds specified data and replaces with new data. 
 
¶ On the Search menu, click Replace. 

 
¶ To replace all occurrences of the data at once, click the Replace All button.  

 
¶ The first occurrence of the data is selected, and you are prompted to either 

Replace this match, or to Skip this match without replacing it, or to Cancel the 
search. 

 
¶ You can also press ESC at any time to cancel the search.  

 

Find Text: Looks for words or characters in the text file. 
 

Find Next Text: Continues looking for additional instances of the same words or 
characters. 
 

Replace: Finds specified words or characters and replaces with new words or 
characters. 

Options Menu  

 
 

Colors: Determines the color of screen components. 
 
¶ First, from the Item list, click the item you want to change.  

 
¶ Second, from the Foreground list, click the color you want the item to be.  

 
¶ Third, form the Background list, click the color you want the background to be.  

 
NOTE:  
 
¶ To go back to the original color scheme, click Default. This undoes all the 

changes you have made.  
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Help Menu  

 
 
About: Suggests BinEdit version and copyright. 
 
Commands: Provides Cursor Movement Commands, Editing Commands etc. 
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WAC Explorer 

WAC Explorer is a text-based application particularly for managing files remotely. It 
functions somewhat like your familiarized Windows Explorer, very simple and fast to use. 
You can use it to explore your computer as well as your network neighborhood. And also 
you can copy, move, rename, and search for files and folders. For example, you can open 
a folder that contains a file you want to copy or move, and then drag it to another folder 
or even another driver. 
 
WAC Explorer displays the hierarchical (tree) structure of files, folders, drives and 
network places on your computer. It also shows any network drivers which have been 
mapped to drive letters on your computer.  
 

Figure 10-3 Screen Snapshot 
 
 

  

Using WAC Explorer 

To create a new file or folder 

 
1. In the Explorer window, click the drive or folder in which you want to create a 

file or folder  
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2. In the File menu, click New.  

 

 
 

3. In the pop-up New box, check New Directory or New File, in the Name typing 
line, enter name for the new folder or file.  

 
4. Click OK to create and close the box.  

 
NOTES: 
 
¶ You can manually enter the file or folder destination in the pop-up New box.  

 
¶ The type of the file you want to create depends on which extension you assign to 

it. For example, you can assign a file with extension " .doc" if you want to open it 
in the Microsoft Word later. If you don't specify any extension, the file type will 
be regarded as unknown type.  

 
¶ File names cannot contain such characters: \ /: *? " < > |  

To delete a file or folder 

1. In the Explorer window, click the file or folder you want to delete.  
 
2. Make sure the file or folder is what you want to delete.  

 
3. In the File menu, click Delete.  

 
4. Click OK when prompted.  
 

NOTE: 
 
¶ If you want to restore the deleted items you can use the Recycle Bin in the 

Windows system.  
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To change the name of a file or folder 

 
1. In the Explorer window, click the file or folder you want to rename.  
 
2. In the File menu, click Rename.  

 

 
 

3. In the pop-up Rename box, type New Name in the text typing line.  
 

NOTES: 
 
¶ File names can't contain such characters: \ /: * ? " < > |. 
 
¶ The primal name of file or folder will be presented in the Original Name. 

 

To send files to terminal window 

 
Using this command, when you are working remotely via WAC Server, you are able to 
send files to your terminal session where WAC client is running. 
 

1. In the Explorer window, search for the drive and folder where your file locates in.  
 
2. In the right tree panel, click the text file (*.txt) you hope to send.  
 
3. In the File menu, click Send.  

 
NOTES: 
 
¶ The sent file will be placed in your current working directory of your local 

machine. To view this directory, you can press CTRL+] and type LCD.  
 
¶ Currently, you can only send one file at a time, and the sending will be done at 

background so when it's sending, you should be able to continue with your WAC 
Explorer session (of course, due to the communication usage, you'll experience 
some slow down). 
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¶ During the file transferring, you can't start the sending for another file. You have 

to wait for the current file to be finished. In future version of WAC Server, a 
queue will be implemented allowing a bunch of files to be started at the same time. 

 
¶ In case the file is rejected by the receiving machine (due to access denied, or out 

of disk, etc.), you will see an alert message popping up on the terminal screen, 
you'll have to resend that file again after the problem got fixed.  

 

To display file or folder attributes 

 
1. In the Explorer window, click the file or folder you want to view.  

 
2. In the File menu, click Attributes.  

 
 

3. If you want to assign attributes to your file or folder, click the blank bracket box. 
To remove, just click it again.  

 
4. After finish, click OK to close the box.  

 
NOTE: 
 
¶ If you are viewing a file, you can just double-click this file to display its attribute. 

 

To copy or move a file or folder  

 
¶ In the Explorer window, click the drive or folder you want to work with.  
 
¶ Click the file or folder you want to copy or cut 

 
¶ In the Edit menu, click Copy or click Cut to move the item. 
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¶ Open the folder or drive where you want to put the file or folder. 

 
¶ In the Edit menu, click Paste.  

 

To move files by dragging 

 
1. In the Explorer window, search for the file or folder you want to move.  

 
2. Make sure the destination for the file or folder you want to move is visible.  

 
3. Drag the file or folder to the destination.  

 
NOTE: 
 
¶ To drag an item in WAC Explorer, it is moved, not copied. 

 

To Search for a file or folder 

 
1. In the Explorer window, in the Edit menu, click Find.  

 

 
 

2. In the pop-up Search box, select the Location or Directories in which you want 
to search.  

 
3. In KeyWord, type all or part of the file name or folder you want to find. If you 

only type part of the name, make sure you don't check Match Whole under 
Options.  
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4. Click OK if you don't need more search criteria. If you need to narrow your 
search, however, then you need to specify additional search criteria under 
Options. Please read the following instruction to help you to select:  

 
NOTES: 
 
¶ When you click OK to search, your screen may be frozen for a while before 

displaying the search results.  
 
¶ The more exact the keywords you typed are, the more efficient the finding is.  

 
¶ If you still want to see the results you found in the last time, press F6 to display or 

click Result in the Edit menu.  
 

¶ Options  
 
If you need to narrow your search, you need to specify additional search criteria 
under Options like "Size, Case Sensitive, Search Subfolders, Date, Match Whole." 
 

Size: To look for files with specific size. 
 
When you click Size, you should see a pop-up dialog box as below, in At Least, 
describe the minimal size of the file. In At Most, describe the maximal size of the 
file. 
 

 
 

Case Sensitive: To look for files featured with the exact combination of 
uppercase and lowercase characters. 
 

Search Subfolders: To look for files by entering every child folder not only 
limited to parent folders.  
 

Date: To look for files that were created, modified or accessed on or between 
specific dates.  
 
When you click Date, you should see a pop-up dialog box as below, in the Date 
Items, select one of the items, and on the right area, specify Months, Days or 
Between-and  
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Match Whole: To look for files that have the same letters you entered in the 
KeyWord. 

 

To show and hide the address bar 

 
1. To display the address bar, in the Explorer window, in the View menu, click 

Address Bar.  
 

2. To hide the address bar, click it again in the View menu.  
 

To show and hide the folder bar 

 
1. To display the status bar, in the Explorer window, in the View menu, click 

Status Bar.  
 
2. To hide the status bar, click it again in the View menu. 

 

To show and hide the folder bar 

 
1. To display the folder bar, in the Explorer window, in the View menu, click 

Folder Bar.  
 

2. To hide the folder bar, click it again in the View menu.  
 
NOTES: 
 
¶ To display subfolders, in the folders pane, click the plus sign (+) next to the folder. 

Or, double-click the folder.  
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¶ To change the size of either side of the window, drag the bar that separates the 
two sides. 

 

To crosscut to another directory 

 
During a session, if you want to change your current working directory, and approach to 
another, you can use this menu. 
 

1. In the Explorer window, in the View menu, click Go to.  
 

 
 

2. In the pop-up Go to box, select the Location or Directories. 
 
3. Click OK to go to the destination you select and close the box. 

 
NOTE: 
 
¶ You can manually input the path in the Path typing line.  

 

To refresh contents in your screen 

 
¶ In the Explorer window, in the View menu, click Refresh.  
 

NOTE:  
 
¶ You can press F5 to refresh.  

To add items to favorites  

1. In the Explorer window, in the Favorites menu, click Add to Favorites.  
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2. In the pop-up Add to Favorites box, accept the default display name or assign a 
new name.  

3. Click OK to save your favorites and close the box.  

NOTES: 

¶ To delete your favorites, click Organize Favorites in the Favorites menu, and 
then select the item to remove.  

¶ To get a short cut to your favorites, click Go to Favorites in the Favorites menu, 
and then select the item you want to display.  

To map network driver  

1. In the Explorer window, in the Tools menu, click Map Network Driver.  

 

2. In the pop-up Map Network Driver box, you can either manually type the 
Folder path or select the path in the specific Location, Directories panel.  

3. In the Drive panel, select a letter as your drive letter, later you can click it to share 
your network resource. 

4. Click OK to map the drive and close the box.  

NOTES: 



                                                                                                                                                                                 

Page 173 of 231 

¶ To disconnect your network drive, click Disconnect Network Drive... in the 
Tools menu, in the pop-up box select the drive letter that you want to cut, then 
click OK to finish. 

To choose color for your window 

1. In the Explorer window, in the Tools menu, click Colors.  

 

2. From the Item List, click the item you want to change.  

3. From the ForeGround list, click the color you want the item to be.  

4. From the BackGround list, click the color you want the background to be.  

5. Click OK to finish  

NOTES:  

¶ To go back to the original color scheme, click Default. This undoes all the 
changes you have made.  

¶ You can preview the color you selected on the preview tab.  

WAC Explorer Keyboard shortcuts References 

Highlighting Display Commands 

Home Scroll to the start of the screen 

End Scroll to the end of the screen 

PageUp Scroll up one screen 

PageDown Scroll down one screen 
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Up Scroll up one line in screen 

Down Scroll down one line in screen 

Left Move back from every folder and subfolder 

Right Move into every folder and subfolder 

The Shortcut Key Of The Menu 

Ctrl+N To create a new file or folder 

Ctrl+O  To open the specified file 

Ctrl+S To Send the specified file to the specified folder 

Ctrl+P To print the specified contents 

Ctrl+X To cut the specified file or folder 

Ctrl+C To copy the specified file or folder 

Ctrl+V  To paste the specified file or folder 

Ctrl+R To rename the specified file or folder 

Ctrl+R To rename the specified file or folder 

Delete  To delete the specified file or folder 

Esc  To exit the program 

F5  To refresh the screen 

F6 To show the finding result 

F7 
To copy the specified file or folder to another specified 
folder 

F8  
To move the specified file or folder to another specified 
folder 

F10  To change settings 

F11  To change colors 

Editing Commands In Address Bar 

Enter According the specified path to find the specified file or folder 

Delete Delete the character that the cursor is on 

Insert Switch between insert and overwrite modes 

BackSpace Delete the character next to the left of the cursor 

Left Move left one word 

Right Move right one word 

Other Commands 

Tab Move the bright sign to next field 

Enter To get the attributes of the specified file or to enter the subfolder 
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Email Inbox  

WAC Email Inbox is a mail tool that allows users to remotely check the emails in the 
Outlook inbox on the host machine, and even to reply emails or compose new emails too. 
 
NOTE --- To use WAC Inbox, you must have set a mail account in the Outlook. 
Otherwise, and naturally, WAC Inbox is not capable of loading messages. The way is: 
Tool menu > Accounts > Mail > Add > Mail.... For more information, please see Outlook 
help. 
 
How It Works ---- When you invoke WAC Inbox, it will automatically fetch messages 
from your Outlook Inbox, and download them into its own program, then display them in 
front of you.  
 
When Need It ---- At this time you have an Outlook mail account on the server host, 
while you are now working on another local machine and hope to check your Outlook 
mails. At this condition, you can use any client program available on your local machine 
to access the server host, and run WAC Email Inbox to achieve this task. 
 
Main Windows ---- In the Inbox there are mainly four screen windows for you to view, 
reply and compose mails: 
 
¶ Message List Window ---- When you run WAC Inbox, you will see this window, 

and all the downloaded messages are listed here.  
 
¶ Message View Window ---- When you choose View Mail in the Message List 

Window, you will be switched to here. This window is provided for you to read 
the message contents.  

 
¶ Message Edit Window ---- Totally named for creating new mail window and 

replying or forwarding window. If want to compose new mail, choose Creating 
New Mail in the Message List Window, if want to reply or forward mail, choose 
Reply Mail or Forward Mail in the Message View Window.  

 
¶ File Attachment Window ---- Totally named for Attachment List Window 

(ALW) where lists all the attached files and Attachment Detail Window (ADW) 
where presents the detailed attachment contents. Normally when you choose 
View Attachment in the Message View Window, you should enter into the 
Attachment List first, then into the Attachment Detail Window after select an 
item.  
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Using WAC Email Inbox 

To read your mail messages  

To view the mails you need to go to Message View Window after select one in the 
Message List Window. Below shows how-to: 

To use mouse to perform the task 

¶ In Message List Window, click a message you want to view, double click it or 
click Enter in the Prompt Panel. Current window should be shifted to Message 
View Window.  

To use keyboard to perform the task 

¶ In Message List Window, select message you hope to read, and then press Enter. 
Current window should be shifted to Message View Window.  

 
NOTES:  
 
¶ To view file accessories, choose View Attachments. If messages without any 

attachments, you can't see this option in the Prompt Panel.  
 
¶ To browse more mails, choose Next Mail or Previous Mail.  
 
¶ To reply or forward e-mail, choose Reply Mail or Forward Mail.  
 
¶ To quit the view window, choose Exit View.  

To create and send new mails  

To create a new message, you need to go to Message Edit Window. Or if you have 
stored the receiver's address in your Address Box, you can start new mail from there. 
Below shows how-to: 

From the Message List Window  

1. In the Message List Window, choose Create New Mail. Your current window 
should be shifted to Message Edit Window.  

2. In the Recipient, input e-mail address of the receiver.  
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3. In the Subject, input your message title.  
4. In the text typing body, compose your mail contents.  
5. In the Prompt Panel, click Send to issue the mail.  

From the Address Box 

¶ In the Address Box, select the one you want to send mail to in the Recipient box. 
¶ Click Edit Mail, your screen should be switched to the Message Edit Window. 
¶ Then follow the 2-5 steps above.  

 
NOTES: 
 
¶ You can use mouse or keyboard to choose the option to complete the task.  

 
¶ If you want to import text from file, choose Insert File, to insert attached files, 

choose Insert Attachment and beside which is the insertion number. For details, 
please see "Insert items into an e-mail text".  

 
¶ To change cursor location, choose Change Cursor Location. You are not 

allowed to insert files or attachments when the cursor is resting on the header 
place.  

 
¶ After sent a mail, Inbox will pops up an Optional box as below, follow the prompt 

in it to continue editing new mail or to end.  

To reply and forward mail messages 

To reply or forward e-mail you need to be in the Message View Window. Below shows 
how-to: 

To reply e-mail 

1. In the Message View Window, select Reply Mail. 
 
2. In the message reply screen, edit your mail messages if necessary, then choose 

Send to issue your mail.  

To forward e-mil 

1. In the Message View Window, select Forward Mail.  
 
2. In then message forward screen, input the Recipient address, edit your mail 

messages if necessary, and then choose Send to issue your mail.  
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NOTE: 
 
¶ You can use mouse or keyboard to choose the option to complete the task.  

To view and save file attachments 

To view file attachments, you first need to enter into the Attachment List Window 
(ALW for shorted) from the Message View Window, then into the Attachment Detail 
Window. Below shows how-to: 

To View the attachment: 

1. In the Message View Window, choose View Attachment, current screen should 
be shifted into the ALW. 

 
2. In the ALW, select the one you want to read, then double click it, or click Enter 

in the Prompt Panel. Current window should be shifted into Attachment Detail 
Window.  

To save the attached files: 

1. In the ALW, choose Save.  
 
2. In the pop-up Save File box, input the File Name and File Path in the typing 

filed. Or in the Drive, Directories and Existing Files boxes, select a different 
drive, directory or filename to find the destination and locate your file, then click 
OK to finish.  

 
NOTES: 
 
¶ You can use mouse or keyboard to choose the option to complete the task.  
 
¶ Only your attachments are text files, can they be opened in WAC Inbox, other 

special formatting files are not allowed  
 
¶ In the Save File box, what you select in the Drives and Directories boxes is 

mapped into File Path typing field, and in the Existing Files box, into File Name 
typing field.  

 
¶ In the Save File box, if you want to return to parent folder, click the dot sign 

(..),in the Directories, then you can return from a subfolder 
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To insert items into mail messages 

In the Edit Message Window, Inbox allows you to select an option to insert a file or an 
attachment, Inserting items as file or attachments copy the data from the item you 
selected. Below shows how-to: 

I mport text from file 

1. In the Edit Message Window, choose Insert File.  
2. In the pop-up Insert File box, input the File Name and File Path in the typing 

filed. Or in the Drive, Directories and Existing Files boxes, find the text you 
want to insert, then click OK to open the file.  

Insert attachments  

1. In the Message Edit Window, choose Insert Attachment.  
 
2. In the pop-up Insert Attachment box, in the Drive, Directories and Existing 

Files boxes, find the text you want to insert, then click OK to open the file.  
 
NOTES: 
 
¶ You can use mouse or keyboard to choose the option to complete the task.  
 
¶ Only your files are text files, can they be opened in WAC Inbox, other special 

formatting files are not allowed.  
 
¶ In the Insert File (Attachment) box, what you select in the Disc and Directories 

boxes is mapped into File Path typing field, and in the Existing Files box, into 
File Name typing field.  

 
¶ In the Insert File (Attachment) box, if you want to return to parent folder, click 

the dot sign (..),in the Directories, then you can return from a subfolder.  

To insert items into mail messages 

In the Edit Message Window, Inbox allows you to select an option to insert a file or an 
attachment, Inserting items as file or attachments copy the data from the item you 
selected. Below shows how-to: 
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Import text from file 

1. In the Edit Message Window, choose Insert File.  
 
2. In the pop-up Insert File box, input the File Name and File Path in the typing 

filed. Or in the Drive, Directories and Existing Files boxes, find the text you 
want to insert, then click OK to open the file.  

Insert attachments  

1. In the Message Edit Window, choose Insert Attachment.  
 
2. In the pop-up Insert Attachment box, in the Drive, Directories and Existing 

Files boxes, find the text you want to insert, then click OK to open the file.  
 
NOTES: 
 
¶ You can use mouse or keyboard to choose the option to complete the task.  
 
¶ Only your files are text files, can they be opened in WAC Inbox, other special 

formatting files are not allowed.  
 
¶ In the Insert File (Attachment) box, what you select in the Disc and Directories 

boxes is mapped into File Path typing field, and in the Existing Files box, into 
File Name typing field.  

 
¶ In the Insert File (Attachment) box, if you want to return to parent folder, click 

the dot sign (..),in the Directories, then you can return from a subfolder.  

To delete mail messages from the message list 

To delete a mail message, you need to be in the Message List Window. Below shows 
how-to: 
 

1. In the Message List Window, select the one you want to delete.  
 
2. In the Prompt Panel, choose Delete Mail.  

 
3. Click OK to finish when prompted.  

 
NOTES: 
 
¶ You can use mouse or keyboard to choose the option to complete the task 
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¶ If you want to restore the deleted items, you can use the Deleted Items folder in 
Outlook 

To search the particular emails 

To search the mail message, you need to be in the Message List Window. Below shows 
how-to:  
 

1. In the Message List Window, choose Search.  
 
2. In the pop-up Search Box, in the From filed, type the mail address of the person 

you want to look for. And /or in the Subject field, type the title that the message 
represents.] 

 
3. Click OK to display the Search Results as shown below, click Clear to remove 

the contents of the typing fields and retype. 
 

4. In the Search Results box, select an item, click View for message details (in the 
View Message Window), and click Cancel to quit. 

 
5. To display the last time search, click Repeat last search in the Message list 

Window.  
 
NOTES: 
 
¶ You can use mouse or keyboard to choose the option to complete the task  
 
¶ What you type in the typing field should care to the case sensitive.  

 
¶ The search returns items from any name that contains the text or letters you type. 

For example, to find messages sent to "abc@foxitsoftware.com", you can enter 
the full address or the initial letters "abc".  

To change color for your Inbox screen 

Inbox provides you customized color options for screen background, screen contents (text) 
and highlighting display. To set the color, you need to be in the Message List Window. 
Below shows how to add color onto your Inbox screen: 
 

1. In the Message List Window, choose Choose Color in the Prompt Panel. Color 
Box springs up. 

 
2. In the Foreground box, choose color for text, and preview the result in the 

Preview for Foreground and Background tab. 
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3. In the Background box, choose color for screen background, and preview the 

result in the Preview for Foreground and Background tab.  
 

4. In the Highlighting Display box, choose color for the highlights, and preview the 
result in the Preview for Highlighting Display tab. 

 
5. Click OK to save all your color changes and closes the box. Click Cancel to quit 

the window without saving any changes you have made.  
 
NOTES: 
 
¶ Go back to the original color scheme, click Default. This undoes all the changes 

you have made.  
 
¶ All the colors you have changed here apply to all screen windows in WAC Inbox.  
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WAC Phone 

WAC Phone is a text-based instant chat tool that enables you to start a chat dialog with 
someone located at your remote host computer while you are on your local client 
computer.  
 
Two Message Screens ---- As the popular messengers that normally have two message 
screens, WAC Phone also has two designated instant message screen, one for displaying 
the incoming messages, the other for typing the outgoing messages.  
 
WAC Users Only ---- WAC Phone is only available on WAC Server connectivity 
environment, so only WAC users can only phone to chat. 
 

Figure 10 - Screen Snapshot 
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Using WAC Phone 

To release a call to the user 
 
To call a user by Phone, you need to know at least the user's session Id or his login name.  
 
To call from the instant message window 
 
¶ In the Phone instant message window, in the Call space, enter the name of the 

called user or Id.  
 
¶ Click OK to begin calling.  
 

To call from the Search box 
 

1. In the Phone instant message window, click Search  
 
2. In the pop-up Search box, in the User List, select the user you want to call, then 

double click it or click OK to close the box.  
 
3. In the Call space click OK to begin calling.  

 
NOTE: User List displays all the other users who access the host computer via 
WAC server. In addition, a user name identical to yours can not be displayed in the 
user list. Other identical user names are solely displayed one.  

 
To call from the command prompt 
 

1. At the command prompt, type "phone/?". You should get this information:  
 

 
 

2. Then use this command phone <plus username> or phone <plus user's Id> to 
call.  

 
3. Your screen should be shifted to Phone window and waiting for the other use's 

response.  
 

NOTES: 
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¶ If you don't know the other user's name or Id, you can use Session Manager 

or WAC Command Line tool wac who to display the user's connectivity 
elements.  

 
¶ If there is no response to your call around 20 seconds, phone will cancel the 

call automatically.  
 
¶ If there are more than one user happen to use the identical login name, you 

are recommended to call them by their Id, else your calling will be received 
by all the users owning the same.  

 
¶ During a conversation, you can't call another user.  

 

To hang up a call 
 
During a conversation, you may want to stop the chat, you can use Hang Up to cancel 
the call. 
 

1. In the Phone instant message window click Hang Up. 
 
2. In the pop-up Hang Up box, you are prompted either to Hang Up the call without 

saving the contents, or to Save and Hangup including saving both displaying and 
typing contents, or to Continue and return to the Phone.  

 
NOTE: 
 
¶ Hang Up button is available only when the call is established.  

 

To save and clear chat contents 
 
During a conversation, you may want to save your chat contents and clear the screen 
without hanging up your call. If so, you can use Save & Clear under the File menu to 
achieve this.  
 

1. In the File menu, click Save & Clear. 
 
2. In the pop-up Save As box, in the File Name, input the file name, then select a 

folder to put. Or in the Drives, Directories, and Existing Files boxes find the 
destination you want to place the chat contents. 

 
3. Click OK to close the Save As box and continue your chatting.  

 
NOTES: 
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¶ In the Save As box, what you select in the Drives and Directories boxes is 
mapped into Path, and in the Existing Files box, into File Name typing field.  

 
¶ In the Save As box, if you want to return to parent folder, click the dot sign (..),in 

the Directories, then you can return from a subfolder.  
 
¶ Save actions in Phone only adds the current contents to the history files that 

already stored, instead cover or replace them.  
 

To paste text from the remote clipboard 
 
This feature only pastes text from the clipboard of the remote host computer that you 
access to, instead of your local clipboard that temporarily stores what you cut or copied. 
This trait offers you the added benefit of getting easily text from a remote operator just by 
his cutting or copying and your pasting. 
 
¶ To paste the text from the remote clipboard, just click Paste in the Edit menu in 

the Phone instant message window. And the text will be printed into the typing 
are screen.  

 
NOTE: 
 
¶ Be aware of that you are working on the remote host computer after the 

connectivity via WAC Server.  
 

To exit Phone program 
 

1. In the Phone instant message window, click Quit.  
 
2. In the pop-up Exit box, you are prompted to either Save and Exit including 

saving both displaying and typing contents, to anyway Exit the Phone without 
saving, or to Return to the instant message window and continue.  

 
NOTE: 
 
¶ To see how to save, please refer to "Saving and clearing chat contents". 
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Session Manager  

Session Manager (SesMan) is a text-based application that is used for managing all 
authorized logon user's sessions. In WAC Server, each logged on connection is call a 
"session". 
 
When you start SesMan, you will see a list of all current sessions, when there are new 
sessions and session terminated later, the list will automatically updated with highlighting 
flicker. 
 
In SesMan, you can view all the current connected users and their connection details, and 
if necessary you can even send or broadcast messages to them, watch their screen 
activities, or abort their sessions. Of course you have to be an Administrator or one 
member of his group to complete these tasks.  
 
Note: It should be noted that Session Manager is only for users who are using WAC 
Server. 
 

Figure 10 - Screen Snapshot 
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Using Session Manager 

To describe session header  

 
 
¶ S_ID (session id): Displays a numerical identifier that uniquely distinguishes a 

user's session from others.  
 
¶ User Name: Displays the user's login name. 

 
¶ Port Type: Indicates the protocol type that you use to connect with the remote 

machine.  
 
¶ Address: Displays the IP address and connect-out port number of the client 

machine.  
 
¶ Term: Specifies the client type that you use to start a connection and establish 

sessions.  
 
¶ Start Time: The initial time at which the user logon.  
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To send message to the specific user 

1. In the SesMan window, select a user you want to send a message, and then 
double click it or choose Send Message to....  

 

 
 

2. In the pop-up Send Message to.... box, choose the way you want to message.  
 
3. Choose Send to session, message will be post to the exclusive one with his 

unique Id.  
 

4. Choose Send to user, message will be post to all whose logon name same to the 
one you select.  

 
5. If your logon name is also same to the one you select, you will receive your 

message too.  
 

6. In Message typing line, input the text.  
 

7. Click Send to send and close the box.  
 
NOTE: 
 
¶ You can press any key to clear the received message(s).  

To Broadcasting message to all users 

1. In the SesMan window, select a user you want to message.  
 
2. Choose System Broadcast.  
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3. In the pop-up System Broadcast box, in the Message typing line input text, then 
click OK to send and close the box.  

 
NOTE: 
 
¶ All users including self will receive the message(s) sent by System Broadcast.  
 
¶ You can press any key to clear the received message(s). 

To watch other user's session screen  

¶ In the SesMan window, select a user you want to watch.  
 
¶ Choose Watch, your current screen session should be switched to user's current 

screen session. 
 
¶ Press Enter to quit the watch session and return to your current session.  

 
NOTE: 
 
¶ On the watch status, your current session shares every input and output with the 

session you are monitoring. However you are not able to take any actions on this 
session.  

 

To control other user's session screen  

¶ In the SesMan window, select a user you want to watch.  
 
¶ Choose Control, your current screen session should be switched to user's current 

screen session. 
 
¶ Press Enter to quit the watch session and return to your current session.  

 
NOTE: 
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¶ On the control status, you and the user are able to watch the session with 
interactive input. 

To take over other user's session screen  

¶ In the SesMan window, select a user you want to watch.  
 
¶ Choose Takeover, your current screen session should be switched to user's 

current screen session. 
 
¶ Press Enter to quit the watch session and return to your current session.  

 
NOTE: 
 
¶  The takeover status is just opposite to the watch status. That is you can take any 

actions on that session, while the user can do nothing except watching.   

To reconnect to other user's session screen  

¶ In the SesMan window, select a user you want to watch.  
 
¶ Choose Reconnect, your current session should be at once reconnected to the 

user’ s current session.  
 
¶ Press Enter to quit the watch session and return to your current session.  

 
NOTE: 
 
¶ Reconnecting to a user’ s session is actually to enforce this user’ s session turn into 

your session, and synchronously terminate this session at the user side and your 
current session. 

To abort other user's session 

1. In the SesMan window, select a user you want to abort.  
 
2. Choose Abort.  
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3. Click Yes to halt the session when prompted.  
 

NOTE: 
 
¶ To abort a user's session may result in the data loss of this user 
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Process Viewer  

Process Viewer (ProcView) provides information about processes currently running on 
your host machine. For example, you can display information on Image Name, CPU, 
Memory, PID (process identifier) and CUP Time.  
 
ProcView refreshes itself periodically, and in which you can quickly see the programs 
that are running and kill programs. To achieve this task, you have to be an administrator 
or one member of his group. 
 
In ProcView window there are shortcuts that accessible by the keyboard and mouse in 
the bottom area (we called it Prompt Panel). You can press the highlight key or use 
mouse-click on the Prompt Panel to perform the task. 
 

Figure 10 - Screen Snapshot 
 

 
 

Using Process Viewer 

To describe process header  

 
 
¶ Image Name: The executable program that created the process as displayed in the 

column heading of processes tab. 
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¶ PID (Process identifier): A numerical identifier that uniquely distinguishes a 

process while it runs. 
 
¶ CPU: In Process Viewer, the percentage of time that a process used the CPU 

since the last update.  
 
¶ CPU Time: In Process Viewer, the total processor time, in seconds, used by a 

process since it started. 
 
¶ Memory: In Process Viewer, the current working set of a process, in kilobytes. 

The current working set is the number of pages currently resident in memory.  

To sort the list of processes 

¶ On the Processes tab, click the column heading you want to sort by.  
 
¶ To reverse the sort order, click the column heading a second time.  

To update the processes data 

¶ Choose Refresh to manually update your process data now.  
 
¶ Choose Auto Refresh to stop updating the process data automatically, type it 

again to recover.  
 

NOTES: 
 
¶ The default is Auto Refresh at the interval of two seconds.  
 
¶ On the status of UN-Auto Refresh, the capital letter "A" is dimmed and your 

session stops flittering.  

To end a process 

1. In the image column, select an Image Name that you want to stop.  
 
2. Press "Y" to halt the process when the prompt appears in the Prompt Panel.  
 

NOTES: 
 
¶ To end a process, you must log on as an Administrator or as a member of the 

Administrator's group.  
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¶ Be careful when ending a process. If you end an application, you will lose some 

unsaved data. If you end a system service, some part of the system may not 
function properly.  

 
¶ You are not allowed to end the system applications.  
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Service Manager  

Service Manager (SvcMan) is a Windows management, it allows you to view and 
manage all your windows services on your remote host machine and can even on another 
machine by connecting to it.  
 
Using SvcMan, you can start, stop, pause, or resume services on remote and local 
machines on only one screen, and can also create custom display names and descriptions 
for services for easy identification, set up recovery actions if a service fails. 

 

Figure 10 - Screen Snapshot 
 

 
 

Using Process Viewer 

To describe session headers 

¶ No.: Shows the column account that the services appear in the session.  
 

¶ Name: Display the name of the services in the column.  
 

¶ State: Shows the status of a service.  
¶ Started: The service is running.  
¶ Paused: The service is intermitted.  
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¶ Open Space: The status when the service is stopped.  
 

¶ Startup Type: Shows the start type for a service.  
 

¶ Auto: Specifies that the service should run when the system starts.  
¶ Manual: Specifies that a user can start the service. Services with Manual 

startup do not start automatically when the system starts.  

¶ Disabled: Prevents the service from being started by the system or a 
user.  

To start, stop, pause, resume, restart, or delete a service 

1. In SvcMan window, type the first letter of the service name several times to find 
the service you want.  

 
2. Then choose Start, Stop, Pause, Resume, or Restart or Delete.  

 
3. Click OK when prompted.  
 

NOTES: 
 
¶ You can use the mouse-click or use the keyboard shortcuts to choose the option to 

complete the task. In the Properties tab, you can use Tab key to change the cursor 
location. 

 
¶ When you pause the Server service, only users in the computer's Administrators 

and Server Operators groups will be able to make new connections to the 
computer.  

 
¶ When you stop the Server service, all users who are connected over the network 

to the computer will be disconnected. It is a good idea to warn connected users 
before stopping the Server service. 

 
¶ If you stop a Server service, the affected computer can no longer be administered 

remotely. You must start the Server service locally.  
 
¶ To stop and immediately restart a service, click the service and then click Restart. 

This stops and restarts the service and any dependent services.  
 
¶ You can't delete a running service. 

To change the startup type  

1. In SvcMan window, find the service you want to change, and choose Properties.  
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2. On the pop-up Properties-General tab, under Startup type, click Automatic, 
Manual, or Disabled.  

 
NOTES: 
 
¶ You can use the mouse-click or use the keyboard shortcuts to choose the option to 

complete the task. In the Properties tab, you can use Tab key to change the 
cursor location.  

To view service dependencies 

1. In the SvcMan window, select the service you want to view, and click Properties.  
 

2. In the pop-up Properties - General tab, click the Dependencies tab.  
 

 
 
NOTES: 
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¶ You can use the mouse-click or use the keyboard shortcuts to choose the option to 
complete the task. In the Properties tab, you can use Tab key to change the 
cursor location.  

 
¶ The top list on the Dependencies tab identifies the other services that must be 

running for the selected service to function.  
 
¶ The bottom list on the Dependencies tab identifies the services that require the 

selected service to be running so they can function. 

To create custom names and descriptions for the services 

1. In SvcMan window, choose Properties.  
 

 
 

2. In the pop-up Properties --- General tab, create Display Name and Descriptions 
for the service you want.  

 
3. Click OK to finish and close the box.  
 

NOTES: 
 
¶ You can use the mouse-click or use the keyboard shortcuts to choose the option to 

complete the task. In the Properties tab, you can use Tab key to change the 
cursor location 

To set up recovery actions if a service fails 

1. In SvcMan window, choose Properties.  
 
2. In the pop-up Properties tab, click Recovery.  
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3. In the Recovery tab, click the actions you want in First Failure, Second Failure 
and Subsequent Failures.  

 
NOTES: 
 
¶ Recovery actions are only available on Windows 2000 and later.  
 
¶ If you select Reboot the Computer, you can specify how long to wait before 

restarting the computer by clicking Reboot Computer Options. You can also 
create a message to remote users before restarts by clicking Restart Computer 
Option.  

To log on to a remote computer  

1. In the File menu, click Connect.  
 

 
 

2. In the pop-up Connect to... tab, choose the Remote computer, and in the text 
typing line, input the IP address or name of the computer you want to connect to.  

 
3. Click to connect.  

 
NOTES: 
 
¶ You can use the mouse-click or use the keyboard shortcuts to choose the option to 

complete the task.  
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¶ Currently using SvcMan to remotely logon requires the identical password and 

username on both client machine and remote host machine.  
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Event Viewer 

WAC Event Viewer (EventView) allows you to take a close look at events recorded in 
the Application, Security, and System logs, and even on another machine by connecting 
to it. 
 
WAC EventView on Windows2000/XP/NT records events in three kinds of logs such as 
Application Log, System Log, and Security Log, and five types of events such as Error, 
Warning, Information, Success Audit, Failure Audit. 
 
Using the event logs in EventView, you can gather information about hardware, software, 
and system problems, and you can monitor Windows 2000/XP/NT security events. 
 
The event log service starts automatically when you connect to the Windows 
2000/XP/NT machine. You can view application and system logs. Only Administrators 
can gain access to security logs. 
 
By default, security logging is turned off. If you want to enable it, you can use Group 
Policy in Microsoft Windows to enable security logging.  
 

Figure 10 - Screen Snapshot 
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Using Event Viewer 

To refresh an event log 

1. In the EventLog menu, select the log you want to refresh.  
 
2. In the EventLog menu, click Refresh.  

 
NOTES: 
 
¶ You must be logged on as an Administrator or as a member of the Administrator's 

group to refresh the security log.  
 
¶ When you open a log, Event Viewer displays the current information for the log. 

While you view the log, the information is not updated unless you refresh it. If 
you switch to another log and then return to the first log, the first log is 
automatically refreshed.  

To view more details about an event  

1. In the EventLog, select the log you want to view.  
 
2. In the EventView window, double click the event to display the Event 

Properties.  
 

 
 
NOTES: 
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¶ Not all events generate binary data. Binary data can be interpreted by an 
experienced programmer or a support technician familiar with the source 
application.  

To view more details about an event  

1. In the EventLog, select the log you want to view.  
 
2. In the EventView window, double click the event to display the Event 

Properties.  
 

 
 
NOTES: 
 
¶ Not all events generate binary data. Binary data can be interpreted by an 

experienced programmer or a support technician familiar with the source 
application.  

To clear an event log 

¶ In the Eventlog menu, select the log you want to clear.  
 
¶ In the Operator menu, click Clear all events. 
 
¶ When prompted, click Yes to save the log before clearing it, click No to 

permanently discard the current event records and start recording new events, 
click Cancel to call off the actions  

 
NOTES: 
 
¶ You must be logged on as an Administrator or a member of the Administrators 

group to clear an event log.  
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¶ After you clear a log, only new events will appear in the log.  
 
¶ If you do not select Overwrite events as needed (clear log automatically without 

archiving) in the Log Properties tab of an active log, you must periodically clear 
the log either when the log reaches a certain size or when a message notifies you 
that the log is full.  

 
¶ You cannot clear archived logs; instead, delete the archived log file.  

To archive an event log 

1. In the Eventlog menu, select the log you want to archive.  
 
2. In the Operator menu, click Save log file as.  
 

 
 

3. In the pop-up Save As box, choose the Driver and Directories.  
 
4. In the typing line, input the File Name for the archived log file.  
 
5. Click OK to save.  

 
NOTES: 
 
¶ If you archive a log in log-file format, you can reopen it in Event Viewer. Logs 

saved as event log files (*.evt) retain the binary data for each event recorded.  
 
¶ If you archive a log in text or comma-delimited format (*.txt and *.csv, 

respectively), you can reopen the log in other programs such as word processing 
or spreadsheet programs. Logs saved in text or comma-delimited format do not 
retain the binary data.  

 
¶ When you archive a log file, the entire log is saved.  
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¶ The sort order is not retained when logs are saved.  

 
¶ Archiving has no effect on the current contents of the active log. 

To open an archived event log 

1. In the Operator menu, click Open log file.  
 

 
 

2. In the pop-up Open File box, search for Driver or Directories that contains the 
document you want to open.  

 
3. Beside Log type, select the type of log to be opened  
 

NOTES: 
 
¶ You can view an archived file in Event Viewer only if the log is saved in log file 

format (*.evt).  
 
¶ You cannot click Refresh or Clear all events to update the display or to clear an 

archived log.  
 
¶ To remove an archived log file from your system, delete the file in WAC 

Explorer 

To export event log list 

1. In the EventLog menu, select a log you want to export. 
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2. In the Operator menu, click Export list.  
 

 
 

3. In the pop-up Save as box, select the Drivers or Directories for the File Path, 
and in the text typing line, input the File Name for the log list. 

 
4. Click OK to export and close the box.  
 
 

NOTES: 
 

1. When you export an event log list, the entire log is saved including the whole sort 
order (structure).  

 
2. Exporting list has no effect on the current contents of the active log.  

To specify a sort order in an event log 

1. In Eventlog menu, select the log you want to sort.  
 

2. Click the column heading you want to sort by. 
 

3. Click the column heading a second time to reverse the sort order  
 
NOTES: 
 
¶ When a log is archived, the sort order is not saved 

To set event logging options 

1. In the Eventlog, click the log you want to set options for.  
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2. In the Operator menu, click Properties.  
 

 
 

3. In the pop-up Log Properties tab, specify the options you want.  
 

NOTES: 
 
¶ You must be logged on as Administrator or as a member of the Administrators 

group in order to complete this procedure.  
 
¶ In the Maximum log size, set the maximal size for a log. When your The default 

size is 512 KB.  
 
¶ If you do not want to archive this log, click Overwrite events as needed.  
¶ To restore the default settings, click Restore Defaults.  

To use the security log 

By default, security logging is turned off. You can use Group Policy in Microsoft 
Windows to enable security logging. The way is:  
 
Local Computer Policy > Computer configuration > Windows Settings > Security 
Settings > Local Policies > Audit Policy. For more information, please see Windows help. 
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Registry Editor  

WAC Registry Editor (RegEdit) is an advanced tool for viewing settings in your system 
registry, which contains information about how your computer runs. Moreover it 
functions as Windows Registry Editor, and so you don't need to renewedly learn to how 
to use it.  
 
WAC RegEdit acts as a database repository, stores information about a computer's 
configuration. And it is organized hierarchically as a tree and is made up of keys and 
their subkeys, and value entries.  
 

Figure 10 - Screen Snapshot 
 

 
 

Using Registry Editor 

To describe key and value 

Key -- In Registry Editor, a folder that appears in the left pane of the Registry Editor 
window. A key can contain subkeys and value entries. For example, Environment is a 
key of HKEY_CURRENT_USER. 
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Predefined Key -- A key that represents one of the main divisions of the registry. Each 
predefined key is displayed in a separate Registry Editor window, with the key name 
appearing in the window's title bar. For example, HKEY_CLASSES_ROOT is a 
predefined key.  
 
Value -- The string of data that appears in the right pane of a registry window and that 
defines the value of the currently selected key. A value entry has three parts: name, data 
type (i.e.: string, dword, binary), and the data (value itself). 

To Change keys and values 

Editing the registry incorrectly may severely damage your system. So before making 
changes to the registry, you should back up any valued data on the computer. 

To find a string, value or key 

1. In the Edit menu, click Find.  
 

 
 

2. In pop-up Find box, in Find what, type the string, value, or key you want to find.  
 
3. Select the Keys, Values, Data, and Match whole string only check boxes to 

match the type of search you want, and then click Find Next.  
 
NOTES: 
 
¶ You can speed up the search by looking through only one type of information; for 

example, if you know that you are looking for a value entry, you can clear the 
Keys and Data check boxes, so that you will not search through those objects.  

 
¶ To repeat the search, press F3.  
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To add a key 

1. Select the registry list to which you want to add a new key, and then click the key 
above the location you want for the new key.  

 
2. In the Edit menu, click New.  

 

 
 

3. In the pop-up New box, check Keys. Type a Name for the new key, and then 
click OK.  

To add a value 

1. Click the registry key or value entry where you want to add the new value.  
 
2. In the Edit menu, click New.  
 

 
 

3. In the pop-up New box, select the type of value you want to add: String Value, 
Binary Value, or DWORD Value.  

 
4. Type a Name for the new value, then click OK.  
 

NOTE: 
 
¶ When you add a value, the value name and data type are saved with a default 

value. For instructions on how to modify the default value, see change a value.  
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To add a registry key to favorites 

1. Select the registry key you want to add to Favorites.  
 
2. In the Favorites menu, click Add to Favorites.  
 

 
 

3. In the pop-up Add to Favorites dialog box, accept the default registry key name 
or type a new one.  
 
The registry key is added to the Favorites list. You can then return to this list by 
simply selecting Go to Favorites from the Favorites menu.  

 
NOTES: 
 
¶ You can create a list of favorite for frequently visited registry keys.  
 
¶ To remove a registry key from the Favorites list, in the Favorites menu, click 

Remove Favorite, and you can select one or more registry keys to remove from 
the Favorites list.  

To change a value 

1. In the right pane of RegEdit widow, select the value you want to change.  
 
2. In the Edit menu, click Modify or double click it.  

 
3. In the pop-up box, in Value data, type the new data for the value. 

 
4. Click OK to finish and close the box..  

To delete a key or value 

1. Click the registry key or value entry you want to delete.  
 
2. In the Edit menu, click Delete.  
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3. Click OK when prompted.  
 

NOTE: 
 
¶ You can delete keys and values from your registry. However, you cannot delete a 

predefined key (such as HKEY_CURRENT_USER) or change the name of a 
predefined key.  

To rename a key or value 

1. Click the registry key (left pane) or value entry (right pane) you want to rename. 
 
2. In the Edit menu, click Rename.  
 

 
 

3. In the pop-up Rename box, in the text typing line, input the New Name.  
 
4. Click OK to finish and close the box.  

 
NOTE: 
 
¶ You cannot rename the root keys or the default value of a key.  

To copy a registry key name 

1. In the registry tree (left pane), click a registry key that you want to copy.  
 
2. In the Edit menu, click Copy Key Name.  

 
3. Paste the name of the registry key into another program or document.  

To import and export  the registry file 

To import the registry 

1. In the Registry menu, click Import Registry File.  
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2. In the pop-up Import Registry File box, search for the Drives, Directories and 
Files that contains the file you want to import.  

 
3. Click OK to finish and close the box.  
 

NOTE: 
 
¶ The file name you select will be map into the File Name line.  

To export the registry to a text file 

1. In the Registry menu, click Export Registry File.  
 

 
 

2. In the pop-up Export Registry File box, search for Drives and Directories that 
you wan to place the file, in the text typing line, enter File Name for the registry 
file.  

 
3. Click OK to finish a close the box. 
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NOTES: 
 
¶ You can use any text editor to work with the registry files you create by exporting. 

Registry files are saved with ".reg" extensions.  
 
¶ Here only export the selected branch from the registry tree.  
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User Manager  

WAC User Manager (UserMan) is a text-based tool you can use to manage users and 
groups on your remote host machine running Windows 2000. It functions much like the 
graphic Microsoft Local users and Groups. 
 
Using WAC UserMan you can remotely create and modify user and group accounts on 
your windows system. Of course, you must be an Administrator or a member of 
Administrators group.  
 
Users display the two built-in user accounts, Administrator and Guest, as well as any 
user accounts you create. 
 
Groups display all built-in groups, Administrators, Backup Operators, Power Users, 
Users, Guests, and Replicator, as well as any group accounts you create.  
 

Figure 10 - Screen Snapshot 
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Using User Manager 

Create and modify user accounts 

To create a new user account 

1. In the UserMan window, in the Menu bar, click Operation, and click User List.  
 
2. In the Menu bar, click User, click New User.  
 

 
 

3. In the pop-up New User dialog box, enter the appropriate information for the new 
user.  

 
4. Click OK to create the new user in the User List and close the dialog box.  
 

NOTES: 
 
¶ The password for the new user must be changed at next logon.  
 
¶ A user name cannot be identical to any other user or group name on the computer 

being administered. It can contain up to 20 uppercase or lowercase characters 
except for " / \ [ ] : ; | = , + * ? < >. And a user name cannot consist solely of 
periods (.) or spaces. 

 
¶ In Password and Confirm, you can type a password containing up to 127 

characters. If you fail to logon, try change the password and use no more that 14 
characters. 

 
¶ You should not add a new user to the Administrators group unless the user will 

perform only administrative tasks.  
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To change a user password 

1. In the UserMan window, in the Menu bar, click Operation, and click User List.  
 
2. In the Menu bar, click User, and click Set Password.  
 

 
 

3. In the pop-up Change User Password dialog box, enter the old and new 
password and confirm it.  

 
4. Click OK to finish and close the dialog box. 

To rename a user account 

1. In the UserMan window, in the Menu bar, click Operation, and click User List.  
 
2. In the Menu bar, click User, and click Rename.  
 

 
 

3. In the pop-up Rename dialog box, enter the new name.  
 
4. Click OK to change and close the dialog box.  

 
NOTES: 
 
¶ A user name cannot be identical to any other user or group name of the computer 

being administered. It can contain up to 20 uppercase or lowercase characters 
except for " / \ [ ] : ; | = , + * ? < >. And a user name cannot consist solely of 
periods (.) or spaces 
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To delete a user account 

1. In the UserMan window, in the Menu bar, click Operation, and click User List. 
 
2. In the Menu bar, click User, and click Delete. 

 
3. Click OK when a confirmation message appears.  

 
NOTES: 
 
¶ A deleted user account cannot be recovered.  
 
¶ The built-in Administrator and Guest accounts cannot be deleted 

To assign a logon script and folder path to a user profile 

1. In the UserMan window, in the Menu bar, click Operation, and click User List.  
 
2. In the Menu bar, click User, and then click Properties.  
 

 
 

3. In the pop-up User Properties dialog box, type the file name of the script in 
Logon Script, and type the file path in the Local Path.  

 
4. Click OK to finish and close the dialog box.  

 
NOTES: 
 
¶ Logon scripts are files that can be assigned to user accounts. Typically a batch file, 

a logon script runs automatically every time the user logs on. It can be used to 
configure a user's working environment at every logon, and it allows an 
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administrator to influence a user's environment without managing all aspects of it. 
A logon script can be assigned to one or more user accounts.  

 
¶ The file path you provided will be regarded as the user's home directory.  

 

Create and modify user groups 

To create a new group 

1. In the UserMan window, in the Menu bar, click Operation, and click Group 
List.  

 
2. In the Menu bar, click Group, and click New Group.  
 

 
 
3. In the pop-up New Group dialog box, enter the appropriate information for the 

new group.  
 
4. Click OK to finish and close the dialog box.  

 
NOTE: 
 
¶ A local group name cannot be identical to any other group or user name on the 

computer being administered. It can contain up to 256 uppercase or lowercase 
characters except for " / \ [ ] : ; | = , + * ? < > ". And a group name cannot consist 
solely of periods (.) or spaces. 

To add a user to a group 

1. In the UserMan window, in the Menu bar, click Operation, and click Group 
List.  

 
2. In the Menu bar, click Group, and click Properties.  
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3. In the Group Properties dialog box that appears, click Add.  
 

 
 

4. In the pop-up Choose Users dialog box, type the names of the users or groups 
you want to add in the lower typing field, or select users or groups in the top box 
and double click them, and then click OK.  

 
5. When you have added all the users you want, click OK in the Group Properties 

dialog box.  
 
NOTES: 
 
¶ To remove a user from a group, select the user in Members in the Group 

Properties dialog box, and then click Remove.  
 
¶ You can also use User Properties to add or remove a user to or from a group. 

 
¶ You should not add a new user to the Administrators group unless the user will 

perform only administrative tasks.  
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¶ Only a member of the Administrators group can add a user to the Administrators, 
Backup Operators, or Replicators group.  

To rename a group 

1. In the UserMan window, in the Menu bar, click Operation, and click Group 
List.  

 
2. In the Menu bar, click Group, and click Rename.  
 

 
 

3. In the pop-up Rename dialog box, enter the new name for the group.  
 
4. Click OK the finish and close the dialog box.  

 
NOTES: 
 
¶ The group name cannot be identical to any other user or group name of the 

computer being administered. It can contain up to 20 uppercase or lowercase 
characters except " / \ [ ] : ; | = , + * ? < > ". And the group name cannot consist 
solely of periods (.) or spaces 

To delete a group 

1. In the UserMan window, in the Menu bar, click Operation, and click Group 
List. 

 
2. In the Menu bar, click Group, and click Delete. 
 
3. Click OK when a confirmation message appears.  

 
NOTES: 
 
¶ A deleted group cannot be recovered.  

 
¶ The built-in groups cannot be deleted.  

 



                                                                                                                                                                                 

Page 223 of 231 

¶ Deleting a group removes only the group; it does not delete the user accounts that 
are members of that group.  
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System Information  

Currently using WAC System Information (SysInfo), you can view your system 
information and hardware devices installed on your remote host computer. In the coming 
up enhanced version, besides viewing, you are able to configure the properties and 
settings of any devices. 
 

Figure 10 - Screen Snapshot 
 
 

 
 

Using System Information 

To view system information 

1. In the SysInfo window, click File.  
 
2. In the drop list menu, click System Information.  

 
NOTES: 
 
¶ System: Displays which version of Windows 2000 is installed on your computer.  
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¶ Registered to: Specifies registration information for this copy of Windows 2000. 
This information was entered during Windows 2000 Setup.  

 
¶ Computer: Specifies the type of processor and the total physical memory of your 

computer.  
 
¶ Complete Computer Name: Specifies the name of the computer that you are 

connecting to.  

To view devices list 

1. In the SysInfo window, click File.  
 
2. In the drop list menu, click Device List.  

 
NOTE: 
 
¶ Currently, you can not view or change the device properties.  
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Appendixes 
 

Appendix A: Program License Agreement 

FOR FOXIT WINDOWS ACCESS (WAC) SERVER SOFTWARE PRODUCT 
 

FOXIT SOFTWARE COMPANY LICENSES THIS WAC SERVER SOFTWARE 
PRODUCT TO YOU SUBJECT TO THE TERMS CONTAINED IN THIS END USER 
LICENSE AGREEMENT ("EULA"). READ THE TERMS OF THIS EULA 
CAREFULLY. BY INSTALLING, COPYING OR OTHERWISE USING THE 
SOFTWARE (AS DEFINED BELOW), YOU AGREE TO BE BOUND BY THE 
TERMS OF THIS EULA. IF YOU DO NOT AGREE TO THE TERMS OF THIS EULA, 
DO NOT INSTALL, COPY OR USE THE SOFTWARE.  
 

NOTICE TO CUSTOMER 
If you do not agree to the terms of this EULA, do not install, or use this software. This 
EULA is a contract between you (either an individual or an entity) and Foxit Software 
Company which governs your use of this Foxit software product that accompanies this 
EULA and related software components, which may include the associated executable 
programs, explanatory materials and the supporting documentation.  
 

DEFINITIONS 
This WAC Server software package is composed of a proprietary WAC Server software 
product, proprietary WAC Toolkit applications (the “ remote console applications” ) and 
proprietary WAC free client programs (the “ WAC Client Software” ). In this EULA, the 
WAC Server Software, the remote console applications, the WAC Client Software, and 
the associated executable programs explanatory materials, and the supporting 
documentation are collectively referred to as the "Software." 
 
A ” Server”  means a single physical computer wholly owned, rented or leased by a single 
individual or entity on which one or more applications load and execute SOFTWARE in 
the memory space of that computer so that one or more users may access it.   
 
"Free" means that no fee is charged for the item itself, though there may be fees involved 
in handling the item. It also means that recipients of the item may redistribute it under the 
same conditions that they received it. 
 

WARNING FOR EVALUATION LICENSEES 
The Software can be installed with a no-cost Evaluation Software License Key. 
Evaluation Software License Keys have an expiration date ("Expiration Date"). If you 
install the Software with an Evaluation Software License Key: (i) you may use the 
Software until the Expiration Date only to evaluate the suitability of the Software for 
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licensing on a for-fee basis; (ii) THE SOFTWARE IS PROVIDED TO YOU "AS IS" 
WITHOUT WARRANTY OF ANY KIND, WHETHER EXPRESS, IMPLIED, 
STATUTORY, OR OTHERWISE. FOXIT COMPANY BEARS NO LIABILITY FOR 
ANY DAMAGES RESULTING FROM USE (OR ATTEMPTED USE) OF THE 
SOFTWARE THROUGH AND AFTER THE EXPIRATION DATE, AND HAS NO 
DUTY TO PROVIDE SUPPORT TO YOU. 
 

LICENCE GRANT  
The Software is licensed, not sold. Subject to the terms and limitations of this EULA, 
Foxit hereby grants you a nonexclusive, nontransferable license, without rights to 
sublicense, to (i) use the Software License Key to activate the Software; (ii) install or 
have installed one copy of the Server Software (in object code form only) on a single 
Server;(iii) use and reproduce the Remote Console Applications (in object code form 
only) for installation and operation on an unlimited number of your own internal 
computers or terminals solely for the purpose of accessing the Server on which the WAC 
Server Software is installed; (iv) internally use and reproduce the WAC Client Software 
to create programs that interface with the WAC Server to manage the Server on which 
the WAC Server Software is installed;(v) use the documentation accompanying the 
Software in connection with permitted uses of the Software.   

 
LICENSE LIMITATIONS 
You may not copy the Software except for a reasonable number of machine-readable 
copies of the software for backup or archival purposes and except as expressly permitted 
in the License Grant section above. You may not remove any titles, trademarks or trade 
names, copyright notices, legends, or other proprietary markings on the Software. You 
are not granted any rights to any trademarks or service marks of Foxit. Foxit retains all 
rights not expressly granted to you. 
 

PROPRIETARY RIGHTS RESERVED BY FOXIT 
Foxit retains all right, title, and interest in and to the Software and the Software License 
Key and in all related copyrights, trade secrets, patents, trademarks, and any other 
intellectual and industrial property and proprietary rights, including registrations, 
applications, renewals, and extensions of such rights. 
 

RESTRICTIONS 
You may not (i) sell, lease, license, sublicense, distribute or otherwise transfer in whole 
or in part the Software, the Software License Key or to another party; (ii) provide, 
disclose, divulge or make available to, or permit use of the Software in whole or in part 
by, any third party without Foxit’ s prior written consent; (iii) decompile, disassemble, 
reverse engineer, or otherwise attempt to derive source code from the Software, in whole 
or in part; (iv) modify or create derivative works based upon the Software; or (v) use the 
Software on a service bureau or hosting basis to provide Remote Access Services 
connecting your customers to an operating system. 
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TERMINATION 
Foxit may terminate this EULA if you fail to comply with any term of this EULA. In the 
event of termination, you must destroy all copies of the Software and Software License 
Key. In addition you must remove all copies of the Software from the Server and all 
computers and terminals on which it is installed. 
 

GOVERNING LAW AND GENERAL PROVISIONS 
This EULA will be governed by the laws of the State of California, U.S.A., excluding the 
application of its conflicts of law rules. This EULA will not be governed by the United 
Nations Convention on Contracts for the International Sale of Goods, the application of 
which is expressly excluded. If any part of this EULA is found void and unenforceable, it 
will not affect the validity of the balance of the EULA, which shall remain valid and 
enforceable according to its terms. You agree that the Software will not be shipped, 
transferred or exported into any country or used in any manner prohibited by the United 
States Export Administration Act or any other export laws, restrictions or regulations. 
This EULA shall automatically terminate upon failure by you to comply with its terms. 
This Agreement may only be modified in writing signed by an authorized officer of Foxit 
Software Company. 
 

NO WARRANTY 
The SOFTWARE is being delivered to you AS IS and Foxit makes no warranty as to its 
use or performance. FOXIT AND ITS SUPPLIERS DO NOT AND CANNOT 
WARRANT THE PERFORMANCE OR RESULTS YOU MAY OBTAIN BY 
USING THE SOFTWARE OR DOCUMENTATION. FOXIT AND ITS 
SUPPLIERS MAKE NO WARRANTIES, EXPRESS OR IMPLIED, AS TO 
NONINFRINGEMENT OF THIRD PARTY RIGHTS, MERCHANTABILITY, OR 
FITNESS FOR ANY PARTICULAR PURPOSE. IN NO EVENT WILL FOXIT OR 
ITS SUPPLIERS BE LIABLE TO YOU FOR ANY CONSEQUENTIAL, 
INCIDENTAL OR SPECIAL DAMAGES, INCLUDING ANY LOST PROFITS 
OR LOST SAVINGS, EVEN IF A FOXIT REPRESENTATIVE HAS BEEN 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, OR FOR ANY CLAIM 
BY ANY THIRD PARTY. Some states or jurisdictions do not allow the exclusion or 
limitation of incidental, consequential or special damages, or the exclusion of implied 
warranties or limitations on how long an implied warranty may last, so the above 
limitations may not apply to you. 
 

LIMITATION OF LIABILITY 
IN NO EVENT WILL FOXIT BE LIABLE FOR ANY LOST PROFITS OR BUSINESS 
OPPORTUNITIES, LOSS OF USE, BUSINESS INTERRUPTION, LOSS OF DATA, 
OR ANY OTHER INDIRECT, SPECIAL, INCIDENTAL, OR CONSE- QUENTIAL 
DAMAGES UNDER ANY THEORY OF LIABILITY, WHETHER BASED IN 
CONTRACT, TORT, NEGLIGENCE, PRODUCT LIABILITY, OR OTHERWISE. 
THIS LIMITATION SHALL APPLY REGARDLESS OF WHETHER FOXIT HAS 
BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. FOXIT'S 
LIABILITY UNDER THIS EULA WILL NOT, IN ANY EVENT, EXCEED THE 
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LICENSE FEES, IF ANY, PAID BY YOU TO FOXIT FOR THE SOFTWARE 
LICENSED BY YOU UNDER THIS EULA. 
 

CONTACT INFORMATION 
 
If you have any questions about this EULA, or if you want to contact Foxit for any reason, 
please direct E-mail to: sales@foxitsoftware.com  
 
Foxit is a trademark of Foxit Software Company. 

Appendix B: Code Sequences 

Here is a list of code sequences recognized by WAC Server (equivalents of VT terminal 
keys are also listed).  
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Where "ESC" means the character with ASCII code of 27 (0x1B). Spaces in the above 
sequences are for illustration only and shouldn't be in the actual sequence sent to server.  

If you want to send an ALT key combination, you need to send the code CTRL-A 
(ASCII code 1) prior the key code. For example, if you want to send ALT-C, you should 
send CTRL-A C. If you just want to send CTRL-A itself, use CTRL-A instead. 

Sequence PC Key  VT Key 

ESC [ A  Up  Up 

ESC [ B  Down  Down 

ESC [ C Right  Right 

ESC [ D  Left  Left 

ESC [ 1 ~  Home  Find 

ESC [ 2 ~  Insert  Insert Here 

ESC [ 3 ~  Delete  Remove 

ESC [ 4 ~  End  Select 

ESC [ 5 ~  Page Up  Previous 

ESC [ 6 ~  Page Down  Next 

ESC [ 11 ~ F1   

ESC [ 12 ~ F2   

ESC [ 13 ~  F3   

ESC [ 14 ~  F4   

ESC [ 15 ~  F5   

ESC [ 17 ~  F6  F6 

ESC [ 18 ~  F7  F7 

ESC [ 19 ~  F8  F8 

ESC [ 20 ~  F9  F9 

ESC [ 21 ~ F10 F10 

ESC [ 23 ~  F11  F11 

ESC [ 24 ~  F12  F12 

ESC  ESC ESC  
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Appendix C: Program and Executive Name Contrast 

By Program Name By Executive Name 

Console –  based Configuration Tool Config.exe 

WAC Manager WacMan.exe 

WAC Explorer WacExplore.exe 

WAC Registry RegView.exe 

Text Editor Edit.exe 

Mail Inbox Inbox.exe 

Chat Tool Phone.exe 

Service Manager SvcMan.exe 

Event Viewer EventView.exe 

Binary Editor BinEdit.exe 

Process Viewer ProcView.exe 

Session Manager SesMan.exe 

User Manager UseMan.exe 

System Information SysInfo.exe 

Snake Snake.exe 

Mine Mine.exe 
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